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Documentation warranty statement

Characteristics of the products described in this publication can be changed at any time without
notice.

The information contained in this document is subject to change without notice. Agfa HealthCare
N.V. and its affiliates make no warranties or representations, express, implied or statutory, with
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this manual.

The information in this publication is subject to change without notice.
2011-6-13

Manufacturer’s responsibility

The manufacturer, installer, or importer will be responsible for the safety, reliability, and performance
of the equipment only if:

+ Installation, modifications, adjustments, changes, or repairs are performed by suitably qualified
service personnel.
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* The electrical installation of the site in which the equipment is used is according to an applicable
safety standard (UL, CSA, or IEC/CDE).

* The equipment is used according to the instructions provided in the operation manuals.

* No software other than that which is distributed with this package or is sanctioned by Agfa
will reside on the IMPAX 6.5.1 computers.

Giving feedback on the documentation

(Topic number: 122201)

Thank you for taking the time to provide feedback. Your comments will be forwarded to the group
responsible for this product’s documentation.

To give feedback on the documentation

1. In an email subject line or body, list which product, version, and publication you are
commenting on.

For example, “IMPAX 6.4 SU01 Client Knowledge Base: Extended*. (You can find this
information in the footer of the publications.)

2. Describe the incorrect, unclear, or insufficient information. Or, if you found any sections
especially helpful, let us know.

3. Provide topic titles and topic numbers where applicable.
Including your personal contact details is optional.

4. Send the email to doc_feedback@agfa.com.

Sorry, we cannot respond directly to every submission and we cannot accept requests for changes
in the product; instead, contact your product sales representative or the product’s technical support
channel.
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Getting started

Understanding IMPAX and these hardware and software components will help ensure successful
installations and upgrades for sites upgrading from IMPAX 5.2 or 5.3 or transitioning from WEB1000.

This guide is not applicable to sites upgrading from IMPAX 6.2 or later.

What is IMPAX 6.5.1?

(Topic number: 7749)

IMPAX 6.5.1 combines the traditional activities of RIS informatics management with PACS image
management to provide a powerful platform for imaging-based planning, interpretation, and results
distribution. IMPAX 6.5.1 enables data sharing and data synchronization in a macro enterprise using
a central Data Center.

The IMPAX 6.5.1 Client focuses on the integration of PACS, RIS, and Reporting applications into
a single delivery of information. A single IMPAX 6.5.1 Client application can be used by a range of
users on any appropriate, networked workstation they have access to.

IMPAX cluster overview

(Topic number: 7791)

Every IMPAX installation is based on the following main components:
+ Network Gateway
* Archive Servers

* Oracle Server or SQL Server
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+ Application Server
+ Curator
« IMPAX Clients—local and remote

The sum of these components is called the cluster. An IMPAX cluster is the set of core IMPAX
components that contains one database. SPFTP/ASPFTP is used for communication within the
IMPAX cluster. Any third-party display stations are considered to be outside the cluster. They use
DICOM to communicate with the cluster.

A typical installation has a Database Server, one or more Archive Servers, one or more Network
Gateways, and one or more Curators. A third-party load balancer is optional, to help handle many
Clients. Local Clients are spread throughout the entire enterprise, and remote Clients outside the
enterprise firewall. These Clients connect to one or more Application Server machines, either directly
or through a load balancer. The Application Server acts much like a proxy machine to handle security,
authentication, and communication with the IMPAX Server components.

When images are transmitted to the IMPAX cluster, the Network Gateway performs validation of
the study images and data. Validation requires the Network Gateway to query the HIS/RIS and
ensure that the study and patient demographics match what is currently incoming from a modality
or a transmit device. If the validation is successful, the images are “allowed” into the system. The
Database Server collects and manages all patient and study demographic data.

The IMPAX Clients, both local and remote, are used to view study images. Local Clients can get
images directly from the Network Gateway image cache. If images have been archived, the Network
Gateway image cache gets them from the Archive Server. The Curator generates compressed wavelet
images and stores them in a web cache, which may also be seen by local Clients. When a study is
diagnosed and dictated, the status of the study is updated at the Database Server, and when a report
is generated, it is forwarded to the HIS/RIS.
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IMPAX cluster: flow of images

flow of ima

Key differences between WEB1000 and IMPAX 6.5.1

(Topic number: 6664)

The following table highlights the major differences between WEB1000 and IMPAX 6.5.1:
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WEB1000 IMPAX 6.5.1

Search Wizards Worklists

A worklist is collection of patients and their studies. For
radiologists, the worklist is analogous to a pile of film jackets.
They use the worklist to know which studies they must interpret
during a specific time period. For technologists, a worklist is a
list of the studies they must perform at specific times for each
patient.

Teams Roles

A role is a collection of users or other roles that holds
permissions and preferences as well as licensing options. For
example, a role can represent the enterprise, the institution, a
department, or a team.

Thumbnail navigation area Thumbnails are displayed in the Available Series palette in the
Image area.

Minimal conferencing capabilities No conferencing capabilities

A more complete list of differences is provided in WEBI1000 and IMPAX 6.5.1 feature comparison
(refer to page 84).

Valid IMPAX upgrade paths

(Topic number: 6607)

Sites can upgrade to IMPAX 6.5.1 from any of these versions of IMPAX (supported versions include
any applicable SUs):

« IMPAX 5.2.5—hereafter referred to as IMPAX 5.2

« IMPAX 5.3.1, 5.3.2—hereafter referred to as IMPAX 5.3

IMPAX 6.2.1—hereafter referred to as IMPAX 6.2

IMPAX 6.3.1—hereafter referred to as IMPAX 6.3

IMPAX 6.4
+ IMPAX 6.5

For more detailed information, refer to the IMPAX 5.x - 6.x Service Update and Hot Fix Migration
Paths spreadsheet in the “Additional documents” section of the IMPAX Knowledge Base > Main
Knowledge Base Page.

Important!

We recommend checking the migration log file after each leg of an upgrade before moving
onto the next leg.
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Additional information:

+ AS3000 (Solaris) servers can upgrade to IMPAX 6.5.1 from any of the previously mentioned
versions of IMPAX on Solaris 9 or 10. Existing Solaris 9 servers must upgrade to Solaris 10
when upgrading to IMPAX 6.5.1.

+ Windows Server 2008 and Windows Server 2003 are supported on IMPAX AS300 servers.
Windows 2008 is supported for fresh installations only; unless already on Windows 2008,
Windows 2003 must continue to be used for upgrades.

+ For IMPAX AS300 upgrades, SQL Server 2008 is supported.

* To upgrade an IMPAX AS300 cluster from SQL Server to Oracle, contact Agfa Professional
Services for assistance. The SQL Server to Oracle migration process is not documented in this
guide.

+ The Application Server platform is either Windows Server 2003 or Windows Server 2008.
Windows 2008 is supported for fresh installations only; unless already on Windows 2008,
Windows 2003 must continue to be used for upgrades. All Application Servers in a cluster must
use the same operating system—either Windows 2003 or Windows 2008.

+ Asite running IMPAX 4.5 can migrate its user data—passwords, IDs, and most preferences—to
IMPAX 6.5.1. However, database data cannot be upgraded directly from IMPAX 4.5 to
IMPAX 6.5.1. The IMPAX 4.5 database must first be upgraded to IMPAX 5.2.5, then to
IMPAX 6.5.1.

Valid cluster configurations

(Topic number: 10763)

For cluster configurations, the following upgrade paths are supported:

+ Current single-cluster configuration to equivalent single-cluster configuration
+ Single-host AS300 to multi-host AS300

+ Single-host AS3000 to mixed-host AS300/AS3000

* Multi-cluster configuration to multi-cluster configuration

If your IMPAX configuration is not listed, contact your service representative.

When considering whether to move from single-host to a multi-host or a mixed-host configuration,
assess current performance of the system. If it is only borderline acceptable, you may want to also
upgrade the configuration to achieve better performance.

When upgrading from a single-host to a multi-host or mixed-host configuration, consider the sizing
and expected load on each server to take best advantage of the additional servers. For example,
moving the Curator component to its own server is generally more beneficial than moving the
Network Gateway component to its own server.
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Related documentation

(Topic number: 6634)

IMPAX includes documentation for IMPAX Client, IMPAX Application Server, and IMPAX Server.
The documentation is released on its own DVD. This DVD includes the Upgrade and Migration
Guides along with the IMPAX 6.5.1 Knowledge Bases, Installation Guides, Configuration Guides,
Task Summaries, and Quick References.

The documentation eventually must be installed on an IMPAX 6.5.1 Application Server. In the
interim, however, the documentation can be installed on any Windows-based computer or be viewed
right on the DVD.

The default.htm file at the root of the Documentation DVD and the installation directory links to
all available documentation.

IMPAX Knowledge Bases

(Topic number: 6676)

These online references are intended for clinical, administrative, and service personnel.

Opening the IMPAX Client Knowledge Base
(Topic number: 57452)

The IMPAX 6.5.1 Client Knowledge Base: Extended is a comprehensive set of information that
details how radiologists, clinicians, specialists, and PACS administrators configure and use the
IMPAX Client software. The Knowledge Base provides targeted getting started information, concepts,
and tasks for various user groups, and focuses on task-based and workflow-based information.

The IMPAX Client Knowledge Base: Core is available in 19 languages. The IMPAX 6.5.1 Client
Knowledge Base: Extended is available in English. Any or all languages can optionally be installed
and can be viewed on the Documentation DVD.

Viewing the Client Knowledge Base from the documentation DVD
(Topic number: 57437)

All IMPAX Knowledge Bases, including the IMPAX Client Knowledge Base, can be viewed directly
from the IMPAX documentation DVD.

To view the Client Knowledge Base from the documentation DVD
. Insert the IMPAX documentation DVD.

1

2. Navigate to /docs/client/knowledge_base.

3. Double-click default.htm.

4. Select the appropriate language for the IMPAX Client Knowledge Base.
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Opening the Client Knowledge Base from the List, Text, or Configure area
(Topic number: 57440)

Once the IMPAX documentation is installed, you can access it from the IMPAX Client application.

To open the Client Knowledge Base from the List, Text, or Configure area
1. Press F1.
or
From the List or Configure area bar, click Help.
The home (or main) page of the Client Knowledge Base opens in a browser window. It normally
appears in the same language used for the IMPAX interface; for example, if working with IMPAX
in French, the French Knowledge Base opens. If the Knowledge Base is not available in the interface

language (usually because that Knowledge Base was not installed), you must manually redirect the
URL to the English Knowledge each time you open the Knowledge Base.

Opening the IMPAX 6.5.1 Application Server Knowledge Base
(Topic number: 40098)

This Knowledge Base covers how to configure and maintain the IMPAX Application Server.

Viewing the Application Server Knowledge Base from the documentation DVD
(Topic number: 58005)

All IMPAX Knowledge Bases, including the IMPAX 6.5.1 Application Server Knowledge Base, can
be viewed directly from the IMPAX documentation DVD.

To view the Application Server Knowledge Base from the documentation DVD
1. Insert the IMPAX documentation DVD.

2. Navigate to /docs/appserver/knowledge_base.
3. Double-click default.htm.

Opening the IMPAX 6.5.1 Application Server Knowledge Base from the Configuration Tool software
(Topic number: 57999)

Once the IMPAX documentation is installed, you can access the IMPAX 6.5.1 Application Server
Knowledge Base from the Business Services Configuration Tool software.

To open the IMPAX 6.5.1 Application Server Knowledge Base from the Configuration Tool software
1. Select Start > All Programs > Agfa HealthCare > Business Services > Configuration Tool.

2. In the Business Services Configuration Tool, click Help.

Opening the IMPAX 6.5.1 Server Knowledge Base
(Topic number: 11528)

The IMPAX 6.5.1 Server Knowledge Base is a reference tool for PACS IT specialists and clinical
coordinators, field engineers, and technical launch team members, primarily to help them understand
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and use the components of the IMPAX cluster. The Server Overview component provides a basic
understanding of the IMPAX system and introduces users to key components and concepts.

Viewing the Server Knowledge Base from the documentation DVD
(Topic number: 57901)

All IMPAX Knowledge Bases, including the IMPAX Server Knowledge Base, can be viewed directly
from the IMPAX documentation DVD.

To view the Server Knowledge Base from the documentation DVD
1. Insert the IMPAX documentation DVD.

2. Navigate to /docs/server/knowledge_base.
3. Double-click default.htm.

Opening the Server Knowledge Base from the Administration Tools
(Topic number: 57892)

Once the IMPAX documentation is installed, you can access it from the IMPAX Administration
Tools interface.

To open the Server Knowledge Base from the Administration Tools
1. Select Help > Help URL.

A new browser window opens and loads the IMPAX Documentation page.

2. Under Knowledge Bases, click the IMPAX Server Knowledge Base link.

IMPAX installation, configuration, and upgrade guides
(Topic number: 6677)

These PDF guides are intended for service and administrative personnel. They contain all the
information needed to install, upgrade, and configure an IMPAX cluster.

E Note:

To view the IMPAX PDF guides on a computer, Adobe Reader must be installed.

Opening a PDF guide from the documentation DVD
(Topic number: 57808)

All IMPAX guides can be viewed directly from the IMPAX documentation DVD.

To open a PDF guide from the documentation DVD
1. Insert the IMPAX documentation DVD.

2. Navigate to /docs/{server | appserver | client}/guides.

3. Double-click the file name of the PDF guide.
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Opening a PDF guide from where the documentation is installed
(Topic number: 57811)

Once the IMPAX documentation is installed, you can access the PDF guides from a connected
computer.

To open a PDF guide from where the documentation is installed
1. Open a browser window.

2. Navigate to https://application_server_name/documents/

where application_server_name is the name of the server where the IMPAX documentation
is installed.

3. Under Upgrade and migration or Installation and configuration, click the title of the guide to
view.

IMPAX Client guide
(Topic number: 6680)

Title File name Provides instructions on
IMPAX 6.5.1 Client impax_client_installL.pdf < Installingthe IMPAX Client and related
Installation, Upgrade, and software in a standard configuration

Configuration Guide
+ Upgrading the IMPAX 5.2, 5.3, or 6.2

or later Client workstation to IMPAX
6.5.1

+ Initially configuring the Client

IMPAX Application Server guide
(Topic number: 6683)

Title File name Provides instructions on

IMPAX 6.5.1 impax_application_server_ + Installing the operating system,

Application Server install.pdf IMPAX documentation, and IMPAX

Installation, Upgrade, Application Server software

and Configuration

Guide + Upgrading the Application Server to
IMPAX 6.5.1

+ Initial configuration of the IMPAX
Business Services and other
post-installation configuration tasks
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IMPAX Server guides
(Topic number: 6673)

File name Provides instructions on

IMPAX 6.5.1 Preparing to impax_5x_ premigration_guide Preparing to upgrade an IMPAX 4.5,

Upgrade Guide—IMPAX .pdf 5.2,0r 5.3 cluster to IMPAX 6.5.1, and
4.5,5.2,5.3, or WEB1000 how to transition from WEB1000 to
to IMPAX 6.5.1 IMPAX 6.5.1. Covers both AS300 and

AS3000 clusters. If these preliminary
tasks are not performed, the upgrade
will not succeed.

IMPAX 6.5.1 Preparingto impax_6x_premigration_guide Preparing to upgrade an IMPAX 6.2

Upgrade Guide—IMPAX .pdf or later cluster to IMPAX 6.5.1. Covers

6.2 or later to IMPAX both AS300 and AS3000 clusters. If

6.5.1 these preliminary tasks are not
performed, the upgrade will not
succeed.

IMPAX 6.5.1 AS300 impax_5x_as300_ upgrade.pdf Upgrading an IMPAX 5.2 or 5.3

Upgrade and Migration cluster to an IMPAX 6.5.1 AS300 host.

Guide—IMPAX 5.2 or 5.3

to IMPAX 6.5.1

IMPAX 6.5.1 AS3000 impax_as3000_5x_ upgrade. pdf Upgrading an IMPAX 5.2 or 5.3

Upgrade and Migration cluster to an IMPAX 6.5.1 AS3000

Guide—IMPAX 5.2 or 5.3 host.

to IMPAX 6.5.1

IMPAX 6.5.1 AS300 impax_as300_install.pdf Installing and initially configuring

Installation and hardware and software on AS300

Configuration Guide Database, Archive, and Network

Gateway servers. This guide covers
single-server,all-in-one, single-host,
and multi-host configurations.

IMPAX 6.5.1 AS3000 impax_as3000_install.pdf Installing and initially configuring

Installation and hardware and software on AS3000

Configuration Guide Database, Archive, and Network

Gateway servers.

IMPAX 6.5.1 Curator and impax_curator_install.pdf Installing and initially configuring the

CD Export Server Curator and the CD Export server.

Installation Guide

IMPAX 6.5.1 Standalone impax_standalone_ Installing and initially configuring an

Installation and install_guide.pdf IMPAX standalone station. A

Configuration Guide standalone station has IMPAX Client,
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File name Provides instructions on

Application Server, and Server
components installed on a single

computer.
IMPAX 6.5.1 Standalone impax_standalone_ Upgrading an IMPAX standalone
Upgrade Guide upgrade_guide.pdf station. A standalone station has

IMPAX Client, Application Server,
and Server components installed on a
single computer.

IMPAX Task Summary references
(Topic number: 65012)

The Task Summary references provide only the main steps of the primary pre-migration and upgrade
tasks. They can serve as a quick reminder of what to do, but do not provide all the information
necessary to a successful upgrade.

ﬂ CAUTION!

The Task Summary references are intended for advanced system administrators. The
references provide no context on when and why to perform the tasks. For complete information,
refer to the full Preparing to Upgrade and Upgrade guides.

File name Tasks summarized in publication
AS300 Upgrade Tasks impax-5x-as300-upgrade- Upgrading the components of an
Summary—IMPAX 5.2 or 5.3 summary.pdf AS300 cluster from IMPAX 5.2 or 5.3
to IMPAX 6.5.1 to IMPAX 6.5.1.
AS3000 Upgrade Tasks impax-5x-as3000-upgrade- Upgrading the components of an
Summary—IMPAX 5.2 or 5.3 summary.pdf AS3000 cluster from IMPAX 5.2 or
to IMPAX 6.5.1 5.3 to IMPAX 6.5.1.
Preparing to Upgrade Tasks ~ impax-5x-premigration-  Preparing to upgrade the components
Summary—IMPAX 4.5,5.2, summary.pdf of an AS300 or AS3000 cluster from
5.3, or WEB1000 to IMPAX 4.5, 5.2, 5.3, or WEB1000 to
IMPAX 6.5.1 IMPAX 6.5.1.

IMPAX 6.5.1 Migrations Reference Guide

(Topic number: 6655)

The IMPAX 6.5.1 Migrations Reference Guide contains information to assist in the migration from
WEB1000, IMPAX 4.5, IMPAX 5.2, or IMPAX 5.3 to IMPAX 6.5.1. Among the information available
is the following:

+ IMPAX 5.2 preferences migrated to IMPAX 6.5.1

Migrations Reference Guide—IMPAX 5.2 or 5.3 or WEB1000 to IMPAX 6.5.1 16
Agfa Company Confidential—Subject to Non-Disclosure Obligation



IMPAX 5.2 and WEB1000 to IMPAX 6.5.1 feature comparison

IMPAX 5.2 and IMPAX 6.5.1 permissions and privilege comparison
+ IMPAX 5.2 database tables rendered obsolete in IMPAX 6.5.1
* Default operations assigned to each default role

This guide is installed with both Server and Client documentation, in the same folder as the
installation, upgrade, and configuration guides. Its file name is impax-migration-reference.pdf.

IMPAX Quick References

(Topic number: 54853)

Quick References are intended for clinical users. These abbreviated publications provide instructions
for commonly performed tasks and frequently required references. For ease of access, Quick
References can printed (double-sided if possible) and posted at Client workstations.

% Note:

To view the IMPAX Quick References on a computer, Adobe Reader must be installed.

Opening a Quick Reference from the documentation DVD
(Topic number: 57817)

All IMPAX Quick References can be viewed directly from the IMPAX documentation DVD.

To open a Quick Reference from the documentation DVD
1. Insert the IMPAX documentation DVD.

2. Navigate to /docs/{server|client}/quick-references.

3. Double-click the file name of the Quick Reference to open.

Opening a Quick Reference from where the documentation is installed
(Topic number: 57823)

Once the IMPAX documentation is installed, you can access the Quick References from a connected
computer.

To open a Quick Reference from where the documentation is installed
1. Open a browser window.

2. Navigate to https://application_server_name/documents/

where application_server_name is the name of the server where the IMPAX documentation is
installed.

3. Under Quick References, click the title of the Quick Reference to view.
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IMPAX Client Quick References
(Topic number: 54856)

Title File name Describes common IMPAX
procedures and references for

IMPAX 6.5.1 Quick Reference: ~ breast_imaging.pdf Radiologists who specialize in
Breast Imaging breast imaging.

IMPAX 6.5.1 Quick Reference:  clinicians.pdf Clinicians and surgeons.
Clinicians

IMPAX 6.5.1 Quick Reference: ct-mr.pdf CT/MR navigation tasks.
CT-MR

IMPAX 6.5.1 Quick Reference: emergency.pdf Emergency room clinical staff.
Emergency (ER)

IMPAX 6.5.1 Quick Reference: icu.pdf ICU clinical staff.

ICU

IMPAX 6.5.1 Quick Reference: reporting_administrator.pdf PACS Administrators at sites
IMPAX Reporting for using IMPAX Reporting.
Administrators

IMPAX 6.5.1 Quick Reference: ~ reporting radiologist.pdf ~ Radiologists at sites using

IMPAX Reporting for Radiologists IMPAX Reporting.

IMPAX 6.5.1 Quick Reference:  orthopaedics.pdf Orthopaedic surgeons.
Orthopaedics

IMPAX 6.5.1 Quick Reference:  radiologists.pdf Radiologists.

Radiologists

IMPAX 6.5.1 Quick Reference: ~ ronds.pdf Conducting rounds or

RONDS conferences.

IMPAX 6.5.1 Quick Reference:  search.pdf Searching for studies and
Search patients by various criteria.
IMPAX 6.5.1 Quick Reference:  spine_annotation.pdf Applying spine annotation labels
Spine Annotation to CT or MR images to indicate

which section of the spine an
image intersects.

IMPAX 6.5.1 Quick Reference: ~ technologists.pdf Technologists and radiographers.
Technologists
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IMPAX Server Quick Reference
(Topic number: 54859)

File name Describes common IMPAX procedures and

references for

IMPAX 6.5.1 Quick Reference: admin_tools.pdf =~ Configuring IMPAX Server using the
Administration Tools Administration Tools.
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Migration references

The following information lists the obsolete IMPAX 5.2 privileges, new operations for IMPAX 6.5.1,
and the privileges from IMPAX 5.2 that are common to IMPAX 6.5.1.

Privilege and permission comparison

(Topic number: 54910)

Some IMPAX 5.2 privileges map to equivalent operations used in IMPAX 6.5.1 permissions; others
do not. While IMPAX 5.2 is the focus of comparison, many of the 5.2 privileges are also available
in IMPAX 4.5 and IMPAX 5.3.

Obsolete IMPAX 5.2 privileges

(Topic number: 54697)

The following table lists the IMPAX 5.2 privileges that are obsolete in IMPAX 6.5.1:

IMPAX 5.2 privileges Feature description and
comments

Privilege Component

ADD_KEYWORDS SELECT Add keywords to the library of
available keywords.

ASSOCIATE_KEYWORDS SCHEDULE Add keywords from the keyword
library to studies.

BURN_CARDIO_REPORTS SELECT Include generated cardiology reports
when a CD-R is burned.
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IMPAX 5.2 privileges Feature description and

comments
Privilege Component
CARDIO_REPORT SELECT Allow user access to the cardiology
reports.
CHANGE_FONT SELECT Change the font on the actual PC.
CONFIG_CONTEXT_MENUS SELECT Configure the possibilities in the

finder list and worklist by
right-clicking the mouse.

CONFIG_ICU_CHECKIN SELECT Not used.

CONFIG_INFO SELECT Configure the Info box by clicking
on the Info icon.

CONFIG_WORKSHEETS SELECT Not used.

CONFIGURE_OCR SELECT Not used.

CONFIGURE_XMIT SELECT Transmit studies to a pre-configured
destination.

DEBUG_WIZARD SELECT Step through a wizard, command
by command.

DELETE_CACHED SELECT Delete studies in the cache. Only
recommended for the system
administrator.

DELETE_LOCAL SELECT Delete a study from the local cache
(if configured as a cached station).

DELETE_MOD SELECT Delete from MOD. Only applies if

the IMPAX Client is installed on the
same machine as the archive. Only
recommended for the system
administrator.

DELETE_TAPE SELECT Delete from Tape. Only applies if
the IMPAX Client is installed on the
same machine as the archive. Only
recommended for the system

administrator.
DISPLAY_BOOKMARKS SELECT Display saved bookmarks.
EDIT_ENUM_ATTRS SELECT Edit enumerated attributes.
EDIT_FINDER SELECT Edit which criteria appear in the
finder.
EDIT_PERF_PHYS SELECT Edit the list of performing
physicians.
EDIT TOOLBAR SELECT Edit toolbar associated with user ID.
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IMPAX 5.2 privileges Feature description and

comments

Privilege Component

ENTERPRISE_ALL_STUDIES_QUERY SELECT Search enterprise-wide for patient
studies.

ENTERPRISE_PRIORS_QUERY SELECT Search enterprise-wide for relevant
prior studies.

FIX_STUDY SERVICE_TOOLS Fix and verify studies that did not

match the information in the HIS.
Appears in the Study Manager.

HIS SELECT Grant access to the HIS using a
telnet window.
ICON_SIZE SELECT Change the icon size. Takes effect

on the machine for all users. Only
recommended for the system

administrator.
INJECT SELECT Inject test images into the system.
NOTIFICATION_MANAGER SERVICE_TOOLS Manage notifications and
notification rules.
PRINT_ADMIN SELECT Administer printer parameters

(limited version of
PRINT_CONFIG).

PRINT_ADVANCED SELECT Access advanced print selections
(changing printers, number of
copies, etc.). In IMPAX 6.5.1,
collapsed into Print.

PRINT_CONFIG SELECT Administrate and edit the setup of
the printers configured for the
system.

PRINT_TEMPLATES SELECT Create templates for WYSIWYG
printing.

QC_DISPLAY SELECT This privilege was not used in
IMPAX 5.2.

QUERY_ALL_STUDIES SELECT Make an unrestricted query in the

database for all studies for a selected
patient. It is recommended that this
feature is disabled for all users.

REPORT_ VIEWER SERVICE_TOOLS View, refresh and print report data.
SAVE_INFO SERVICE_TOOLS Save modified study information in
the Study Manager.
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IMPAX 5.2 privileges Feature description and
comments

Privilege Component

SAVE_SUMMARY_SERIES DISPLAY Save created or edited summary
series. Not recommended for
approved studies.

SERVICE_TOOLS SELECT Allow user access to the Service
Tools application.

SHOW_ALL_COMMENTS SELECT View all study comments for all
studies for the selected patient.

SHOW_PROGRESS SELECT This privilege was not used in
IMPAX 5.2.

STATS SELECT Access the statistical reports.

STATUS_MONITOR SERVICE_TOOLS View the system performance and
activity in work queues.

STUDY_ARRIVED _RULE SELECT Enable audible notifications for
study arrivals.

SYSTEM_DATA_ MANAGER SERVICE_TOOLS Remove historical data from the
database.

TALKTECH SELECT Allow user to only query for cached
studies.

USER_MANAGER SERVICE_TOOQOLS Create new users. Note that this

allows users to add new users with
unlimited access. Only
recommended for the system
administrator.

VIEW_STUDY_INFO SELECT View the study information.

PACS Client operations

(Topic number: 9446)

Operations are the actions allowed by a permission. When creating a permission, you can choose
to enable or disable operations that relate to the IMPAX Client. Dependent operations are operations
that must also be enabled to provide full access to the feature.

General

Corresponding 5.2 privilege

Operation Description Dependent Component Privilege
operations
At-a-Glance
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Operation

Edit At-a-Glance
Messages

Show At-a-Glance

Audible Notification

Change Password

Configure Area

Individual
Configuration

Preferences

Description

Allow user to add and
edit messages in the
At-a-Glance area

Allows user to view
the At-a-Glance area.

Allow user to enable
audible notification
for events such as
study arrival.

Allow user to change
his or her password,
which is
recommended.

Select sub-operations
to allow users access
to the Configure area.
Access to the
Configure area
should be carefully
controlled. Through
the Configure area
you can delete users,
change permissions,
change licenses, and
o on.

Allow individual
users to have control
over their own
preferences and
station. Users
otherwise need to
have a PACS
Administrator to
change personal
preferences.

Allow user access to
the Preferences
section of the
Configure area.

Corresponding 5.2 privilege

Dependent

operations

General None

At-a-Glance >

Show

At-a-Glance

None None

None SELECT

None SELECT
None

None None

To access all  None

tabs, requires:
General

Print > Edit
Composite
Layouts

Component Privilege

None

None

AUDIBLE_NOTIFY

CHANGE_
PASSWORD

None

None

None

Migrations Reference Guide—IMPAX 5.2 or 5.3 or WEB1000 to IMPAX 6.5.1
Agfa Company Confidential—Subject to Non-Disclosure Obligation

24




Corresponding 5.2 privilege

Operation Description Dependent Component Privilege
operations
Printers Allow user access to  None SELECT PRINT_ADMIN,
the Printers section of PRINT_ CONFIG,
the Configure area. PRINT_ADVANCED
Service Allow the user to None None None

access the Service
Portal in the
Configure area.

Stations Allow user access to  None None None
the Stations section of
the Configure area.
Users and Roles  Allow user accessto  None SELECT USER_TOOLBARS

the Users and Roles
section of the
Configure area.

Context Server None None
Integrations
Allow Single Allow user to log into General None None
Sign-on both IMPAXanda
ontext

Context Server Server
integration with a Integrations >
single login. Thisisa g =
potential security

. . Context
risk, so the site must N
licitly enable this erver
explicitly Integrations
feature.
Enable Context  Allow user accessto None None None
Server Context Server
Integrations integrations.
Cycle Studies Allow user to cycle  None None None
through studies in the
worklist
Delete Study Allow user to delete  None None None
viewable study
Edit Columns Ability to edit the set None SELECT EDIT_COLUMNS
of visible columns
returned in worklists,
search results, and so
on.
Edit Enumerated Values Allow user to edit the None None None
enumerated values,
used for searching
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Corresponding 5.2 privilege

Operation Description Dependent Component Privilege
operations
Edit Viewable Worklists Allow user to edit None None None
which worklists are
viewable by the user
in the Worklists
library
Export and Import None None
Studies
Export Studies ~ Allow user to include None None None
with Image the Image Viewer
Viewer when exporting
studies to local
CD/DVD media.
Export Studies Allow user to include None None None
with Reports reports when
exporting studies to
local CD/DVD
media.
Import Studies ~ Allow user to import None None None
DICOM studies to
the PACS from local
external media, such
as CD.
History Allow user to display None None None
recently displayed
studies.
Image Area Allow user access to  None None None
the Image area.
Image Area Tools For all Image None None
Area Tools
operations:
General
Image Area
Modality >
View All or
specific
modalities
3D B Allows users to None None
launch a series into
the Volume Viewing
window for 3D
analysis.
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Operation

Active Target

Apply Hanging
Protocols

Apply System
Layout Protocols

Auto Window
Level

Break Out Gated
Series

Cine Viewer

Comparative
Review

Corresponding 5.2 privilege

Description Dependent Component Privilege
operations

Ed Allow user to DISPLAY  CURSOR
present a 3D context

for images in studies

and view the location

of slice positions.

Allow user to None None

apply an available
hanging protocol to
the current study
using the Set Series
Hanging Protocol
tool.

Allow the user to None None

preset screen layout
options that change
how studies, series,
and images are
displayed across the
available monitors.

| Allow user to None None

automatically
window level an
image based on a
selected region of the
image.

Allow user to None None

create a temporary
series that displays
the same point of a
heart cycle through
time in nuclear
medicine studies.

Allow user to play None None

series images in a
continuous loop or
frame by frame.

m Allow user access None None

to the comparative
review modes for
mammography
screening.
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Corresponding 5.2 privilege

Operation Description Dependent Component Privilege
operations

Compare m Allow user to None None

display two enlarged
copies of an image
side by side in a
window and modify
one image without
affecting the second

image.
Create Combined # Allow user to None None
Series combine all series in
a study temporarily.
Create Summary Allow user to DISPLAY CREATE_
Study combine images from SUMMARY

one or more series or
studies as a summary
study.

Customize Allow user to The DISPLAY CUSTOMIZE

open the Customize Customize
dialog in the Image ~ ©peration
area for setting user ~ 81Ves access to

preferences for the Customize
toolbars, screen dialog. Access
layouts, hanging al‘l tabs on the
protocols, startup d1alqg, also
defaults, markup requires:
statistics, @il

workflows,automatic

study saves, modality Image Area

preferences, image Tools > Apply

wizards, keyboard hanging

shortcuts, and cine ~ Protocols

viewer options. Image Area
Tools >

Screen Layout

Image Area
Wizards > any
sub-operation

Demographics [EAllow user to show None None

Toggle or hide patient
demographics on
study images.
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Corresponding 5.2 privilege

Operation Description Dependent Component Privilege
operations
Display Markup Allow user to hide None None
Toggle all markups, display
all markups, or
display only their

own markups.

Display Scout [ Allow user to None None

open a Scout window
that shows the slice
location in CT and

MR studies.
Edit New Series  Allow user to edit the None None
Descriptions series description

values in hanging

protocols.
Extended Monitor @ Allow user to None None
Display display an instance of

a selected series on an
extended color

monitor.
Histogram Allow user to take None None
Equalization a histogram from a

region of interest and
equalize it to the rest
of the image.

Image Allow user to use None None
Enhancement the Image

Enhancement tool to
produce a sharper,
enhanced image edge
by accentuating the
difference between a
pixel value and a
weighted average of
the surrounding

pixels.
Image B Allow user to None None
Infor mation display the Image
Window Information window,

which contains
demographic details
and orthopaedic
implant details, and
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Corresponding 5.2 privilege

Operation Description Dependent Component Privilege
operations
to print the
information.
Image Pasting 4 Allow user to None None

align a series of XA
images that were
taken to track a
radiopaque agent
through the body.

Image Selection @] Allow user to None None

select images that
other tools can be
applied to.

Linking . Allow user to None None

connect and
disconnect coplanar
series so that
navigation, and
optionally window
leveling and
magnification,
performed on one
series applies to all
connected series

Mammography [ Allow user to None None

CAD SR Toggle display or hide
mammography CAD
SR markers.

MPR . Allows users to None None

launch a series into
the Volume Viewing
window for MPR and
MIP analysis.

Nonlinear n Allow user to None None

Window Level change the brightness
and contrast of an
image based on
graphical curve

adjustments.
Nuclear Medicine Allow user to None None
Palette apply a specified

color palette to
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Corresponding 5.2 privilege

Operation Description Dependent Component Privilege
operations

grayscale images in a

study.
Paired Zoom and Allow the user to None None
Pan magnify all breast

images that are in
view (or stacked) and
then move the images
in a similar direction
at current
magnification.

Pin Study [ Allow user to pin None None

a study in place and
keep it visible while
navigating through
other patient studies.

Pixel Value Toggle |E# Allow user to None None

o
display or hide the
image pixel value
beneath the pointer.

Presentation State Allow user to None None
Selection apply a sqftcopy
presentation state.

Projection Jil] Allow user to None None

enlarge a selected
image to full screen
size in a new window.

Rearrange Series Allow user to None None
reorder the seriesin a

study.

Screen Layout Allow user to None None
specify how images,
series, and studies are
arranged in columns
and rows on an Image
area monitor.

Service Window Allow user to None None
display the DICOM
header and database
information for an
image.
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Corresponding 5.2 privilege

Operation Description Dependent Component Privilege
operations

Sort Images B3 Allow user to sort None None

images in the series
according to available
DICOM attributes.

Split Multi-Phasic Allow user to None None

Series perform a
multi-phasic split of
a series.

Tab Stops Allow user to add None None

navigation tabs to
images of interest.

True Size E Allow user to DISPLAY TRUE_SIZE
display the image at
its actual size,
according to available
image information.

Undo/Redo/Reset Allow user to: None None

undo, [&l redo, or
reset images, 2l reset

markups, @l reset
geometry, [@N reset
window level, or E

reset nuclear
medicine palettes.

View Original Allow user to None None

Images retrieve the original
DICOM image data
for the displayed
study.

Window Level Allow user to DISPLAY SAVE_WINDOW _

change image LEVEL
brightness and

contrast by adjusting

window center and

window width.

Window Level Allow user to apply  Also requires None None
Preset window level presets. the operation

Window level presets related to one

are predefined of the tools in

window level values. the Window
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Operation

Image Area Wizards

Create or Import
Wizards

Delete Wizards

Edit Wizards

Run Wizards

Job Manager
Delete Jobs

Description

Allow user to define
image wizard actions,
create an image
wizard by recording
actions, or import
image wizards.

Allow user to delete
image wizards. This
operation only
applies to wizards the
user has defined, not
those inherited from
arole.

Allow user to modify
an image wizard's
actions or edit an
image wizard's name,
description, or
trigger. This
operation applies
only to wizards the
user has defined, not
those inherited from
arole.

Allow user to activate
any defined image
wizards using the
wizard button or
keyboard shortcuts.

Allow user to delete
print, transmit,

Dependent
operations

level button
menu, such as:

General

Image Area
Tools >
Window Level

General

Image Area
Tools >
Customize

General

Image Area
Tools >
Customize

General

Image Area
Tools >
Customize

General
Image Area

Modality >
View All or
specific

modalities

General

Corresponding 5.2 privilege

Component Privilege

None

SELECT

None

SELECT

SELECT

None

SELECT

None

NEW_WIZARD

None

EDIT_WIZARD

STARTUP_ WIZARD

None

DELETE_JOB
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Corresponding 5.2 privilege

Operation Description Dependent Component Privilege
operations

retrieve,and CD or  Job Manager

DVD burn jobs. > Enable Job
Manager
Enable Job Allow user accessto  None SELECT VIEW_PROGRESS
Manager the Job Manager

window to view the
status of print,
transmit, retrieve,
and CD or DVD burn
jobs. (This is different
from the Job
Manager in the
Administration
Tools.)

Modify Any Job ~ Allow user to view  General None None
print, transmit,
retrieve, and CD or
DVD burn jobs for all
users. If the user also
has permissions to
delete jobs or modify
their priority, he or
she can modify jobs
created by other
users.

Job Manager
> Enable Job
Manager

Modify Job Allow users to modify General SELECT JOB_ PRIORITY
Priority the priority of their Job Manager

own print, transmit,
. > Enable Job
retrieve, and CD or J

DVD burn jobs. Manager
Key Images Edit Favorite Allow user to edit key None None
Titles image note document
titles.
Keywords None None
Edit Personal Allow user to add or None SELECT EDIT_KEYWORDS
Keywords edit keywords that are
available only to him
or her.
Edit System Allow user to add or None SELECT SYSTEM_
Keywords edit keywords that are KEYWORDS
available for
system-wide use.
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Corresponding 5.2 privilege

Operation Description Dependent Component Privilege
operations
Link Patients Allow user to link None SELECT LINK_PATIENTS
studies from different
patients.
Messaging Service None None None
Instant Messaging Allows the user to None None None
easily connect with
colleagues using the
IMPAX instant
messaging feature.
This permission must
be disabled for any

roles whose users
share the same
IMPAX account
(single sign-on),such
as EPR users.

Receive Study Allow user access to  None None None
Messages the Messaging Service

for connecting with

other clients. This

operation is required

to use the dictation

preferences set in the

Configure area -

Preferences section,

List area bar,

Worklist tab.
Modality For all None None
Modality
operations:
Study-based
View Study
View All Allow user to view SELECT SHOW_ALL_JOBS
studies from all
modalities
View CR Allow user to view None None
CR studies. If using
the Entry-Level
Radiologist license,
users cannot display
CR images without an
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Corresponding 5.2 privilege

Operation Description Dependent Component Privilege
operations
additional CR DR US
option.
View CT Allow user to view CT None None

studies. If using the
Entry-Level
Radiologist license,
users cannot display
CT images without an
additional CT option.

View DR Allow user to view None None
DR studies. If using
the Entry-Level
Radiologist license,
users cannot display
CR images without an
additional CR DR US
option.

View MG Allow user to view None None
MG studies.

View MR Allow user to view None None
MR studies. If using
the Entry-Level
Radiologist license,
users cannot display
MR images without
an additional MR
option.

View NM Allow user to view None None
NM studies.

View US Allow user to view US None None
studies. If using the
Entry-Level
Radiologist license,
users cannot display
CR images without an
additional CR DR US
option.

View XA Allow user to view None None
XA studies.

Orthopaedic Application Allow user to None SELECT LAUNCH_

open images into the MEDICAD
Orthopaedic
Application window.
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Corresponding 5.2 privilege

Operation Description Dependent Component Privilege
operations
Override Permissionson Allow user to modify General None None
a Folder teach{ng folder Teaching Files
permissions
regardless of the
individual
permissions set on
the folders.
Print DISPLAY PRINT
Edit Composite  Allow user to define General SELECT WYSIWYG_ PRINT,
Layouts composite layouts for ~ o PRINT_TEMPLATES
printing and saving >g
studies. Preferences

Print to Paper Allow user to print ~ Study-Based SELECT PRINT
studies to paper. Print > Print

Composite
Layouts
Quality Control None None
Acknowledge Allow user to resolve Study-Based None None
Conflicts conflicts between View Stud
images with the same ..\, Incluﬁe
SOP instance UID. Uil
Studies option
Fixup, Segment,  Allow user to fix Study-Based None None
and Split Studies demographics, merge View Stud
studies, segment with Inclu}clle
studies, and split Unverified
studies. Studies option

Quick Fix Up Allow user to fix Study-Based SELECT QUERY_

fiemographig View Study UNVERIFIED
information ina with Include
batch of studies. Unverified
Studies option
Remember User Settings Allow settings that ~ None None None
can be saved
automatically to be
saved automatically.
Has no effect on
modifications that
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Operation

Scripting
Configure Scripts

Run Scripts

Searching for Studies

Add Search
Criteria

Advanced Search

Configure Simple
Search Criteria

Dependent
operations

Description

must be explicitly
saved.

None

Allow user to add, =~ None
import, export,
remove, or edit script

wizards.

Allow user to run the None
scripts in the List area

by clicking the script's
button in the Wizards
toolbar.

Allow user to edit the General
master list of search
criteria for predefined

search criteria.

Searching for
studies >
Advanced
Search
Allows access to the  None
Advanced Search. If

this operation is
selected, the

Advanced Search
appears in the List

area, and the simple
Search is no longer
available (even if the
Simple Search

operation is enabled).
Refer to "Finding

studies using

Advanced Search"

(topic number 8610)

in the IMPAX 6.5.1
Client Knowledge

Base: Extended.

Allow the user to None
define what type of

patient information

is displayed in the

Search columns.

Corresponding 5.2 privilege

Component Privilege

None None

None None

SELECT CONFIGURE_
SCRIPT_BUTTONS

None None

SELECT DEFAULT _
CRITERIA

SELECT FINDER _
FAVORITES

None None
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Operation

Searching for
Open Studies

Simple Search

Use Relevant Prior
Rules

Set Default Image Type

TalkStation Integration

Teaching Files

Text Area

Description

Allow user to search
for open studies (that
is, perform a "wet
read").

Allow user access to
the simple Search in
the List area.

Allow user to enable
the relevant prior
feature so that
relevant priors are
automatically opened
with the study.

Allow user to choose
between viewing
original images or
web images by
default.

Allow user to dictate
studies using
TalkStation.

Allow user to use the
Teaching Files
functionality. Within
the Teaching Files
area, you can set
specific teaching file
permissions.

Corresponding 5.2 privilege

Dependent
operations

None None

The Searching None
for studies >
Advanced

Search

operation

must be

disabled for

simple Search

to appear.

Study-based SELECT

Study
Retrieval >
Retrieve
Studies from
External PACS

None SELECT

Study-Based None

Dictate
Studies as
Radiologist or
Dictate
Studies as
Resident

General

Text Area >
Enable Text
Area

SELECT

None

Component Privilege

None

None

QUERY_ PRIORS

SET_ DEFAULT _
PATHS

None

TEACHING_FILE

None
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Corresponding 5.2 privilege

Operation Description Dependent Component Privilege
operations
Configure Allow user to None None
SmartSeek Tabs  configure SmartSeek
tabs.
Edit Favorite Allow user to add, General None None
Study Comments ;:dlt, :fmd decllete Text Area >
avorite study Enable Text
comments. Area
Enable Enterprise Allow user to use None None None
Study List Enterprise features in
the Study List.
Enable Text Area  Allow user to view the None None None

Text Area. Normally,
the Text area is
disabled only in some
Context Server and

EPR integrations.
Private Study Allow user to mark  General None None
Comments study and voice _ Text Area >
comments as private. poou1
Area
Update Study Allow the user to None None None
update the study
through the
backoffice
integrations.

Worklists None None
Configure Global Allow user to None None None
Priority Groups  configure global

priority groupings for
worklists.
Edit Viewable Allow user to edit None None None
Worklists viewable worklists.
Personal Allow user to create, None None None
Worklists edit, and delete
personal worklists.
Scheduled Worklists None None
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Corresponding 5.2 privilege

Operation Description Dependent Component Privilege
operations
Add Studies to Allow users to add General SELECT ADD_ONLY_
Scheduled studies to a scheduled Scheduled TO_ROND
Worklists worklist by dragging Worklists >
them from other Vi
klists few
WOTKHSLS. Scheduled
Worklists
Create Scheduled Allow user to create  General SELECT SCHEDULE
Worklists scheduled worklists. Scheduled
Worklists >
View
Scheduled
Worklists
Delete Scheduled Allow user to delete  General None None
Worklists scheduled worklists. Scheduled
Worklists >
View
Scheduled
WorKklists
Edit Scheduled Allow user to edit General SELECT EDIT _ROND
Worklists existing scheduled Scheduled
worklists. Worklists >
View
Scheduled
Worklists
Remove Studies  Allow user to remove General None None
from Scheduled  studies from
hedul
Worklists scheduled worklists. sl\clofl?llilstesd>
View
Scheduled
Worklists
Reorder Allows user to change General None None
Scheduled the order of
Worklists scheduled worklists Schedgled
) ; Worklists >
in the Worklist Vi
Librar 1w
Y. Scheduled
Worklists
View Scheduled  Allow user to view None SELECT CONFIGURE_
Worklists scheduled worklists ROND
in the Worklist
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Operation

Description

Library and in the
List area.

Standard Worklists

Create Worklists

Delete Worklists

Edit Worklists

Allow user to create
standard worklists
and sign-off
worklists.

Allow user to delete
standard and sign-off
worklists.

Allow user to edit
standard and sign-off
worklists.

Dependent
operations

None

None

None

Corresponding 5.2 privilege

Component Privilege

None None
None None
None None

Study-Based

Operation

Add/Remove Key Images

Dictate Studies as
Radiologist

Description

Allow user to add
key images to or
remove key images
from a report. (All
users are permitted
to view key images.)

The Add/Remove
Key Images
operation can also
have study status
flags applied to it.
For example, you
can set it to work
only on New studies.

Allow user to dictate
studies as a
radiologist, with
ability to sign off
reports. This
operation can also
have relevant study

Dependent
operations

General
Image Area

Modality >
View All or
specific
modalities

Text Area >
Enable Text
Area

Study-based

Text Area >
View
Reports

General

Image Area

Modality >
View All or
specific
modalities

Corresponding 5.2 privilege

Component Operation

None None

DISPLAY  DICTATE
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Corresponding 5.2 privilege

Operation Description Dependent Component Operation
operations
status flags applied
to it.
Dictate Studies as Allow user to dictate General DISPLAY DICTATE
Resident stgdles as a‘r.e51dent, Image Area
without ability to

sign off reports. This Modality >
operation can also ~ View All or
have relevant study specific

status flags applied ~modalities

to it.
Edit Study Priority None None None
Export and Import The Export and SELECT BURN_CD
Studies Import operations

can also have study

status flags applied

to them. For
example, you can set
the Export Studies to
Remote Media
operation to work
only on Approved
studies.

Export Studies to  Allow user to export None None None
Local Media studies to local

media in DICOM

format; for example,

to burn studies to a

local CD or DVD

drive.

You can then select
what status studies
must have before
they can be burned:
APPROVED,
DICTATED, NEW,
REPORTED, or

OPEN.
Export Studies to  Allow user to export None None None
Remote Media studies to remote

media in DICOM

format; for example,
to burn studies with
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Operation

Image Area Tools

Collimate

Delete Image

Edit All Markups

Edit DICOM
Flements

Edit Study
Snapshots

Export Images

Description

CD/DVD burning
software.

You can then select
what status studies
must have before
they can be burned:
APPROVED,
DICTATED, NEW,
OPEN, or
REPORTED.

The Image Area
Tools operations can
also have study
status flags applied
to them. For
example, you can set
the Delete Image
operation to work
only on New studies.

ﬂ Allow user to

crop an image to
eliminate clutter.

Allow user to

remove images from
a study.

Allow user to

move or resize image
markups.

Allow user to
edit image
acquisition elements
such as kVp, mAs,
SID, and Technician
Code.

Allow user to edit
study snapshots.

Allow user to export
study images as
JPEG files, as AVI

Corresponding 5.2 privilege

Dependent
operations

For all Image None

Area Tools

operations:

General

Image Area

Modality >

View All or a

subset of

specific

modalities
DISPLAY
DISPLAY
DISPLAY
None
None
SELECT

Component Operation

None

COLLIMATE

DELETE_IMAGES

EDIT_ALL_
MARKUP

None

None

BURN_CD_
VIEWER
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Corresponding 5.2 privilege

Operation Description Dependent Component Operation
operations

files, or as a
Clipboard copy.

Geometry Allow user to rotate None None
and flip images.

Import Images [l Allow user to add None None

a BMP or JPEG
format image to a
study.

Invert E| Allow user to SELECT REVERT_ STATUS

exchange the white
and black areas in an
image.
Magnification Allow user to None None
magnify images
using the various

zoom tools.
Markup Allow user access to DISPLAY  MARKUP
the Markup tools.
Publish SPS Allow user to None None
Objects publish softcopy

presentation states.
This operation can
also have relevant
study status flags

applied to it.
Rearrange Images low user to DISPLAY  REARRANGE_
reorder the images IMAGES
in a series.
Save Geometry Allow user to save DISPLAY SAVE_
rotation and flips. GEOMETRY
Save Allow user to save None None
Magnification/Pan magnification and
position.
Save Markup Allow user to save DISPLAY SAVE_MARKUP
markups.
Save Tabstops Allow user to save DISPLAY  SAVE_TABSTOP
tab stops.
Save User Image  Allow user to save None None
Calibration calibration changes.
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Corresponding 5.2 privilege

Operation Description Dependent Component Operation
operations
Save Window Level Allow user to save None None
window level
changes.
User Image Allow user to DISPLAY  CALIBRATE
Calibration calibrate an image,

series, or study;
revert from user to
modality calibration;
or apply ERMF
calibration, if
available.

Keywords The Keyword None None
operations can also
have study status

flags applied to it.
Associate Allow user toadd  None SELECT ASSOCIATE_
Keywords with keywords from the KEYWORDS
Study keyword library to
studies.
Print The Print None None

operations can also
have study status

flags applied to
them.
Print Composite  [5] Allow user to None None None
Layouts print composite
layouts of studies.
Print Study Allow user to print None None None
studies.
Shared Workflow Allow user to enable None None
shared workflow
(claim/assign
studies).
Study Retrieval None None
Retrieve Offline Allow user to None DISPLAY REPORT
Studies retrieve offline

studies; for example,
studies that are on
media that is not in
the library.
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Operation

Corresponding 5.2 privilege

Description Dependent Component Operation
operations

Retrieve Studies  Allow user to None None None
from External retrieve studies that
PACS are in an external
PACS system.
Retrieve Studies Allow user to None None None
from HSM retrieve studies from
an HSM
(Hierarchical
Storage
Management)
system.
Retrieve Studies  Allow user to None None None
from Nearline retrieve nearline
studies; for example,
studies that are
archived on DVD or
DIT.
Text Area For all Text None None
Area
operations:
General
Text Area >
Enable Text
Area
Add Study Allow user to add SELECT ADD_STUDY
Comments new study COMMENTS
comments. This
operation can also
have relevant study
status flags applied
to it.
Edit Patient Allow user to edit None None
Demographics the patient's name in
the Text area.
Edit Performing  Allow user to edit None None
Physician the name of the
performing
physician in the Text
area.
Edit Study Allow user to edit SELECT EDIT_STUDY_
Comments existing study COMMENTS
comments. This
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Corresponding 5.2 privilege

Operation Description Dependent Component Operation
operations

operation can also
have relevant study

status flags applied
to it.
Edit Study Status  Allow user to change None None
the status of a study.
Protect Studies Allow user to protect SELECT PROTECT

a study against
removal from the
image cache.

View Reports Allow user to view SELECT RIS_REPORT
reports in the Text
area. This operation
can also have
relevant study status
flags applied to it.

Transmit Studies Allow user to None SELECT TRANSMIT
transmit studies to
other DICOM
destinations. This
operation can also
have relevant study
status flags applied
to it.

View Study Allow user to view  None None None
studies that are
included in the study
access rules for the
permission. This
operation can also
have relevant study
status flags applied
to it.

Administration Tools operations
(Topic number: 9448)

Operations are the actions allowed by a permission. When creating a permission, you can choose
to enable or disable operations that relate to the Administration Tools. For details on what each of
these managers controls, refer to the Administration Tools component of the IMPAX 6.5.1 Server
Knowledge Base.

We recommend giving Administration Tools operations to PACS Administrators only.
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Operation

Autopilot Management

View

Basic Framework

Acknowledge

Delete

Basic Routing Manager

View

Body Part Manager

View

Cache Manager

View
Cache Monitor
View

Demographic Layout
Manager

Description

privilege

Allow user access to the AUTOPILOT_MANAGER
Autopilot Manager. The

Autopilot Manager sets when

studies are removed from

cache.

Allow user access to some of
the basic framework features.
(To disable access, all other
operations must be cleared as
well.)

Allow user to acknowledge
exceptions through the
Exception Management dialog.

ACKNOWLEDGE_EXCEPTIONS

Allow user to delete exceptions None
through the Exception
Management dialog.

Allow user access to the basic BASIC_ROUTING_MANAGER
Routing Manager, to configure

routing based on modalities

only (see also Routing Manager

in this list).

Allow user access to the Body BODY_PART_MANAGER
Part Manager. The Body Part

Manager configures body parts

in the system. The configured

body parts are global and are

in effect for all users.

Allow user access to the Cache CACHE_MANAGER
Manager to create temporary

storage of images on cache.

Allow user access to the Cache CACHE_MONITOR

Monitor to track cache status.

To use this feature, you must
also have the Source Manager
> View operation.

Corresponding 5.2 Service Tools
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Operation Description Corresponding 5.2 Service Tools

privilege

New DICOM Field Allow user to create DICOM  CREATE_DICOM_FIELD
fields for use in demographic
layouts within Source Manager.

View Allow user access to the DEMOGRAPHIC_
Demographic Layout Manager LAYOUT_MANAGER
within Source Manager. Users
can create demographic layouts
as default for the entire system.

(To disable access to the
manager, the New DICOM
Field operation must be cleared

as well.)
Enumerated Values
Manager
View Allow user access to the ENUMERATED_VALUES

Enumerated Values Manager,
to create preset values for
drop-down lists in search
criteria. Enumerated values can
also be added through the
Study Manager, if given the
Study Manager > System-Wide
Values operation.

Image Access Manager

View Allow user access to the Image IMAGE_ACCESS_MANAGER
Access Manager to set priorities
for retrieving images from one
cache relative to another cache,
and from one archive relative
to another archive.

Job Manager

Start/Halt Queues Allow user to start and stop START_HAILT_QUEUES
queues in the Job Manager.

View Allow user access to the Job JOB_MANAGER
Manager. Users can halt the
queue or process jobs that stall
due to an error. (To disable
access to the manager, the
Start/Halt Queues operation
must be cleared as well.)

Network Manager
View Allow user access to Network NETWORK_MANAGER
Management. Users can then
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Operation

Description

Corresponding 5.2 Service Tools

privilege

Patient Location Manager

View

Print Date Manager

View

Quality Test Manager

View

Queue Monitor

View

Relevant Prior Manager

View

Routing Manager

enable DICOM
communication between your
system and remote stations on
the network.

Allow user access to the Patient
Location Manager to define
mappings for patient locations.

Allow user access to the Print
Date Manager to specify the
date format when printing
images. You can also select the
print date format through the
IMPAX Client.

Allow user access to the Quality
Test Manager. Users can query
for test results and add notes
and comments about the tests
performed.

Allow user access to the Queue
Monitor to diagnose problems
within a particular queue or
view details about jobs in a
particular queue.

Allow user access to the
Relevant Prior Manager. Users
create system-wide relevant
prior rules that are used for
prefetching with this manager.
Refer to "Relevant Prior
Manager: Workflow
applications” (topic number
9482) in the Administration
Tools component of the
IMPAX 6.5.1 Server Knowledge
Base.

To use this feature, you must
also have the Source Manager
> View operation.

PATIENT LOCATION_MANAGER

PRINT_DATE_MANAGER

QUALITY_TEST_MANAGER

QUEUE_MONITOR

RELEVANT_PRIOR_MANAGER
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Operation Description Corresponding 5.2 Service Tools

privilege

View Allow user access to the ROUTING_MANAGER
advanced routing rules in the
Source Manager, to configure
study routing rules for the
entire system (see also Basic
Routing Manager).

Scavenger Manager

View % Note: SCAVENGER_MANAGER

Do not use. As of IMPAX
6.5, Scavenger Manager
is no longer supported.

Source Manager

View Allow user access to the Source SOURCE_MANAGER
Manager to configure which
stations are acquisition stations
that receive images from the
modality.

Speciality Manager

View Allow user access to the SPECIALITY_MANAGER
Speciality Manager to define
the mapping between study
descriptions or procedure
codes and specialty identifiers.
The configured specialties are
global and take effect for all
users. The specialties are also
to be used in combination with
prefetching and autorouting.

Study Manager Many of the Study Manager
operations can also have study
status flags applied to them.
For example, you can set the
Retrieve operation to work
only on New and Open studies.

Add/Remove Allow user to set search and  None
Search and transmit locations. Also

Transmit requires the Network Manager
Locations > View operation.

Delete Completely Allow user to delete astudy = DELETE_COMPLETELY
completely through the Study
Manager.
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Operation

Delete from
Archive

Delete from Cache
Fix All Studies
Lock/Unlock
Study

Merge

Merge Physicians

Protect/Unprotect
Study

Retrieve

Split

Store

Store to Archive

Study Information

System-Wide
Values

Description

Allow user to delete a study
from the archive through the
Study Manager.

Allow user to delete a study
from cache through the Study
Manager.

Allow user to manually fix
many unverified studies at once
through the Study Manager.

Allow user to lock or unlock a
study through the Study
Manager.

Allow user to merge multiple
studies into one through the
Study Manager.

Allow user to merge physician
names through the Study
Manager.

Allow user to mark a study as
protected or unprotected
through the Study Manager.
Protected studies are not
deleted from cache by the
Autopilot Process.

Allow user to manually retrieve
a study from an archive
through the Study Manager.

Allow user to manually split a
study into two studies through
the Study Manager.

Allow user to manually store a
study to media (CD/DVD)
through the Study Manager.

Allow user to manually store a
study to the archive through
the Study Manager.

Allow user access to the Study
Information dialog through the
Study Manager.

Allow user to create, edit, and
delete search criteria values that
will then be available to all

Corresponding 5.2 Service Tools

privilege
DELETE_FROM_ARCHIVE

DELETE_FROM_CACHE

FIX_ALL_STUDIES

None

MERGE_STUDIES

None

None

RETRIEVE

SPLIT_STUDY

None

None

None

None
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Operation Description Corresponding 5.2 Service Tools

privilege

users in the system. These
values, such as modalities,
specialty, or referring
physician, can be added when
searching for studies in the
Study Manager. Any values
added here also appear in the
Enumerated Values Manager,
and vice versa. The values also
appear as a selectable option
for the appropriate search
criteria in any Client in the
system. If you do not give users
this operation, they can still
create, edit, and delete their
own search criteria values in
the Study Manager.

Transmit Allow user to manually None
transmit a study to another
station through the Study
Manager.

View Allow user access to the Study STUDY_MANAGER
Manager. Users with the rights
to the Study Manager can
delete studies even if they do
not have the Delete Images
operation (refer to page 23) in
the list of PACS Client
operations. (To disable access
to the manager, all other
operations for the manager
must be cleared as well.)

Study Presentation
Manager

View Allow user access to the Study None
Presentation Manager.

Web Compression

Manager

Delete Allow user to delete records ~ None
from the Web Compression
Manager.

Save Allow user to save changes None
made in the Web Compression
Manager.
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Operation Description Corresponding 5.2 Service Tools

privilege

View Allow user access to the Web ~ None
Compression Manager. (To
disable access to the manager,
all other operations for the
manager must be cleared as
well.)

IMPAX 5.2 preferences migrated to IMPAX 6.5.1

(Topic number: 54780)

User preferences Migrated? Details

List area

User Keywords Yes The keywords created to drive workflows continue to be
used in IMPAX 6.5.1.

Worklists No The worklist architecture changed significantly. Standard
worklists are used in IMPAX 6.5.1.

Scripts (Select wizards) No The Select Wizard is no longer available in IMPAX 6.5.1.
This functionality has been replaced by standard worklists.

Columns No IMPAX 6.5.1 supports worklist-specific columns set up
during the creation of a standard worklist.

Ronds No The IMPAX 5.2 Ronds information is not compatible with

IMPAX 6.5.1. Use the scheduled worklists along with the
Snapshot tool to create Ronds in IMPAX 6.5.1.

Configure area - Preferences

Default Printers and Print Yes The printer configurations are compatible with

Presets IMPAX 6.5.1.

Relevancy rules Yes The storage of Relevancy rules information has moved
from IMPAX 5.2 database to the IMPAX 6.5.1 ADAM
database.

Composite Layouts Yes WYSIWYG print templates have been renamed to
Composite Print Layouts.

Patient name format No The implementation of patient name has changed.

(single-byte, phonetic, and IMPAX 6.5.1 can provide single-byte, phonetic, and

SO on) ideographic versions of patient names.
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User preferences Migrated? Details

Search Locations No

Transmit Locations No

Worklists - Study Arrival No

Worklists - Audible No
Notification
Reporting method - No

Analog, TalkStation, Serial
Configure area - Users and Roles

User information (user ID, Yes
password, long name,

description)
User and license Yes
assignment
User mapping (to No

enterprise LDAP servers)

Permissions No

Configure area - Printers

Printer information (type, Yes

Cannot migrate this user setting to an IMPAX 6.5.1 role.
Search locations are set and configured within the
Configure > Preferences area.

This user setting cannot be migrated to an IMPAX 6.5.1
role. In IMPAX 6.5.1, Transmit Locations are set and
configured within the Configure > Preferences area.

The worklist architecture changed significantly in
IMPAX 6.0.2. The studies added to the worklist are
controlled by settings in the Configure > Preferences
section and by Worklist settings in the Image area >
Customize dialog.

In IMPAX 6.5.1 the Audible Notification operator is
enabled by selecting Audible Notification from the User
ID menu found on the List or Configure area bar.

Reporting methods are set in Configure area - Preferences,
Text area bar, Reporting tab.

IMPAX 5.2 user information can be migrated to the
IMPAX 6.5.1 ADAM database, including IMPAX
passwords and user names.

IMPAX 6.5.1 uses a role-based access control model. The
migration process moves users from IMPAX 5.2 privilege
levels to IMPAX 6.5.1 roles.

User and Group mappings are new features in
IMPAX 6.5.1. They define how the users are authenticated
in the cluster and what roles they are associated with.

The default permissions for IMPAX 6.5.1 are based on
roles. They can be customized prior to the migration if
necessary. The user information for IMPAX 5.2 is not
compatible with this model.

Printer information functionality is consistent between

AE title, hostname) IMPAX 5.2 and IMPAX 6.5.1.
Film sizes Yes Film sizes are consistent between IMPAX 5.2 and
IMPAX 6.5.1.
Formats Yes Formats are consistent between IMPAX 5.2 and
IMPAX 6.5.1.
LUTs Yes LUTs are consistent between IMPAX 5.2 and IMPAX 6.5.1.
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User preferences Migrated? Details

Image area

Comparative Review Yes
Sequences

Wizards Yes
Hanging Protocols Yes
Series Descriptions Yes
Keyboard Shortcuts Yes
Top toolbar, Context No
toolbar

Cine toolbar No
Screen Formats No

Default ERMF Settings ~ No

Default Tool No
Default Tool Scope No

Default Study/Series View No
modes

Strict Hanging protocols No
User Profile (default toggle No

settings)

Configurable Study Save No

Comparative review sequences functionality is consistent
between IMPAX 5.2 and IMPAX 6.5.1. New sequences
have been added, however.

Operations such as DELETE and EDIT apply only to
user-defined wizards and not those inherited from a role.

Hanging protocol functionality is consistent between
IMPAX 5.2 and IMPAX 6.5.1.

IMPAX 6.5.1 can add generated series description or
user-added manual descriptions.

Keyboard shortcuts are migrated for users, and system
keyboard shortcuts are migrated for the entire site.

The default configurations for the toolbars are based on
roles in IMPAX 6.5.1 and can be configured by the
administrator.

The default configurations for the toolbars are based on
roles in IMPAX 6.5.1 and can be configured by the
administrator.

The default configurations for the screen formats are based
on roles in IMPAX 6.5.1 and can be configured by the
administrator.

ERME Settings are not migrated. ERMF calibration is now
applied by default to studies of the selected modality.

The default tool is based on roles in IMPAX 6.5.1.

The default tool scope is based on roles in IMPAX 6.5.1
and can be configured by the administrator.

The default study/series view modes for the screen formats
are based on roles in IMPAX 6.5.1 and can be configured
by the administrator.

Strict Hanging protocols are standard with an IMPAX 6.5.1
license.

The user profile (default toggle settings) are based on roles
in IMPAX 6.5.1.

Configurable Study Save tool settings are controlled in the
user profiles in IMPAX 6.5.1 and must be redefined.

Markup Statistics No Markup Statistics are controlled in the user profile in
IMPAX 6.5.1 and must be redefined.
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User preferences Migrated? Details

Modality Preferences No User preferences for a specific modality are controlled by
user profiles in IMPAX 6.5.1 and must be redefined.

Window Level Presets No The default configurations for the Window Level presets
are based on roles in IMPAX 6.5.1 and can be configured
by the administrator.

Display Annotation Text No The feature is enabled with a study-based operation
assigned to a permission.

Link Tool defaults (Nav, No The default configurations for the link tool defaults are

W/L, Zoom/Pan) based on roles in IMPAX 6.5.1 and can be configured by

the administrator.

Spine Annotation labels ~ No The Spine Annotation tool is enabled only when a series
containing axial images is displayed.

Saved Window positions No Docking Scout and floating palettes settings are controlled
in the user profiles in IMPAX 6.5.1 and must be redefined.

Snapshots No In IMPAX 6.5.1, snapshots are saved to a scheduled
worklist.

Worklists - Active No Standard Worklists now contain multiple Boolean searches

Worklist settings to compile the search results.

Text area

Canned Study Comments Yes Study comments functionality is consistent between

IMPAX 5.2 and IMPAX 6.5.1.

Canned Keywords Yes Keyword functionality is consistent between IMPAX 5.2
and IMPAX 6.5.1.

Study data (Database migration)

Markup Yes Markup is consistent between IMPAX 5.2 and
IMPAX 6.5.1.

Teaching Files Yes The database table is the same in both versions. The
administrator must make the data compatible with
IMPAX 6.5.1.

Tabs Yes Tabs are consistent between IMPAX 5.2 and IMPAX 6.5.1.

Window Level Yes Window Level is consistent between IMPAX 5.2 and
IMPAX 6.5.1.

Magnification Yes Magnification is consistent between IMPAX 5.2 and
IMPAX 6.5.1.

Geometry Yes Geometry is consistent between IMPAX 5.2 and
IMPAX 6.5.1.
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User preferences Migrated? Details

Image Calibration Yes Image Calibration is consistent between IMPAX 5.2 and
IMPAX 6.5.1.

Rearranged Images Yes Rearranged Images are consistent between IMPAX 5.2 and
IMPAX 6.5.1.

Summary Series Yes Summary series created in IMPAX 5.2 are migrated to

IMPAX 6.5.1; however, users can only view the migrated
summary series and cannot edit the migrated summary
series.

Keywords Yes Keyword functionality is consistent between IMPAX 5.2
and IMPAX 6.5.1.

Study Comments Yes Study comments functionality is consistent between
IMPAX 5.2 and IMPAX 6.5.1.

Teaching Files - Folder No IMPAX 5.2 teaching file folders are migrated to

access IMPAX 6.5.1, but the permissions to access these folders
are not. To allow users to view the teaching files, the PACS
Administrator must manually configure the access to each

teaching file folder.
Station settings Migrated? Details
Configure area - Stations *
Video Card Settings Yes Video card settings are consistent between
IMPAX 5.2 and IMPAX 6.5.1.
Monitor Layout, Calibration, Yes Monitor layout, calibration, and extended
Extended settings (NEMA, Pixel settings are consistent between IMPAX 5.2 and
Size, JL Cooper jog shuttle) IMPAX 6.5.1.
Barcode Settings Yes Barcode settings are consistent between

IMPAX 5.2 and IMPAX 6.5.1.

Memory Configuration No Memory configuration has changed for
IMPAX 6.5.1 and must be redefined.

* These values are updated when a user logs into a particular IMPAX Client workstation for the first
time.

Feature comparison

(Topic number: 54907)

Some IMPAX 5.2 and WEB1000 features map to equivalents in IMPAX 6.5.1; others do not. While
IMPAX 5.2 is the focus of comparison, many of the 5.2 features are also available in IMPAX 4.5 and
IMPAX 5.3.
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IMPAX 5.2 and IMPAX 6.5.1 feature comparison: Select

(Topic number: 54961)

IMPAX 5.2
Select
features

Access Control

Access
Control

Application
Display

Images

Exit

Help

Hospital
Information
System

Licensing

Description

Configure the access control matrix
to give or deny access to system
features for all users.

After you create a worklist of patients
and studies, you must switch to
Display to view the images.
Depending on the modality and body
part you are viewing, the contents of
the toolbar and screen format vary.
Only studies highlighted in the
worklist are displayed.

If working in Display, to close the
program, click Exit. This takes you
to the login screen.

Click Help tool to view help
information

Used to connect to the HIS

Licenses are associated with physical
Client stations. They limit what
Client features can be made available
through access controls.

IMPAX 6.5.1 comparison

Configure area > Users and Roles -
Permissions tab

The administrator has complete control of
access to studies per user or role.

List area > Worklists

You can cycle all worklist studies in the
Image area, or you can select particular
worklist studies to open with images. You
can also open images from a search results
list.

List area, Configure area > Logout

Click Logout to close all Client windows and
return to the Login screen.

List area, Configure area > Help tool and
menu

Click the Help menu or tool to open the
home page of the IMPAX 6.5.1 Client
Knowledge Base: Extended, in the same
language displayed by the IMPAX Client
interface text.

Text area > Order panel

HIS information is displayed directly within
the Text area. All textual information is
collected in one spot to prevent interference
with image display.

Configure area - Users and Roles > Licensing
bar

Licenses are assigned to users and roles, not
physical stations. They limit what Client
features can be made available through
permissions.
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IMPAX 5.2 Description

Select
features

System Use the System Configuration tool
Configuration to launch the Service Tools.

Data Export
Burn CD with The Burn CD with Viewer tool is
Viewer used to burn studies to CD with the

Image Viewer, which allows them to
be viewed on computers that do not
have IMPAX installed.

CD Export CD Export burns the selected studies
onto the CD for export to another
station.

Image Management

Delete Image The functionality of the Delete tool
differs depending on if you are
working in Select or in Display. In
Select, Delete removes a selected
study from the local cache.

Information

Add Keywords Add, remove, or edit keywords
available for system-wide use.

All Study Contain all the comments associated
Comments with all studies for a patient. It is a
read-only version of the comments.

Associate There are two steps to using
Keywords keywords. First, make the keyword

IMPAX 6.5.1 comparison

Configure area, Administration Tools > All

System-wide configurations are made in the
Configure area. Some system variables are
still defined in the Service Tools, which are
now called Administration Tools.

List area, Image area > Export Studies
command

The Export Studies command opens the
Export dialog, where you can select the CD
> Prepare Local CD option and select the
Include image viewer on each disk checkbox.
The Image Viewer functionality is the same
as in IMPAX 5.2 and earlier.

List area, Image area > Export Studies
command

The Export Studies command opens the
Export dialog, where you can select the CD
> Burn Local CD option to launch a
previously prepared burn job.

Image area > Delete Image tool

Removes the selected image from a study.
(You can also remove a study from a worklist
by right-clicking it and selecting Remove,
but the study remains in the system.)

List area, Text area > Keywords

Keywords functionality is the same as
previous versions of IMPAX.

Text area > Study panel, Study Comments

Displays study comments. All study
comments are displayed in the Text area.
Study information popups do not cover the
image.

List area, Text area > Keywords
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IMPAX 5.2 Description IMPAX 6.5.1 comparison

Select
features
available to system users in the Add Keywords functionality is the same as
Keywords dialog. Second, associate  previous versions of IMPAX.
keywords with various studies. After
a keyword is associated with a study,
perform a search for the study using
that keyword as one of your Finder
Criteria.
Keywords A keyword is a descriptive word or  List area, Text area > Keywords
p?rase gsed to indicate the contents Keywords functionality is the same as
O E S0 previous versions of IMPAX.
Study The Study Information dialog Text area > Study panel
Information Erlessergts thehdeteul(sil gathered from the . plays the study metadata. All study
about the study. information is now collected into the Text
area and study information popups do not
appear over the image.
Network
Support There are three types of IMPAX Installation > Configuration
1Cnst;1llli1t10n of Dlzpéay S(‘;a‘luons:ﬁlacheless,fCacl?ed, Supports Cacheless and Standalone stations
Cache(;:ss, and >tanda onef.f N tﬁ’pe of station only. Cached stations are not supported in
S ac (f 1’ Y}? ulﬁpis)l(nlg)? TCtSSt € Way you us€ 1\[pAX 6.5.1. Standalone no longer has a
tandalone  the isplay Station to view g 4. o qin caller.
images.
Organization
Bookmark Take a freeze frame of the current ~ Image area > Set Aside
state of D}Splay, in case of Set Aside feature in Image area. Rather than
interruption. save a bookmark, users “set aside” a study
when interrupted. The study appears as a
tab in the Image area. Studies are set aside if
the station logs out automatically after a
configured period of disuse.
Display Allows you to view the bookmark  Image area > Set Aside
Sooianas Fhat you ce:iptured when youwere ¢y the Study tab in the Image area to
interrupted. return to a set aside study. It is saved as they
left it.
Load Snapshot Load a snapshot from Select. Image area > Snapshot
This feature is available in the menu beside
the snapshot button.
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Select

features

Schedule The Schedule contains a collection of
studies you set up to view at a later
time.

Patient / Image / Series Linking

Link Patients Link Patients is a Select menu item
that connects studies for a patient
that has multiple records with
different patient IDs.

Study Management

Protect Study Use Protect Study to prevent
Autopilot from removing particular
studies from cache. If you unprotect
a study, the study becomes available
again for deletion from cache.

Retrieve Study Retrieve a study residing in a location
other than the IMPAX cluster where
your machine is located before you
can view it.

Transmit - The Transmit tool sends selected

Select studies to other cached stations
located within or outside the cluster
(for example, to a doctor who is
working from home).

Teaching File

Teaching File Add studies into a teaching file. Once
added, you can move studies to
another folder or copy them to other
folders if more than one description
applies to the study.

UCSF The UCSF Teaching File system is an

Teaching File application specific to UCSF for the
purposes of cataloging and
distributing teaching file information
to its physicians.

Tools

IMPAX 6.5.1 comparison

List area > Worklists

IMPAX 6.5.1 streamlines standard and
scheduled worklists together into a new
interface.

List area > Link Patients command

Linking multiple patient records as one
patient, you can view all of the studies and
priors for that patient together.

Text area > Study panel

Select a study and select the Protect
checkbox to prevent a study from being
deleted from cache by the Administration
Tools Autopilot function.

List area, Text area > Worklist, search
results, or Study List

An icon indicates studies that need to be
retrieved. Right-click the study and select
Retrieve.

List area, Image area > Transmit command

Send studies to external stations or locations
outside the cluster. Accessible through a
worklist or Advanced Search bar menu and
the Image area context menu.

Text area > Study List

Teaching files are viewed and managed
through Teaching Files tab of the Study List
in the Text area.

This feature is not available in IMPAX 6.5.1.
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IMPAX 5.2 Description IMPAX 6.5.1 comparison

Select

features

Display Test functions such as Data Integrity This tool is no longer available, but you can
Quality and Image Subtraction. The toolis  still test monitor quality by using DICOM
Control most effective when used in SMPTE images.

Images conjunction with test images whose

qualities are already known.

FixUp Use the FixUp tool to compare List area > Fix Up command
unverified studies against
information in the HIS/RIS to fix
typographical errors.

The Fix Up command is accessible from a
worklist bar menu. Compare unverified
studies against information in the HIS/RIS
to fix typographical errors.

Inject Test Adds a test file from a CD to the This tool is no longer available, but you can

Images database. Use the test file is used to ~ still test monitor quality by using DICOM
calibrate images and to test image =~ SMPTE images.
levels

Print Take the images from a selected study List area, Image area > Export Studies
and prints them to film or paper. command

The Export Image command opens the
Export dialog, where you can select the Print
option to print studies, series, images, or
selected images to a DICOM printer.

Print The Print Parameters tool allows you Configure area > Printers
Parameters  to configure the settings for all Add or edit printer attributes and delete

installed p rinters, agd to set system- printers in this section of the Configure area.
and user-level printing presets based

on modality.

Retrieve The Retrieve Report tool opens the = Text area > Report panel
Report report or dictated diagnosis

Th 1 h ing vi
associated with a study. e report related to the study being viewed

in the Image area is displayed in the Report
panel of the Text area. This facilitates the
comparison of prior reports to prior images,
particular on two- and three-monitor
workstations.

Wizards

Edit Wizards Make the necessary changes to the  List area > Wizard toolbar, Edit command

wizard. List area wizards in the IMPAX 6.5.1 Client
use VB.NET as a scripting language.
Although created in the List area, they can
affect the Image area, Configure area, or
other applications—they are not limited to
List area actions.
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Select
features

New Wizard A custom wizard records a series of List area > Wizard toolbar, New command
steps that a user performs repeatedly
to automate that task. A wizard can
contain any action performed in
Select. They are created by recording
the actions to be performed by the
wizard.

List area wizards use VB.NET as a scripting
language. Although created in the List area,
they can affect the Image area, Configure
area, or other applications. The functionality
previously performed by Select wizards is
largely replaced by creating standard
worklists.

Record New  Records a series of steps that a user  List area > Worklists
Wizard performs repeatedly to automate that

task The functionality previously performed

using Select wizards is now available by
defining standard worklists. These cannot
be created by recording actions, however.

Worklist and Worklists Management

Add to After you have examined the contents List area > Worklists

Worklist of the Search Results list and
determined which studies you want
to view, add those studies to the
worklist to view them in Display.

Standard worklists are populated
automatically based on predefined criteria.
They can be set to automatically update as
new studies come in. You can drag studies
from a standard worklist to a scheduled

worklists.
Add With Al Move selected studies from the List area > Worklists, search results
Studies Search Resplts list to the worklist Wlth Studies in search results do not have to be
all of studies for the selected Patient

moved to worklists before you can open

ID. them in the Image area. Just right-click the
study and select Open with Images.
Add With The selected studies are moved to the List area > Relevance button
Relevant worklist. If any relevant priors or T 1 . .
. iy : . t tomatically wh
Priors additional studies are retrieved, all © OpeT Televalt priors automaticaly waen

you cycle a worklist or open a study with

studies for that patient are grouped images, click the Relevance button.

under the patient name in the
worklist. The patient name has a
folder with a plus symbol (+) beside
it to indicate more than one study.

New Create a new worklist with the Finder List area > Worklist Library
Criteria set to default. Worklists are created and added in the
Worklist Library.
Open To open multiple worklists, use the  List area > Worklist Library
Open tool. The performance level of
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Select
features

your system determines the number Select the worklists to display from the
of worklists you can open duringa  Worklist Library.
session.

Refresh Query Search the database based on the List area > Worklists, Advanced Search
combination of Finder Criteria you
select. Studies that match all the
criteria are returned in the Search

Advanced Search includes a New Search
checkbox. To update worklists, you can click
the Refresh button. Worklists can also be

Results list. configured to update automatically with new
studies.
Remove All Move all studies in the current List area > Worklists

from Worklist worklist back to the Search Results

. ; > To remove studies from a worklist
list. Use this tool to clear the worklist. ’

right-click them and select Remove.

Reset Query  Clear the Search Results list and List area > Advanced Search

Criteria (rietfurris all Emder Criteria back to the dvanced Search includes a New Search
efault settings. checkbox.

Save Save stores a worklist for future use. List area > Worklist Library

Created worklists are automatically saved
for future use.

Show Study  Used to view the Stat Study list. This feature is not available in IMPAX 6.5.1.
Arrival
Window
All Studies Return all studies matching given ~ List area, Text area > Search, Study List
PRzt D) Using Search or Advanced Search, you can
locate all studies for a patient by name or
ID. As well, all Patient Priors known to
IMPAX are automatically loaded in the
Study List area when the study is displayed.
Relevant Studies are returned as relevant only List area, Text area > Relevance button,
Priors if there are prior rules set up for your Study List
User ID. To open relevant priors automatically when
you cycle a worklist or open a study with
images, click the Relevance button. All
Patient Priors known to IMPAX are
automatically loaded in the Study List area
when the study is displayed.
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IMPAX 5.2 and IMPAX 6.5.1 feature comparison: Display

(Topic number: 54975)

IMPAX 5.2 Display Description

features

IMPAX 6.5.1 comparison

Access Control

Access Control Configure the access control
matrix to give or deny access
to system features for all users.

Application

Exit If working in Display, click
Exit to return to the Select
screen.

Help Click Help tool to view help
information

Licensing Licenses are associated with
physical Client stations. They
limit what Client features can
be made available through
access controls.

System Configuration Use the System Configuration
tool to launch the Service
Tools.

Configure area > Users and Roles -
Permissions tab

The administrator has complete control
of access to studies per user or role.

Image area > Text button (single
monitor)

IMPAX no longer has the concept of
closing the Image area. To return to the
List area or Text area on a
single-monitor, click the Text button.
With multiple monitors, the Image area
can stay open (but sometimes blank).
To exit the application, click Logout.

Image area, List area, Conﬁgure area >
Help tool and menu

Click the Help menu or tool to open the
home page of the IMPAX 6.5.1 Client
Knowledge Base: Extended, in the same
language displayed by the IMPAX Client
interface text.

Configure area - Users and Roles >
Licensing bar

Licenses are assigned to users and roles,
not physical stations. They limit what
Client features can be made available
through permissions.

Configure area, Administration Tools
> All

System-wide configurations are made
in the Configure area. Some system
variables are still defined in the Service
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IMPAX 5.2 Display

Description

IMPAX 6.5.1 comparison

features

Undo/Redo Toggle

Data Create

Summary Series

Summary Study

Data Export
Copy to Clipboard

Export as AVI

Export as JPEG

Data Import

Reverse/reapply the action.

The Summary Series tool
opens a floating palette to
which you can add images to
create a summary sampling
from the study.

Combines images from one or
more series or studies as a
summary study.

Copy individual images to the
Windows Clipboard for use in
any graphics program.

The Export as AVI tool
exports images within a
selected series as an AVI file.

The Export Images as JPEG
tool exports selected images,
an entire series of images, or

an entire study as .jpg format
files.

Tools, which are now called
Administration Tools.

This feature is not available in
IMPAX 6.5.1. The Undo and Redo tools
are still available.

Image area > Add to Key Images
command

Summary Series is replaced by key
images in IMPAX 6.5.1. Key images are
added through the context (right-click)
menu.

Image area > Summary Study tool

Combines images from one or more
series or studies as a summary study.

Image area > Export Studies command

The Export Image command opens the
Export dialog, where you can select the
Copy to Clipboard option to copy the
clicked image to the Windows
Clipboard for use in other graphics
programs.

Image area > Export Studies command

The Export Image command opens the
Export dialog, where you can select the
AVI option to convert studies, series,
or selected images to AVI format.

Image area > Export Studies command

The Export Image command opens the
Export dialog, where you can select the
JPEG option to convert studies, series,
selected images, or one image to JPEG
format.
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features
Import Image Adds an image in BMP or Image area > Import tool
JPEG format to a study. Adds an image in BMP or JPEG format
to a study.
Dictation
Dictate Marking a study as Dictated, Image area > Dictate Study tool

changes the study status to
indicate that you have
assumed dictation
responsibility for a study.

Changes the dictation status of a single
study to dictation started or dictation
completed.

Dictate — Multiple Studies Dictate multiple studies. Image area > Dictate Study tool

To launch dictation on multiple studies
for one patient, right-click the Dictate
Study button and select which studies
to dictate.

Show Dictation Window  Use the Show Dictation Image area > TalkStation integration
window to view the status of

A When using the TalkStation integration,
your current dictation.

right-click the Dictate Study button and
select the Show/Hide Dictation Window

command.

Image Management

Delete Image Removes the selected image  Image area > Delete Image tool

from a study. Removes the selected image from a

study.

Image Processing

Compression Used to set the compression  Image area > View Original Images tool

configuration ratio applied to the image. TMPAX 6.5.1 users (with permission to
do so) can configure whether they
receive full DICOM or wavelet images.
The server determines the compression
configuration.

Information

All Study Comments The All Study Comments tool Text area > Study panel, Study
contains all the comments Comments

associated with all studies for Displays study comments. All study

comments are displayed in the Text
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IMPAX 6.5.1 comparison

features

a patient. It is a read-only
version of the comments.

Study Information The Study Information dialog
presents the details gathered
from the RIS about the study.

Internationalization

CJK decoded data Display data using East Asian
characters.

Markup

Tumor Volume (Calculate The Volume tool allows you

the Volume of a Series of to find the volume of a Region

ROI's) of Interest (ROI) in a CT or
MR study, specifically the
volume of tumors.

Navigation

Advance by The Advance button is a toggle

Page/Image/Tab that determines how you can
scroll through images in
Display.

Tab Toggle Adds navigation tabs to
images of interest.

Organization

Bookmark Take a freeze frame of the

current state of Display, in
case of interruption.

area. Study information popups do not
cover the image.

Text area > Study panel

Displays the study metadata. All study
information is now collected into the
Text area and study information popups
do not appear over the image.

All areas > CJK

IMPAX 6.5.1 has similar CJK display
capabilities as IMPAX 5.2.

This feature is not available in
IMPAX 6.5.1.

Image area > Advance by Image, page,
or Tab tool

Allows you to scroll from one image or
frame to the next; pages through images
in a large series, one screen at a time;
allows you to scroll from one tabbed
image to the next.

Image area > Tab Toggle tool

Adds navigation tabs to images of
interest.

Image area > Set Aside

Set Aside feature in Image area. Rather
than save a bookmark, users “set aside”
a study when interrupted. The study
appears as a tab in the Image area.
Studies are set aside if the station logs
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features

Description

IMPAX 6.5.1 comparison

Display Bookmark

Load Snapshot

Add Snapshot to Schedule

Schedule

Allows you to view the
bookmark that you captured
when you were interrupted.

Load a snapshot from Select.

Use the Add Snapshot to
Schedule tool to add snapshots
you create to the schedule for
viewing at a later time.

The Schedule contains a
collection of studies you set up
to view at a later time.

Patient / Image / Series Linking

Link Patients

Link Series

Link Series by Table
Position

Use this menu item to link all
the studies for the patient for
viewing in Display.

Connects two or more series
so that navigation, window
leveling, or zooming
performed on one series
applies to them all. With this
tool, you manually
synchronize series.

Connects series with
automatic slice position
synchronization so that
navigation, window leveling,
or magnification performed
on one series applies to all
series.

out automatically after a configured
period of disuse.

Image area > Set Aside

Click the Study tab in the Image area to
return to a set aside study. It is saved as
they left it.

Image area > Snapshot

This feature is available in the menu
beside the snapshot button.

Image area > Snapshot

Associate snapshots with a scheduled
worklist by using the Snapshot tool.

List area > Worklists

IMPAX 6.5.1 streamlines standard and
scheduled worklists together into a new
interface.

List area > Link Patients command

Linking multiple patient records as one
patient, you can view all of the studies
and priors for that patient together.

List area > Link Series tool

Connects two or more series so that
navigation, window leveling, or
zooming performed on one series
applies to them all. With this tool, you
manually synchronize series.

List area > Link Series tool

Connects series with automatic slice
position synchronization so that
navigation, window leveling, or
magnification performed on one series
applies to all series.
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Description

IMPAX 6.5.1 comparison

features
Print

WYSIWYG Print

Snapshot
Take Snapshot

Study Management
Transmit - Display

Study Presentation

Demographics Toggle

Display Markups Toggle

Magnify Glass

This tool opens the
WYSIWYG Printing utility
where you can drag and drop
specific images to create a
custom print layout.

Take the snapshot for the
study and the changes after it
was taken are included in the
snapshot.

Send studies to other cached
stations or to cached stations
located outside the cluster,
(for example, to a doctor who
is working from home).

Shows or hides patient
demographics on study
images.

Hides all markups, displays all
markups, or displays only
your markups.

Opens a separate window that
magnifies the section of the
image directly beneath.

Image area, Configure area >
Composite Layout Chooser tool,
Preferences - Composite Layout tab

WYSIWYG has been renamed as
Composite Layouts Templates are
created in the Configure area and are
then accessible in the Image area by
anyone with the appropriate privileges.
The functionality is the same as before.

Image area > Snapshot tool

Takes a snapshot of the current layout,
including screen formats and window
levels, and saves it to a scheduled
worklist for use during a round or
conference.

List area, Image area > Transmit
command

Send studies to external stations or
locations outside the cluster. Accessible
through a worklist or Advanced Search
bar menu and the Image area context
menu.

Image area > Demographics Toggle tool

Shows or hides patient demographics
on study images.

Image area > Display Markup Toggle
tool

Hides all markups, displays all markups,
or displays only your markups.

Image area > Magnify Glass tool
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features

IMPAX 6.5.1 comparison

Magnify Rectangle Zooms in on a specific area of
an image.
Magnify/Pan Reset Reverts all magnification and

panning applied to any images
in the study to the previously
saved state.

Presentation State Applies a grayscale softcopy
Selection presentation state.
Teaching File

Teaching File Add studies into a teaching

file. Once added, you can
move studies to another folder
or copy them to other folders
if more than one description
applies to the study.

UCSF Teaching File The UCSF Teaching File
system is an application
specific to UCSF for the
purposes of cataloging and
distributing teaching file
information to its physicians.

Tools

Auto Window Level on  Obtains the optimum window

ROI level values within a selected
region of the image and
applies those values to the
entire image.

Opens a separate window that magnifies
the section of the image directly
beneath. Available from the Zoom
button menu.

Image area > Magnify Rectangle tool

Zooms in on a specific area of an image.

Image area > Magnify/Pan Reset tool
tool

Reverts all magnification and panning
applied to any images in the study to
the previously saved state. Available
from the Zoom button menu.

Image area > Presentation State
Selection tools

Applies a grayscale softcopy
presentation state.

Text area > Study List

Teaching files are viewed and managed
through Teaching Files tab of the Study
List in the Text area.

This feature is not available in
IMPAX 6.5.1.

Image area > Auto Window Level on
Selected ROI tool

Obtains the optimum window level
values within a selected region of the
image and applies those values to the
entire image. Available from the
Window Level button menu.
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features

Description

IMPAX 6.5.1 comparison

Breakout Gated Series

Cine Viewer

Collimate

Compare

Configurable Study Save

Create Combined Series

Cursor Mode

Creates a temporary series that
displays the same point of a
heart cycle through time in
NM studies.

Plays back series in
Ultrasound, XA, and NM
studies, for example, either in
a continuous cine or
frame-by-frame.

Crops an image to eliminate
any unnecessary matter. The
Collimate tool is used most
often on DF or RF studies.

Displays two enlarged copies
of an image side by side and
assess the effect of changing
the window level or other
presentation options.

Saves the changes of the type
specified in the user profile
that were made to the current
study.

Scrolls through all of the
images in the study, without
series boundaries, by
combining all of the series in
the study into a new series.

Presents a 3D context for
images in MR studies and
shows the location of slice
positions.

Image area > Break Out Gated Series
tool

Creates a temporary series that displays
the same point of a heart cycle through
time in NM studies.

Image area > Cine Viewer tool

Plays back series in Ultrasound, XA, and
NM studies, for example, either in a
continuous cine or frame-by-frame.

Image area > Collimate tool

Crops an image to eliminate any
unnecessary matter. The Collimate tool
is used most often on DF or RF studies.
Available from the Markup button
menu.

Image area > Compare tool

Displays two enlarged copies of an
image side by side and assess the effect
of changing the window level or other
presentation options.

Image area > Configurable Study Save
tool

Saves the changes of the type specified
in the user profile that were made to the
current study.

Image area > Create Combined Series
tool

Scrolls through all of the images in the
study, without series boundaries, by
combining all of the series in the study
into a new series.

Image area > Cursor Mode tool

Presents a 3D context for images in MR
studies and shows the location of slice
positions.
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Customize Use the Customize dialog to
configure how Display
functions.

Display Annotation Opens an Annotation dialog.
Use this dialog to place

freeform text on the image.

Display Quality Control  Test functions such as Data

Images Integrity and Image
Subtraction. The tool is most
effective when used in
conjunction with test images
whose qualities are already
known.

Display Scout Opens a Scout window that
shows the slice location in CT
and MR studies.

Edit DICOM Elements  Edits the image acquisition
elements kVp, mAs, SID, and
Technician Code.

Edit Markups Moves or resizes image
markups.

Extended Monitor Display Displays an enlarged instance
of a series in a new window on
an extended color monitor.

Image area > Customize tool

Opens a dialog for setting user
preferences for toolbars, screen layouts,
hanging protocols, startup defaults,
markup statistics, automatic study
saves, modality preferences, image
wizards, keyboard shortcuts, and cine
viewer.

Image area > Markup Annotation tool

Opens an Annotation dialog. Use this
dialog to place freeform text on the
image. Available from the Markup
button menu.

This tool is no longer available, but you
can still test monitor quality by using
DICOM SMPTE images.

Image area > Display Scout tool

Opens a Scout window that shows the
slice location in CT and MR studies.
Fixed button in the top toolbar.

Image area > Edit DICOM Elements
tool

Edits the image acquisition elements
kVp, mAs, SID, and Technician Code.

Image area > Edit Markup tool

Moves or resizes image markups.
Available from the Markup button
menu.

Image area > Extended Monitor Display
tool

Displays an enlarged instance of a series
in a new window on an extended color
monitor.
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FixUp

Flip Horizontal

Flip Vertical

Geometry Reset

Image Enhancement
(Sharpen)

Image Information

Image Pasting

Image Selection

Use the FixUp tool to compare
unverified studies against
information in the HIS/RIS to
fix typographical errors.

Rotates a selected image along
its horizontal axis.

Rotates a selected image along
its vertical axis.

Returns all rotation and flips
applied to any image in the
study back to the previously
saved state.

Produces a sharper, enhanced
image edge by accentuating
the difference between a pixel
value and a weighted average
of the surrounding pixels.

Displays demographic details
and orthopaedic implant
details and allows you to print
the information

Aligns a series of XA images
that were taken to track a
radiopaque agent through the
body.

Selects images that other tools
can be applied to.

Image area > Fix Up command

The Fix Up command is accessible from
a worklist bar menu. Compare
unverified studies against information
in the HIS/RIS to fix typographical
errors.

Image area > Flip Horizontal tool

Rotates a selected image along its
horizontal axis. Available from the
Geometry button menu.

Image area > Flip Vertical tool

Rotates a selected image along its
vertical axis. Available from the
Geometry button menu.

Image area > Geometry Reset tool

Returns all rotation and flips applied to
any image in the study back to the
previously saved state. Available from
the Geometry button menu.

Image area > Image Enhancement tool

Produces a sharper, enhanced image
edge by accentuating the difference
between a pixel value and a weighted
average of the surrounding pixels.

Image area > Image Information tool

Displays demographic details and
orthopaedic implant details and allows
you to print the information

Image area > Image Pasting tool

Aligns a series of XA images that were
taken to track a radiopaque agent
through the body.

Image area > Image Selection tool

Selects images that other tools can be
applied to.
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Inject Test Images

Invert

Markup Angle

Markup Arrow

Markup Arrow - Line

Markup Arrow - Thick

Markup Caliper

Markup Ellipse

Adds a test file from a CD to
the database. Use the test file
is used to calibrate images and
to test image levels

The Invert tool exchanges the
white and black areas in an
image.

Measures angles in an image.

Places a markup arrow to
point to areas of interest.

The Markup Arrow - Line tool
creates a line arrow to
pinpoint areas of interest on
an image. The size of the
arrowhead is proportional to
the length of the line drawn.

The Markup Arrow - Thick
tool creates a thick, filled
arrow to pinpoint areas of
interest on an image. The size
of the arrowhead is
proportional to the length of
the line drawn.

Measures the distance between
two points.

The Markup Ellipse tool
highlights elliptical anomalies
on an image.

This tool is no longer available, but you
can still test monitor quality by using
DICOM SMPTE images.

Image area > Invert tool

The Invert tool exchanges the white and
black areas in an image. Available from
the Window Level button menu.

Image area > Markup Angle tool

Measures angles in an image. Available
from the Markup button menu.

Image area > Markup Arrow tool

Places a markup arrow to point to areas
of interest. Available from the Markup
button menu.

Only a single type of Markup arrow is
available, although the arrow
automatically adjusts for size depending
on length.

Only a single type of Markup arrow is
available, although the arrow
automatically adjusts for size depending
on length.

Image area > Markup Caliper tool

Measures the distance between two
points. Available from the Markup
button menu.

A Markup Ellipse tools is available for
measuring elliptical regions of interest.
See “Markup Region of Interest (ROI)”
later in this table.

Migrations Reference Guide—IMPAX 5.2 or 5.3 or WEB1000 to IMPAX 6.5.1
Agfa Company Confidential—Subject to Non-Disclosure Obligation

77



IMPAX 5.2 Display Description

features

IMPAX 6.5.1 comparison

Markup Erase The Markup Erase tool
removes any markup
associated with an image.

Markup Freeform Deletes markups.

Markup Profile Creates a graph that illustrates
the Hounsfield Unit of the
image pixels intersected by a
line drawn on the image.

Markup Ratio Caliper Creates a ratio measurement
of two lines on an image.

Markup Rectangle Measures a rectangular region
of an image.

Markup Region of Interest Measures an elliptical region.

(ROI)

Markup Reset Reverts all markups applied to
any images in the study to the
previously saved state.

Multi-Planar Allow you to view anatomy

Reformatting along its central axis or
perpendicular to that central
axis.

NM Palette Reset Removes all color palettes

applied to the current study.

Image area > Markup Erase tool

Deletes markups. Available from the
Markup button menu.

Image area > Markup Freeform tool

Measures an irregularly shaped area.
Available from the Markup button
menu.

Image area > Markup Profile tool

Creates a graph that illustrates the
Hounsfield Unit of the image pixels
intersected by a line drawn on the
image.

Image area > Markup Ratio Caliper tool

Creates a ratio measurement of two
lines on an image. Available from the
Markup button menu.

Image area > Markup Rectangle tool

Measures a rectangular region of an
image. Available from the Markup
button menu.

Image area > Markup Ellipse tools

Measures an elliptical region. Available
from the Markup button menu.

Image area > Markup Reset tool

Reverts all markups applied to any
images in the study to the previously
saved state. Available from the Markup
button menu.

Image area > Volume Viewing tool

MPR is handled via a separate,
integrated application called Volume
Viewing.

Image area > NM Palette Reset tool
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Nuclear Medicine Palette

Pan

Patient Priors

Pin/Unpin Studies

Pixel Value Toggle

Print

Print Parameters

Applies a specified color
palette to grayscale images in
a study.

Changes the image position
without changing the
magnification

The Patient Priors tool
displays a list of all studies for
the current Patient ID.

Pins a study in place and keeps
it visible while navigating
through other studies for the
patient.

Displays or hides the image
pixel value beneath the
pointer.

The Print tool takes the
images from a selected study
and prints them to film or

paper.

The Print Parameters tool
allows you to configure the
settings for all installed
printers, and to set system-

Removes all color palettes applied to
the current study.

Image area > Nuclear Medicine Palette
tool

Applies a specified color palette to
grayscale images in a study.

Image area > Pan tool

Changes the image position without
changing the magnification

Text area > Study List

All Patient Priors known to IMPAX are
automatically loaded in the Study List
area when the study is displayed. Prior
information is always available,
reducing steps required to access
required information.

Image area > Pin/Unpin Studies tool

Pins a study in place and keeps it visible
while navigating through other studies
for the patient.

Image area > Pixel Value Toggle tool

Displays or hides the image pixel value
beneath the pointer. Available from the
Markup button menu.

List area, Image area > Export Studies
command

The Export Image command opens the
Export dialog, where you can select the
Print option to print studies, series,
images, or selected images to a DICOM
printer.

Configure area > Printers

Add or edit printer attributes and delete
printers in this section of the Configure
area.

Migrations Reference Guide—IMPAX 5.2 or 5.3 or WEB1000 to IMPAX 6.5.1
Agfa Company Confidential—Subject to Non-Disclosure Obligation

79



IMPAX 5.2 Display Description

features

IMPAX 6.5.1 comparison

and user-level printing presets
based on modality.

Projection Mode Displays an enlarged instance
of an image in a projection
window.

Rearrange Images Reorders the images in a series

Rearrange Series Reorders the series in a study.

Redo Reverses the effect of the

previous Undo command.

Replication/Interpolation "Switches between pixel

Toggle replication and pixel averaging
mode for redrawing images on
magnification.”

Reset Images Reverts all images in the study

to their previously saved state.

Rotate 180 Rotate images 180 degrees.

Rotate Left Rotates images 90 degrees to
the left.

Rotate Right Rotates images 90 degrees to
the right.

Image area > Projection Mode tool
Displays an enlarged instance of an
image in a projection window.
Image area > Rearrange Images tool

Reorders the images in a series

Image area > Rearrange Series tool

Reorders the series in a study.

Image area > Redo tool

Reverses the effect of the previous Undo
command

Image area > Replication/Interpolation
Toggle tool

Switches between pixel replication and
pixel averaging mode for redrawing
images on magnification.

Image area > Reset Images tool

Reverts all images in the study to their
previously saved state.

Image area > Rotate 180 tool

Rotates images 180 degrees. Available
from the Geometry button menu.

Image area > Rotate Left tool

Rotates images 90 degrees to the left.
Available from the Geometry button
menu.

Image area > Rotate Right tool

Rotates images 90 degrees to the right.
Available from the Geometry button
menu.
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Save

Scope

Screen Format

Segment Study

Series View Mode

Service Window

Set Series Hanging
Protocol

Show Available Series

Smooth Rotation

Saves selected changes to the
study.

Defines whether tool actions
apply to one image, to all
images in the series, or to all
images in the study.

Defines how images, series,
and studies are arranged in
columns and rows on an
Image area monitor.

The Segment study tool
assigns the images of the
performed study to each of the
scheduled studies.

Defines whether each Image
area monitor that displays the
same studies also displays the
same series of those studies.

Displays DICOM header
information for an image.

Applies an available hanging
protocol to the current study.

Opens the Available Series
window

The Smooth Rotation tool is
used in CR studies. This tool

Image area > Save tool

Saves selected changes to the study.

Image area > Scope tool or command

Defines whether tool actions apply to
one image, to all images in the series, or
to all images in the study. Also available
as a context (right-click) menu
command.

Image area > Select Screen Format tool

Defines how images, series, and studies
are arranged in columns and rows on
an Image area monitor.

List area > Advanced Search - Segment

Segmenting a study means breaking a
single study into multiple studies for
one patient. Available from the
Advanced Search bar menu.

Image area > Series View Mode tool

Defines whether each Image area
monitor that displays the same studies
also displays the same series of those
studies.

Image area > Service Window tool
Displays DICOM header information
for an image.

Image area > Set Series Hanging
Protocol tool

Applies an available hanging protocol
to the current study.

Image area > Show Available Series
tools

Opens the Available Series palette.

Image area > Smooth Rotation tool
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features
allows you to trace the Rotates an image by making a line
incorrect angle and the result drawn on the image perfectly vertical .
makes the line you draw Available from the Geometry button
perfectly vertical. menu.

Sort by Attribute Sorts images in the series Image area > Sort by Attribute tool
accc?lr)dlng to available DICOM Sorts images in the series according to
attributes available DICOM attributes

Spine Annotation Labels the location of slices in Image area > Spine Annotation tool
axial MR or CT images. Labels the location of slices in axial MR

Available in the Scout

X or CT images. Available in the Scout
window.

window.

Split multi-phasic Series ~ Splits a multi-phasic series ~ Image area > Split Multi-Phasic Series
into multiple series, each tool

containing one phase. Splits a multi-phasic series into multiple

series, each containing one phase.

Split Study Split a study into an existing List area > Advanced Search - Split
patient record. This feature is
used if images from one
patient were mistakenly
associated with a study for
another patient.

Splitting a study means associating
some of the images from a study with a
different patient. Split is used when
images from one patient are mistakenly
associated with a study for another
patient. Available from the Advanced
Search bar menu.

Study View Mode Defines whether each Image Image area > Study View Mode tool
area monitor displays different
studies or whether studies
span two or four monitors.

Defines whether each Image area
monitor displays different studies or
whether studies span two or four
monitors.

System Layout Protocols  Applies a system screen layout Image area > System Layout Protocols
to the current patient, tool
changing how the studies,
images, and series are
displayed on the available

Applies a system screen layout to the
current patient, changing how the
studies, images, and series are displayed

LRI on the available monitors
Template Opens images into the Image area > Template tool or
Orthopaedic Application command
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window, an integrated
application.

Undo Reverse the last change made.

User Image Calibration ~ Calibrates an image, series, or
study; reverts from user to
modality calibration; or
applies ERMF calibration, if
available.

View Structured Report  The View Structured Report
tool opens the structured
report associated with a
cardiology study.

Window Level Changes image brightness and
contrast by adjusting window
center and window width
values.

Window Level DR Images Changes the window level
values of an image based on
graphical curve adjustments.

Window Level Preset With the Window level preset
tool, you can override the
window level defaults that the
system administrator has
defined in the Modality
Preferences tab of the
Customize dialog.

Window Level Reset Reverts window level changes
to the previously saved state.

Opens images into the Orthopaedic
Application window, an integrated
application.

Image area > Undo tool

Reverses the last change made.

Image area > User Image Calibration
tool

Calibrates an image, series, or study;
reverts from user to modality
calibration; or applies ERMF
calibration, if available.

IMPAX 6.5.1 has a similar set of tools
for cardiology as previous versions, but
the majority of the cardio functionality
comes from the integration with
IMPAX Cardiovascular.

Image area > Window Level tool

Changes image brightness and contrast
by adjusting window center and
window width values and gives access
to preset window level values. Available
from the Window Level button menu.

Image area > Nonlinear Window Level
tool

Changes the window level values of an
image based on graphical curve
adjustments.

Image area > Window Level tool

Right-click the Window Level button
tool to access the window level preset
values. Available from the Window
Level button menu.

Image area > Window Level Reset tool
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Reverts window level changes to the
previously saved state. Available from
the Window Level button menu.

Zoom Magnifies or reduces images Image area > Zoom tool

in increments. . . .
crements Magnifies or reduces images in

increments. Available from the Zoom
button menu.

Zoom 1:1 Pixel Displays the selected image at Image area > Zoom 1:1 Pixel tool

2 L3l el Displays the selected image ata 1:1

ratio. Available from the Zoom button
menu.

Zoom to Full Screen Magnifies a single image to ~ Image area > Zoom to Full Screen tool

full screen size. Magnifies a single image to full screen

size. Available from the Zoom button
menu.

Zoom True Size Displays the image at itsactual Image area > Zoom True Size
size, based on available image

; ) Displays the image at its actual size,
information.

based on available image information.
Available from the Zoom button menu.

Wizards

Wizard A custom wizard record a Image area > Wizard buttons
series of steps that a user
performs repeatedly to
automate that task.

Wizards are defined in the Customize
dialog, Wizards tab. They can then be
assigned to tool buttons that can be
added to the top or context toolbars.
Wizards automate repetitive tasks.

WEB1000 and IMPAX 6.5.1 feature comparison

(Topic number: 55002)

WEB1000 Description IMPAX 6.5.1 comparison

features

Access Control
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Grant Access Used to allow other teams to
view studies.

Switch Teams Used to switch to an additional
team for viewing the different
studies.

WEB1000 Teams Usedin WEB1000 to determine
which studies you are allowed

to view.
Advanced
Monitor Used to verify that your
Calibration monitor is calibrated correctly
through test through the Test Pattern.
pattern
Application

Broker Support A middleware component in the
integration between Hospital
Information Systems and PACS
systems.

Button Size The WEB1000 window is
resized to a narrow enough size.

Change Password Allow user to change the
password for maintaining the
security of WEB1000.

Concurrent Users Display the current user logged
into the client, user's current
team ID, default team 1D,
privilege level and user ID.

IMPAX 6.5.1 comparison

Configure area > Users and Roles

The Administrator defines images that users
have access to. User may also have emergency
access granted to them to allow access to
particular studies on an emergency basis.

Teams do not exist in IMPAX 6.5.1. Users exist
in an organizational structure in LDAP server,
and may be organized into specific roles within
this structure with access based on membership
to that role.

Teams do not exist in IMPAX 6.5.1. Users exist
in an organizational structure in LDAP server,
and may be organized into specific roles within
this structure with access based on membership
to that role.

Configure area > Stations

Monitor calibration is now set through the
Configure area - Stations section.

Configure area, Connectivity Manager > Users
and Roles

Licenses for features are assigned to users and
roles through the Configure area. Connectivity
Manager replaces Broker.

Button size cannot be configured in
IMPAX 6.5.1.

List area, Configure area > Change Password
command

Select the Change Password command from
the User ID menu.

Configure area > Users and Roles

Feature Licensing. Different implementation
from previous versions, but offers greater
functionality. Licenses for features are assigned
to users/roles in the Configure area.
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Conference with Collaborate about a study with No conference capabilities are available in
current study other users logged into the IMPAX 6.5.1.

system.
Configure Client Set the Client Log level by Configure area > Stations
Log Level selecting either Debug, Info, or

Configure area allows for changes to the
IMPAX Client logging level to debug problems.
New method of configuration, but similar to
previous versions in logging levels available.

Error log level.

Configure Study Set the Study page to show only List area > Worklists

Columns certain columns of information -
Users or administrators may configure the

in the Display list. column display in the IMPAX 6.5.1 Client
using right-click functionality.

Configure Set toolbars by modality. Image area > Customize tool

Toolbars The Toolbars tab in the Customize dialog is

used to define which tool buttons are available
in the toolbars.

Display as Images Specify the study format. List area > Worklists

Display with Images or Add to Cycle list allows
users to display a selected study.

Display as Display the study images in the There are no thumbnail display options in

Thumbnails thumbnail tab IMPAX 6.5.1. IMPAX 6.5.1 offers a larger set
of image display options to solve the same
problems that viewing a study in thumbnails
solves, such as key images and Available Series

palette.
Enable default ~ Used to compress images for ~ Configure area, Administration Tools > Users
lossy faster viewing. Can be set by ~ and Roles
compression defautt. The Administrator determines which users

have access to view full fidelity or wavelet
images and compression ratios. Compression
setting are confined to a central location for
ease of administration.

EPR URL. Small software application EPR > URL Integration

which runs within a web IMPAX 6.5.1 allows integration of the Image

browser. area into another application via a URL. URL
integration is similar to previous versions, but
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EPR JavaScript. Small software
application which runs within
a web browser.

EPR Java API to store all user
account information in
WEB1000.

EPR The Java applet used by
WEB1000 is signed with a

digital certificate allowing it to
access certain features of your
computer such as printing.

EPR availability  The purchased licensing feature.

Generic Status ~ The Service Tools application is

Message used by service and
administrative personnel to
configure and maintain the
cluster.

Licensed Features Used to list all of the purchased
licensed features.

Modality Viewing CR, DR, XA, MG. view a series
of images from a modality.

IMPAX 6.5.1 comparison

requires a full install of the IMPAX Client on
EPR computers.

EPR > URL Integration

IMPAX 6.5.1 allows integration of the Image
area into another application via a URL. URL
integration is similar to previous versions, but
requires a full install of the IMPAX Client on
EPR computers.

EPR > .NET integration

IMPAX 6.5.1 allows complete integration of
the Image area into another application for
image display purposes.

This feature is not available in IMPAX 6.5.1.

Configure area > Users and Roles

Feature licensing is completely different from
previous versions, but offers greater

functionality. Licenses for features are assigned
to users and roles through the Configure area.

Image area > Status bar

Image area displays information in the lower
toolbar similar to the information that was
previously available.

List area > Help > About IMPAX

The type of license can be viewed, but the
features available in that license is not
displayed. Descriptions of the licenses are
available in the IMPAX Documentation.

Configure area > Users and Roles

Feature licensing is completely different from
previous versions, but offers greater

functionality. Licenses for features are assigned
to users and roles through the Configure area.
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Multiframes to ~ Used to display MPEGs as Configure area > Users and Roles
MPEG wavelets.

Feature licensing is completely different from
previous versions, but offers greater

functionality. Licenses for features are assigned
to users and roles through the Configure area.

Multiframes to  Allow licensed users to view ~ Configure area > Users and Roles
wavelet multiframe MPEG study images

Feature licensing is completely different from
as wavelets.

previous versions, but offers greater
functionality. Licenses for features are assigned
to users and roles through the Configure area.

Online Help Used to open the WEB1000 List area, Configure area, Image area > Help
Knowledge Base button or menu

Click the Help menu or tool to open the home
page of the IMPAX Client Knowledge Base, in
the same language displayed by the IMPAX
Client interface text.

Software module List packages, modules and No software module versions functionality is
versions their corresponding version available in IMPAX 6.5.1.
numbers included in the server
build.
Switch server Used to search other locations  There is no switch server functionality available
for studies. in IMPAX 6.5.1.
Third-party List all of the third party vendor List area > Help > About IMPAX
hbrarlles, Versions, prod}lcts, verspns and Some third-party libraries, versions, and
copyrights providers used in WEB1000 .

copyright information is displayed in the About
box. Other copyright information is available
in the IMPAX Documentation.

Using IE ActiveX URL ActiveX enables the EPR > Help > URL Integration
Control software to view MPEGs with

) IMPAX 6.5.1 allows integration of the Image
licensed component.

area into another application via a URL.

Webstart Used to start WEB1000 for the This feature is not available in IMPAX 6.5.1.
first time.
Authentication
LDAP The external authentication Installation > Configuration
name.
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MVE The database user name,
defined in the ODBC, usually
mvf.

NT Domain NT server name.

Radius Radius server name.

WEB1000 Tickets Used to make Client-Server
communicated.

Client Machine

Configure Disk  Specify the Disk Cache Size in

Cache size (for ~ megabytes to store the pulled

Pull) images.

Configure RAM  Specify the RAM Cache size to

Cache size store the images.

Set Machine Configure the profile settings

Settings for your machine.

Conference

Cancel Chat Erase what you have typed

contents before they are sent in the
conference.

Chat History View all messages that have
been composed by the users.

Disconnect Disconnect from a conference

session.

Freeform drawing Not available in Display tab
tool

Image ROI Used to start formatting the

shape of the Region of Interest.

IMPAX 6.5.1 comparison

LDAP authenticates users on the system.
IMPAX 6.5.1 may use an internal LDAP
database, or a site enterprise LDAP database.

In IMPAX 6.5.1, user authentication is done
through LDAP.

Configure area
In IMPAX 6.5.1, user authentication is done
through LDAP.
This feature is not available in IMPAX 6.5.1.

IMPAX 6.5.1 authenticates tickets with the
LDAP server.

This feature is not available in IMPAX 6.5.1.

Configure area > Stations

Change the RAM cache in the Configure area
- Stations, General bar, Memory tab.

Configure area > Stations

Configure local IMPAX Client machine
settings.

No conference capabilities are available in
IMPAX 6.5.1.

No conference capabilities are available in
IMPAX 6.5.1.

No conference capabilities are available in
IMPAX 6.5.1.

No conference capabilities are available in
IMPAX 6.5.1.

No conference capabilities are available in
IMPAX 6.5.1.
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WEB1000 Description IMPAX 6.5.1 comparison

features
Image Slider Used to add the Image Slider to No conference capabilities are available in
the toolbars. IMPAX 6.5.1.
Link Images Used when making changes to No conference capabilities are available in
an image that you want to apply IMPAX 6.5.1.
to all images in that series. For
example, adjusting
window/level.
Screen Format 1x1, 2x2, 3x2, 3x3, 4x4 No conference capabilities are available in
IMPAX 6.5.1.
Sent Chat Check the message that has No conference capabilities are available in
Contents been sent to other users in the IMPAX 6.5.1.
conference.
Window Level ~ Use window/level tools to No conference capabilities are available in
manipulate image contrast by IMPAX 6.5.1.
adjusting window center and
window width.
Connectivity

Optional Broker Broker support may not be IMPAX 6.5.1 supports Connectivity
support available; the client must be able Manager 2.3 only for modality worklist, HIS
to handle this effectively and  verification, and reporting.
remove inappropriate features.

Database
SQLServer and  Support and maintain the Installation > Server
Oracle database  WEB1000 server. IMPAX supports usage of both Oracle and
SRS MSSQL databases.
Display
Display Display the images at the Image area > Screen layouts
radiologist's display station. IMPAX 6.5.1 has the ability to display images
in a variety of different formats.
Toggle Series Used to toggles the Thumbnail Image area > Show Available Series tool
Selector Series T‘ray _Off to provide a Show Available Series palette includes docking
larger viewing area or on for features.
ease of navigation.
File Caches
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WEB1000 Description

features

Support for Image Cache vs. Web Cache;
multiple caches  configuration must exist for
for possible Image / Study Deletes

media types

Image Management

Delete Studies Delete studies from the
WEB1000 Server.

Image Processing

Compression Used to set the compression
configuration ratio applied to the image.
Information

Study Used to view all the information
Information available for a study
Internationalization

CJK decoded data Used to display the CJK data.

Markup

Caliper Used to measure the distance
between two points in
millimeters. .

Flip Horizontal =~ Used to rotate and flip images.

IMPAX 6.5.1 comparison

Installation > Server

IMPAX 6.5.1 maintains separate caches for
DICOM and Wavelet data—image cache for
DICOM data and web cache for wavelet.

Administration Tools > Study Manager

Delete study in the Administration Tools is the
same as it was in previous versions of the
Service Tools. There is no delete of studies
from the Client.

IMPAX 6.5.1 users (with permission to do so)
can configure whether they receive full DICOM
or wavelet images. The server determines the
compression configuration.

Text area > Study panel

Display of study metadata. All study
information is now collected into the Text area,
and study information pop-ups do not appear
over the image.

All areas > CJK

IMPAX 6.5.1 has similar CJK display
capabilities as IMPAX 5.2.

Image area > Markup Caliper tool

Available in the top toolbar from the Markup
button menu. Similar to previous versions of
IMPAX, but different from WEB1000
implementation.

Image area > Flip Horizontal tool

Available in the top toolbar from the Markup
button menu. Similar to previous versions of
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WEB1000 Description IMPAX 6.5.1 comparison

features
IMPAX, but different from WEB1000
implementation.
Flip Vertical Used to rotate and flip images. Image area > Flip Vertical tool
Flip Vertical tool
Save Markup Used to save to the database any Image area > Save tool
markups you have made to the Select Save from top toolbar and choose to save
tmage. markup. Users may also use the Configurable
Save tool to define what is saved ahead of time.
MPEG

Adjust Brightness Adjust brightness or contrastas Image area > Cine Viewer tool

/ Contrast the MEEG isiplaying; Cine Viewer and the brightness/contrast

feature can be configured to be in the top or
context toolbar. There is no MPEG support in
IMPAX 6.5.1

Adjust Framerate Change the number of frames Image area > Cine Viewer tool

played per second. In the Cine Viewer toolbar. change the number
of frames played per second with the Frame
Rate slider or field. There is no MPEG support
in IMPAX 6.5.1.
Adjust Min/Max Display the min/max size at Image area > Cine Viewer tool
frame which the MPEG is played. Customize the starting point per body part per
modality. There is no MPEG support in
IMPAX 6.5.1.
Full-screen Playback images in full screen  There is no MPEG support in IMPAX 6.5.1.
playback mode.
Pan Pan (when zoomed inonan  Image area > Cine Viewer tool
LELS) Grab and drag the cine while zoomed. There
is no MPEG support in IMPAX 6.5.1.
Play / Pause cine Pay/Pause images in a Image area > Cine Viewer tool
loop continuous loop or in still Pay/Pause images in a continuous loop or in
format. still format. There is no MPEG support in
IMPAX 6.5.1.
Save MPEG Save the MPEG images. There is no MPEG support in IMPAX 6.5.1.
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WEB1000 Description IMPAX 6.5.1 comparison

features
Set Current Set the current frames in the ~ There is no MPEG support in IMPAX 6.5.1.
Frame MPEG. For use in still format.
Zoom Used in Full Resolution mode Image area > Cine Viewer tool
to select the magnification The Cine Viewer toolbar can include a Zoom
value. button. There is no MPEG support in
IMPAX 6.5.1.
Navigation
Image Slider Used to add the Image Slider to Image area > Navigation
the toolbars.

Image navigation is available in the top toolbar.

Image Tagging  Used to navigate to the specific Image area > Advance by Tab tool, Tab Toggle
images. By tagging images, you tool
can scroll through just the
images that are of interest,
eliminating the need to
repeatedly view numerous
images.

Used to navigate to the specific images. By
tagging images, you can scroll through just the
images that are of interest, eliminating the need
to repeatedly view numerous images.

Next Series Used to navigate between series Image area > Show Available Series tool

in a study. The Show Available Series palette includes

navigation buttons.

Previous Series ~ Used to navigate between series Image area > Show Available Series tool

in a study. The Show Available Series palette includes
navigation buttons.
Select All Series  Combine all series into one. Image area > Create Combined Series tool
Combine all selected series into one series.
Network
Client Proxy Used to set up proxies in Configure area > Stations
SRS Lbsfrnet Explf)rer t(})lpass The Application Server acts much like a proxy
rﬁquest; 01;t/ m t?lt ¢ Internet machine to handle security, authentication,
through a tirewall. and communication with the IMPAX Server
components. Communication with the
Application Server is set in the Configure area.
Support all Support SSL and all types of ~ Installation > Server

combinations of proxy server designed to
(SSL or non-SSL) provide secure communications
x (Forward proxy on the Internet.

The Application Server acts much like a proxy
machine to handle security, authentication,
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WEB1000
features

and/or reverse

proxy) = 8
combinations

Print

Print

Reports

Adjust Font Size

DICOM
Structured
Report

HTML

HTML, PDE,
TXT, Word

Patient / Study
Selector

Print Report

Retrieve Reports

Description

Used to print images or reports.

Changes the font size on a
report.

The reports of radiologic images
and other medical information
transferred between computers
via DICOM.

Hypertext Markup Language.
Extension for a file read using
your web browser (Internet
Explorer or Netscape
Navigator).

Web 5 proposed feature

Used to navigate between
studies by patient on the
Display page

Used to print reports.

Used to retrieve available
reports from the broker.

IMPAX 6.5.1 comparison

and communication with the IMPAX Server
components.

List area, Image area > Export Studies
command

The Export Image command opens the Export
dialog, where you can select the Print option
to print studies, series, images, or selected
images to a DICOM printer.

Text area > Reports panel

Reports are viewed in the Reports panel;
however, the font size cannot be changed.

IMPAX 6.5.1 has a similar set of tools for
cardiology as previous versions, but the
majority of the cardio functionality comes from
the integration with IMPAX Cardiovascular.

Text area > Reports panel

Reports are viewed in the Reports panel;
however, reports cannot be saved under
different formats.

This feature is not available in IMPAX 6.5.1.

Text area > Reports panel

Reports are navigated by changing the patient
in focus in the Text area, or changing to an
available prior for a patient in focus. Reports
are displayed in the Report panel in the Text
area.

Text area > Reports panel

If using the IMPAX RIS, you can print reports
from the Text area.

Text area > Reports panel
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WEB1000 Description IMPAX 6.5.1 comparison

features
Reports are automatically displayed in Text
area. The user is not required to retrieve
reports as they are automatically available in
the Text area.

RTF Save reports in Rich Text Text area > Reports panel

o et Reports are viewed in the Reports panel;

however, reports cannot be saved under
different formats.

Support for Search and retrieve available = IMPAX 6.5.1 supports Connectivity Manager

Multiple Brokers reports from the multiple 2.3 only, which supports only one connection

for Reports brokers. to a report source at a time.

Toshiba Reports  Custom work was completed to This feature is not available in IMPAX 6.5.1.
modify report presentation for
Toshiba.

TXT Extension for a plain text file ~ Text area > Reports panel

(unformatted text). Reports are viewed in the Reports panel;

however, reports cannot be saved under
different formats.

Save

Save images as  Save an image to the local disk List area, Image area > Export Studies
JPEG as a JPEG image. command

The Export Image command opens the Export
dialog, where you can select the JPEG option
to convert studies, series, selected images, or
one image to JPEG format.

Security

Optionally Reduce the network traffic and Installation > Server

Restrlc';(all i secure the port access. IMPAX 6.5.1 Server is automatically armored
new?r trathic t; during installation to secure port access, as part
specific port an of an armoring script

protocol

Server configuration

Server logging ~ Used to configure the server ~ Configure tools

level configurable logging. CLUI, Administration Tools,and IMPAX 6.5.1
Business Services Configuration Tools handle
the various areas of logging. The Application

Migrations Reference Guide—IMPAX 5.2 or 5.3 or WEB1000 to IMPAX 6.5.1 95
Agfa Company Confidential—Subject to Non-Disclosure Obligation



WEB1000 Description

features

Serviceability

Activity Manager Service Tools.

Study Management

Protect Study Used to prevent studies from
being deleted from the
WEB1000 Server.

Study Presentation

Configure Client
Compression

Configure Scaling
Algorithm

Demographics
Configuration

Screen Format

Used to set up the amount of
compression applied to the
image.

Calculate magnification of the
images using a scale type.

The Display Overlay feature
shows or hides the demographic
information displayed on
images.

1x1, 1x2, 2x1, 2x2, 2x3, 3x2,
3x3, 4x4, full-res (1:1), wavelet
cine

IMPAX 6.5.1 comparison

Server adds an additional area where server
logging will need to be configured.

IMPAX 6.5.1 does not have equivalent
functionality.

Text area > Study panel

Select a study and select the Protect checkbox
to prevent a study from being deleted from
cache by the Administration Tools Autopilot
function.

Administrator configures compression at the
server and whether the end user is able to view
original or web images. Users are not able to
configure the lossy/lossless representation of
images, only the original or web. The current
implementation removes the need for the user
to decide what representation they should
request; the system or administrator does it for
them.

This feature is not available in IMPAX 6.5.1.

Image area > Demographics Toggle

Shows or hides patient demographics on study
images.

Image area > Screen Format tool

1x1, 1x2, 2x1, 2x2, 2x3, 3x2, 3x3, 4x4, full-res
(1:1), wavelet cine

Toggle Set the image default Image area > Demographics Toggle
Demographics 'demographlf:s displayed "‘“4 Shows or hides patient demographics on study
included patient demographics, images
study information, image
attribute, and other
demographic information set
by your system administrator.
Migrations Reference Guide—IMPAX 5.2 or 5.3 or WEB1000 to IMPAX 6.5.1 96

Agfa Company Confidential—Subject to Non-Disclosure Obligation



WEB1000 Description

features

Toggle lossy / Used to compress images for
lossless faster viewing. Can be set by
compression default.

Toggle MPEG /  Allow the user to indicate the

Wavelet users preference for the media

multiframe type to be used for multiframes
preference

Study Query

Query Studies are displayed grouped

by patient; Studies with conflicts
are displayed in red italics; o
Users are warned about studies
that fail verification through a
dialog.

Query Location  Search all locations, web cache
only, Web + HIS (Broker), or
remote PACS's

Refresh Query  Allow user to refresh the
studies.

Thumbnail Display

Display Selected Display the selected images with
Images preset study presentation
format.

Select All Images Used to select all of the images
in a study.

Select Study / Used to toggles the Thumbnail

Patient Series Tray off to provide a
larger viewing area or on for
ease of navigation.

IMPAX 6.5.1 comparison

The Administrator configures compression at
the server and determines whether the end user
is able to view DICOM or web images. The
user is not able to configure the lossy/lossless
representation of images, only original or web.

There is no MPEG support in IMPAX 6.5.1.

List area > Search

IMPAX 6.5.1 offers Advanced Search or Simple
search.

List area > Search

IMPAX 6.5.1 offers Advanced Search or Simple
search.

List area > Search

IMPAX 6.5.1 offers Advanced Search or Simple
search.

No thumbnail display options are in 6.5.1.
IMPAX 6.5.1 offers a larger set of image display
options to solve the same problems that
viewing a study in thumbnails solves, such as
key images and Available Series palette.

There are no thumbnail display options in
6.5.1. IMPAX 6.5.1 offers a larger set of image
display options to solve the same problems that
viewing a study in thumbnails solves.

There are no thumbnail display options in
6.5.1. IMPAX 6.5.1 offers a larger set of image
display options to solve the same problems that
viewing a study in thumbnails solves, such as
key images and Available Series palette.
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WEB1000 Description
features

Toggle Series Used to display small,
Thumbnail View low-resolution version of study
Images.

Waveform

Dynamic Used to control how the images
Playback format are played back.

Image Slider Used to add the Image Slider to
the toolbars.

Overlay other Overly the other additional
additional waveforms.
waveforms

Page backward 10 For use in static format.
s Displays previous 10 seconds.

Page forward 10 s For use in static format.
Displays next 10 seconds.

Play waveform  Play the waveform.

Standard 12-lead Display 12-lead ECG. Cannot
format be used to play waveforms.

Static Format Display in static format. Cannot
be used to play waveforms.
Activates Previous and Next 10
seconds buttons.

Stop waveform  Halt the cine player and
presents a still frame only.

IMPAX 6.5.1 comparison

There are no thumbnail display options in
6.5.1. IMPAX 6.5.1 offers a larger set of image
display options to solve the same problems that
viewing a study in thumbnails solves.

IMPAX 6.5.1 has a similar set of tools for
cardiology as previous versions, but the
majority of the cardio functionality come from
the integration with IMPAX Cardiovascular.

IMPAX 6.5.1 has a similar set of tools for
cardiology as previous versions, but the
majority of the cardio functionality come from
the integration with IMPAX Cardiovascular.

IMPAX 6.5.1 has a similar set of tools for
cardiology as previous versions, but the
majority of the cardio functionality come from
the integration with IMPAX Cardiovascular.

IMPAX 6.5.1 has a similar set of tools for
cardiology as previous versions, but the
majority of the cardio functionality come from
the integration with IMPAX Cardiovascular.

IMPAX 6.5.1 has a similar set of tools for
cardiology as previous versions, but the
majority of the cardio functionality come from
the integration with IMPAX Cardiovascular.

IMPAX 6.5.1 has a similar set of tools for
cardiology as previous versions, but the
majority of the cardio functionality comes from
the integration with IMPAX Cardiovascular.

IMPAX 6.5.1 has a similar set of tools for
cardiology as previous versions, but the
majority of the cardio functionality comes from
the integration with IMPAX Cardiovascular.

IMPAX 6.5.1 has a similar set of tools for
cardiology as previous versions, but the
majority of the cardio functionality comes from
the integration with IMPAX Cardiovascular.

IMPAX 6.5.1 has a similar set of tools for
cardiology as previous versions, but the
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WEB1000 Description

features
Elapsed time in seconds is
displayed on the toolbar.

Toggle Color Select color or black and white

Display view.

Toggle Grid Turn the background grid on

display or off.

Toggle looped Used to view waveforms in

playback motion. Activates the play, stop,
and enable/disable looping
buttons.

Zoom Mode Show zoomed sub region of
waveform.

Wavelet

Adjust Min/Max Display the min/max size at
frame which the wavelet is played.

Adjust Min/Max Display the min/max size at

frame which the wavelet is played.

Angle Used to mark the interior and
exterior angles formed by two
lines.

Ellipse Used to measure a round or
oblong area.

Freeform ROI Used to mark an area with an

irregular shape.

IMPAX 6.5.1 comparison

majority of the cardio functionality comes from
the integration with IMPAX Cardiovascular.

IMPAX 6.5.1 has a similar set of tools for
cardiology as previous versions, but the
majority of the cardio functionality comes from
the integration with IMPAX Cardiovascular.

IMPAX 6.5.1 has a similar set of tools for
cardiology as previous versions, but the
majority of the cardio functionality comes from
the integration with IMPAX Cardiovascular.

IMPAX 6.5.1 has a similar set of tools for
cardiology as previous versions, but the
majority of the cardio functionality comes from
the integration with IMPAX Cardiovascular.

IMPAX 6.5.1 has a similar set of tools for
cardiology as previous versions, but the
majority of the cardio functionality comes from
the integration with IMPAX Cardiovascular.

Image area > Cine Viewer tool

In the Cine Viewer toolbar. change the number
of frames played per second with the Frame
Rate slider or field.

Image area > Cine Viewer tool

Display the min/max size at which the wavelet
is played.

Image area > Markup Angle tool

Available in the top toolbar from the Markup
button menu.

Image area > Markup Ellipse tool
Available in the top toolbar from the Markup
button menu.

Image area > Markup Freeform tool

Available in the top toolbar from the Markup
button menu.
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WEB1000 Description IMPAX 6.5.1 comparison
features

Invert Reverse the background and ~ Image area > Invert tool

foreground colors of any image. Available in the top toolbar from the Markup

button menu.

Magnify Glass ~ Used to enlarge an area of an ~ Image area > Magnify Glass tool
image. You can drag the
magnify glass to different areas
of interest on the image.

Available in the top toolbar from the Markup
button menu.

Magnify Used to magnify a staticareaon Image area > Magnify Rectangle tool

Rectangle the image. Available in the top toolbar from the Markup

button menu.

Pan Used to drag the image on the Image area > Pan tool

screen to see all parts of the Used to drag the image on the screen to see all

tmage. parts of the image.
Play / Pause / Play/Pauses/Stops the wavelet. Image area > Cine Viewer tool
Stop loop Play/Pauses/Stops the wavelet.
Progressive Download all the imagesina  Image area
Download study. Users can progressively download image data
to the client. If users are using wavelet (web)
images in display, only the data that is needed
is downloaded. This feature is not available
with full DICOM images.
Save Window Used to save the value of IMPAX 6.5.1 does not have the ability to save
level as preset adjusted brightness and contrast a window level preset based on changes made
on an image. to the current study. Window level presets are
created via the Customize menu in the Image
area.

Select Window  Used to choose the brightness Image area > Window Level tool

Level from Preset and contrast on an image. Right-click the Window level button menu to

select the preset to apply.

Set Current Display the current frame Image area > Cine Viewer tool
Frame playing. Display the current frame playing.
Set Zoom (%) Display the size at which the ~ Image area > Cine Viewer tool

wavelet is played. Display the size at which the wavelet is played.
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WEB1000 Description

features

Toggle looping  Play the wavelet from start to
finish continuously.

Toggle Rocking  Play the wavelet from start to
finish and then from finish to
start continuously.

Window Level =~ Manipulate image contrast by
adjusting window center and
window width.

Zoom Used in Full Resolution mode
to select the magnification
value.

Wizards

Edit Existing Modify search wizard criteria,

Wizard constraints, and names using
the Wizard tab on the
Preferences tool.

New Wizard Create custom automatic
searches.

Worklist Management

Pull All Used download all images in a
study to the local hard disk on
your computer.

IMPAX 6.5.1 comparison

Image area > Cine Viewer tool

Play the wavelet from start to finish
continuously.

Image area > Cine Viewer tool

Play the wavelet from start to finish and then
from finish to start continuously.

Image area > Window Level tool

Manipulate image contrast by adjusting
window center and window width. This may
be the default tool in the Image area, so no
action is required. If it is not the default tool,
it is available in the top toolbar from the
Window Level button menu.

Image area > Zoom tool

Available in the top toolbar from the Zoom
button menu.

List area > Worklists

The functionality previously performed using
wizards is now available by defining standard
worklists.

List area > Worklists

The functionality previously performed using
wizards is now available by defining standard
worklists.

This feature is not available as IMPAX 6.5.1
does not support cached clients.
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IMPAX 5.2 tables obsolete in IMPAX 6.5.1

(Topic number: 55118)

Some of the entries in the IMPAX 5.2 and 5.3 database tables have become obsolete in the IMPAX
6.5.1 database.

Obsolete tables in WSQL

(Topic number: 55025)

Table name Module name

mitra_voice_command_keywords activex-voice
mitra_display_pinned_studies display-sql
mitra_display_special_format display-sql
mitra_display_config display-sql
mitra_ae_config display-sql
mitra_display_markup_text display-sql
mitra_display_modality_config display-sql
mitra_display_worklist display-sql
mitra_user_calibration display-sql
mitra_display_modality_toolbar display-sql
mitra_display_hanging protocol display-sql
mitra_display_site_hanging display-sql
mitra_display_toolbar_buttons display-sql
mitra_display_format display-sql
mitra_display_user_wizards display-sql
mitra_display_wizards display-sql
mitra_display_site_wizards display-sql
mitra_display_priv_wizards display-sql
mitra_lut_tables display-sql
mitra_display_snapshot display-sql
mitra_display_mpr_vr_presets display-sql
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Table name Module name

mitra_display_ordering
mitra_display_study_sorting
mitra_display_xml_config
mitra_display_wizard_state
mitra_display_echo_values
mitra_display_echo_data
jselect_data_dictionary
jselect_user_script_button
mitra_select_available _combos
mitra_select_available_columns
mitra_select_user_columns
mitra_select_user_combos
mitra_finder_wizards
mitra_select_toolbar
mitra_select_user_settings
mitra_cerner_apps
mitra_select_telerad_aes
mitra_select_rond_items
mitra_select_rond_config
mitra_select_rond_departments
mitra_select_rond_link
mitra_select_rond_holidays
mitra_select_user_toolbar
mitra_study_arrive_rule_xml
cd_burn_wizard
cd_export_service
mitra_window_positions
mitra_select_avail context

mitra_select_user_context

mitra_select_status_macros

display-sql

display-sql

display-sql

display-sql

display-sql

display-sql

mvf-jselect-sql
mvf-jselect-sql
mvf-select-sql
mvf-select-sql
mvf-select-sql
mvf-select-sql
mvf-select-sql
mvf-select-sql
mvf-select-sql
mvf-select-sql
mvf-select-sql
mvf-select-sql
mvf-select-sql
mvf-select-sql
mvf-select-sql
mvf-select-sql
mvf-select-sql
mvf-select-sql
mvf-select-sql
mvf-select-sql
mvf-select-sql
mvf-select-sql
mvf-select-sql

mvf-select-sql
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Table name

mitra_user_enumerated_attr
mitra_avail_study_list_columns
mitra_user_study_list_columns
mitra_user_study_list_defaults
mitra_mw_finder_wizards
mitra_user_fixup_columns
mitra_avail_fixup_columns
mitra_user_rond_columns
mitra_avail_rond_columns
dosr_user.user.data.sql
mitra_select_user_keyword
mitra_user_tf_report_items

mitra_avail_tf_report_items

Module name

mvf-select-sql
mvf-select-sql
mvf-select-sql
mvf-select-sql
mvf-select-sql
mvf-select-sql
mvf-select-sql
mvf-select-sql
mvf-select-sql
display-sql

mvf-select-sql
mvf-select-sql

mvf-select-sql

Obsolete tables in ORAS

(Topic number: 55124)

Table name Module name

mf_staff

mf procedure
mf_location
mtk_query_constraints
mtk_user_source
mtk_user_destination
mtk_user_layout
dosr_team
dosr_user_team
dosr_user_history
dosr_password_history

dosr_privileges

dosr_wl_presets

mtk
mtk
mtk
mtk
mtk
mtk
mtk
dosr
dosr
dosr
dosr
dosr

dosr

Migrations Reference Guide—IMPAX 5.2 or 5.3 or WEB1000 to IMPAX 6.5.1
Agfa Company Confidential—Subject to Non-Disclosure Obligation

104



Table name Module name

dosr_user dosr
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Default operations for
each role

The following information lists the default operations for each role.

Administrator role: Default Administration Tools
operations

(Topic number: 54865)

Legend:
A Assigned functionality
I Inherited functionality

Administration

Operation Clerical IT Security Service System
Officer Administrator
Autopilot Management
View A A A

Basic Framework

Acknowledge A A A
Delete A A
View A A A
Basic Routing Manager
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Administration

Operation Clerical IT  Security Service System
Officer Administrator
View A A A
Body Part Manager
View A A
Cache Manager
View A A A
Cache Monitor
View A A A

Demographic Layout Manager
New DICOM Field A A
View A A

Enumerated Values Manager

View A A
Image Access Manager

View A A
Job Manager

Start/Halt Queues A A A

View A A A
Network Manager

View A A A

Patient Location Manager

View A A
Print Date Manager

View A A
Quality Test Manager

View A A A

Queue Monitor
View A A A
Relevant Prior Manager

View A A
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Administration

Operation Clerical IT  Security Service System
Officer Administrator
Routing Manager
View A A A
Scavenger Manager
% Note: A A A
Do not use. As of
IMPAX 6.5, Scavenger
Manager is no longer
supported.
Source Manager
View A A A
Specialty Manager
View A A
Study Manager
Add/Remove Search and A A
Transmit Locations
Delete Completely A A
Delete from Archive A A
Delete from Cache A A
Fix All Studies A A
Lock/Unlock Study A A
Merge A A
Merge Physicians A A
Protect/Unprotect Study A A
Retrieve A A A
Split A A
Store A A A
Store to Archive A A
Store to Archive (Open) A A
Store to Archive (New) A A A
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Administration

Operation Clerical IT  Security Service System
Officer Administrator
Store to Archive (Dictated) A A A
Store to Archive (Reported) A A A
Store to Archive (Approved) A A A
Study Information A A A
System-Wide Values A A
Transmit A A A
View A A A
Study Presentation Manager
View A A
Web Compression Manager
Delete A A
Save A A
View A A A

Administrator role: Default Audit Manager
operations

(Topic number: 54868)

Legend:

A Assigned functionality
I Inherited functionality
General

Administration

Operation Clerical IT Security Officer Service System
Administrator
Administrator Role A
Security Officer Role A
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Administrator role: Default PACS Server operations

(Topic number: 54874)

Legend:

A Assigned functionality
I Inherited functionality
General

Administration

Operation Clerical IT Service

Security Officer

System

CLUI

Administrator

Administrator role: Default PACS Client operations

(Topic number: 54871)

Legend:
3D 3D visualization Mod_CT Display of CT modality type
A Assigned functionality Mod_DR Display of DR modality type
CA Client automation Mod_MG Display of MG modality type
CAD Display of CAD markers Mod_MR Display of MR modality type
COMPREV  Mammography Mod_NM Display of NM modality type
CONFIG Configuration area Mod_US Display of US modality type
CS Context Server Mod_XA Display of XA modality type
HP Hanging protocols oT Orthopaedic integration
I Inherited functionality QC Quality
L1 Level 1 Basic Feature Set RONDS Scheduling and review of ronds
L2 Level 2 Basic Feature Set TF Teaching files
Mod_ALL Display of all modality types TS TalkStation integration
Mod_CR Display of CR modality type
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General

Administration

Operation License Top-level Clerical IT Security Service System
level Officer Administrator
At-a-Glance A
Edit At-a-Glance L1 A
Messages
Show At-a-Glance L1 I I I I I A
Audible Notification L1 I I I I I A
Change Password CONFIG 1 I I I I A
Configure Area A A A
Individual CONFIG A
Configuration
Preferences CONFIG A A
Printers CONFIG A A A
Service CONFIG A
Stations CONFIG A A A
Users and Roles  CONFIG A A
Context Server A
Integrations
Allow Single CS I I I 1 I A
Sign-on
Enable Context  CS I I I 1 I A
Server
Integrations
Cycle Studies L1 A
Delete Study A
Edit Columns L1 A
Edit Enumerated Values A
Edit Viewable Worklists A
Export and Import A
Studies
Export Studies L1 A A
with Image
Viewer
Export Studies L1 A A
with Reports
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Administration

Operation License Top-level Clerical IT Security Service System
level Officer Administrator
Import Studies L1 A A
History L1 I I I 1 I A
Image Area L1 I I I 1 I A
Image Area Tools A
3D 3D A
Active Target L1 A
Apply Hanging ~ HP A
Protocols
Apply System L1 I I I 1 I A
Layout Protocols
Auto Window L1 I I I I I A
Level
Break Out Gated L1 A
Series
Cine Viewer L1 I I I I I A
Comparative COMPREV A A
Review
Compare L1 I I I 1 I A
Create Combined L1 I I I I I A
Series
Create Summary L2 I I I I I A
Study
Customize L1 I I I I I A
Demographics L1 I I I 1 I A
Toggle
Display Markup L1 I I I I I A
Toggle
Display Scout L1 I I I 1 I A
Edit New Series L1 A
Descriptions
Extended Monitor L1 I I I I I A
Display
Histogram L1 A
Equalization
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Administration

Operation License Top-level Clerical IT Security Service System
level Officer Administrator
Image L2 A
Enhancement
Image L1 I I I I I A
Information
Window
Image Pasting L1 A
Image Selection L1 I I I 1 I A
Linking L1 I I I I I A
Mammography  CAD A
CAD SR Toggle
MPR L2 A
Nonlinear L1 I I I 1 I A
Window Level
Nuclear Medicine L1 A
Palette
Paired Zoom and L1 A
Pan
Pin Study L1 I I I I I A
Pixel Value Toggle L1 I I I 1 I A
Presentation State L1 I I I 1 I A
Selection
Projection L1 I I I I I A
Rearrange Series L1 I I I I I A
Screen Layout L1 I I I 1 I A
Service Window L1 A A A
Sort Images L1 I I I I I A
Split Multi-Phasic L1 I I I I I A
Series
Tab Stops L1 A
True Size L1 A A
Undo/Redo/Reset L1 I I I I I A
View Original L1 A
Images
Window Level L1 I I I 1 I A
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Administration

Operation License Top-level Clerical IT Security Service System
level Officer Administrator

Window Level L1 I I I 1 I A
Preset

Image Area Wizards A
Create or Import CA I I I I I A
Wizards
Delete Wizards CA A A
Edit Wizards CA A A
Run Wizards CA I I I I I A

Job Manager A
Delete Jobs L1 A A A
Enable Job L1 A A A
Manager
Modify Any Job L1 A A A
Modify Job L1 A A A
Priority

Key Images Edit Favorite L1 A

Titles

Keywords A
Edit Personal L1 I I I I I A
Keywords
Edit System L1 A
Keywords

Link Patients L1 I I I I I A

Messaging Service
Instant Messaging L1 A I I I I A
Receive Study L1 A
Messages

Modality A
View All MOD_ALL 1 I I 1 I A
View CR MOD_CR A
View CT MOD_CT A
View DR MOD_DR A
View MG MOD_MG A
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Administration

Operation License Top-level Clerical IT Security Service System
level Officer Administrator
View MR MOD_MR A
View NM MOD_NM A
View US MOD_US A
View XA MOD_XA A
Orthopaedic Application OT A
Override permissionson TF A A
a folder
Print A
Edit Composite 1.2 A A
Layouts
Print to Paper L1 I I I I I A
Quality Control A
Acknowledge QC A A
Conflict
Fixup, Segment, QC A A
Merge, and Split
Studies
Quick Fix Up QC A A
Remember User Settings L1 I I I I I A
Scripting A
Configure Scripts L1 A A A
Run Scripts L1 I I I I I A
Search for Open Studies L1
Searching for studies A
Add Search L1 A A
Criteria
Advanced Search L1 A A A
Configure Simple L1 A
Search Criteria
Simple Search L1 I I I I I A
Use Relevant Prior L1 I I I I I A
Rules
Set Default Image Type L1 A
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Operation

License
level

Administration

Top-level Clerical IT Security Service System
Officer Administrator

TalkStation Integration TS A

Teaching Files A A
Add Teaching File TF
Folders
Delete Teaching  TF
File Folders
Modify Teaching TF
File Folders
Update Teaching TF
File Folders
View Teaching TF
File Folders

Text Area A
Configure L1 A
SmartSeek Tabs
Edit Favorite L1 A A
Study Comments
Enable Enterprise L1 A
Study List
Enable Text Area L1 I I I I I A
Private Study L1 A
Comments

Update Study L1

Worklists A
Configure Global L1 A
Priority Groups
Edit Viewable L1 A
Worklists
Personal L1 A
Worklists
Scheduled A
Worklists
Add Studies to RONDS A
Scheduled
WorKklists
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Administration

Operation License Top-level Clerical IT Security Service System
level Officer Administrator

Create Scheduled RONDS A
Worklists
Delete Scheduled RONDS A
Worklists
Edit Scheduled RONDS A
Worklists
Remove Studies RONDS A
from Scheduled
Worklists
Reorder RONDS A
Scheduled
Worklists
View Scheduled = RONDS A
Worklists
Standard A
Worklists
Create Worklists L1 A A
Delete Worklists L1 A A
Edit Worklists L1 A A

Study-Based

Administration

Operation License Top Clerical IT Security Service System
Level level Officer Administrator
Add/Remove Key Images 12 A
Dictate Studies as L1 A
Radiologist
Dictate Studies as L1 A
Resident
Edit Study Priority A
Exportand Import Studies A
Export Studiesto L1 A A
Local Media
Export Studiesto L1 A A
Remote Media
Image Area Tools A
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Administration

Operation License Top Clerical IT Security Service System
Level level Officer Administrator
Collimate L1 A A
Delete Image L1 A
(Approved)
Delete Image L1 A
(Dictated)
Delete Image L1 A
(New)
Delete Image L1 A
(Reported)
Edit All Markups L1 A
(Approved)
Edit All Markups L1 A
(Dictated)
Edit All Markups L1 A
(New)
Edit All Markups L1 A
(Reported)
Edit DICOM L1 A A A
Elements
Edit Study L1 A
Snapshots
Export Images L1 I I I I I A
Geometry L1 I I I I I A
Import Images L1 A
Invert L1 I I I I I A
Magnification L1 I I I I I A
Markup L1 I I I I I A
Publish SPS L1 A
Objects
Rearrange Images L1 I I I I I A
Save Geometry L1 A
(Approved)
Save Geometry L1 A
(Dictated)
Save Geometry L1 A
(New)
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Administration

Operation License Top Clerical IT Security Service System
Level level Officer Administrator
Save Geometry L1 A
(Reported)
Save L1 A
Magnification/Pan
(Approved)
Save L1 A
Magnification/Pan
(Dictated)
Save L1 A
Magnification/Pan
(New)
Save L1 A
Magnification/Pan
(Reported)
Save Markup L1 A
(Approved)
Save Markup L1 A
(Dictated)
Save Markup L1 A
(New)
Save Markup L1 A
(Reported)
Save Tab Stops L1 A
Save User Image L1 A
Calibration
Save Window Level L1 A
User Image L1 I I I I I A
Calibration
Keywords A
Associate Keywords L1 I I I I I A
with Study
Print A
Print Composite L1 A A
Layouts
Print Study L1 A A
Study Retrieval A
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Administration

Operation License Top Clerical IT Security Service System
Level level Officer Administrator
Retrieve Offline L1 A A A
Studies
Retrieve Studies L1 A A A
from External
PACS
Retrieve Studies L1 A A A
from HSM
Retrieve Studies L1 I I A I A A
from Nearline
Text Area A
Add study L1 I I I I I A
comments
Edit Patient QC A
Demographics
Edit Performing L1 A
Physician
Edit Study L1 A
Comments
Edit Study Status L1 A
Protect Studies L1 A
View Reports L1 I I I I I A
Transmit Studies L1 A
View Study L1 I I I I I A

Cardiology role: Default PACS Client operations

(Topic number: 54889)

Legend:

3D 3D visualization Mod_CT Display of CT modality type

A Assigned functionality Mod_DR Display of DR modality type

CA Client automation Mod_MG Display of MG modality type

CAD Display of CAD markers Mod_MR Display of MR modality type

COMPREV  Mammography Mod_NM Display of NM modality type
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CONFIG Configuration area Mod_US Display of US modality type
CS Context Server Mod_XA Display of XA modality type
HP Hanging protocols oT Orthopaedic integration

I Inherited functionality QC Quality

L1 Level 1 Basic Feature Set RONDS Scheduling and review of ronds
L2 Level 2 Basic Feature Set TF Teaching files

Mod_ALL Display of all modality types TS TalkStation integration
Mod_CR Display of CR modality type

General
Cardiology
Operation License Top Cardiologist Echo Technologist
level level Cardio
At-a-Glance
Edit At-a-Glance Messages L1
Show At-a-Glance L1 I I I I
Audible Notification L1 I I I I
Change Password CONFIG 1 I I I
Configure Area
Individual Configuration =~ CONFIG
Preferences CONFIG
Printers CONFIG
Service CONFIG
Stations CONFIG
Users and Roles CONFIG
Context Server Integrations
Allow Single Sign-on CS I I I I
Enable Context Server CS I I I I
Integrations
Cycle Studies L1
Delete Study
Edit Columns L1
Edit Enumerated Values
Edit Viewable Worklists
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Cardiology

Operation License Top Cardiologist Echo Technologist
level level Cardio

Export and Import Studies
Export Studies with Image L1 A I I I
Viewer
Export Studies with Reports L1 A I I I
Import Studies L1 A I I I
History L1
Image Area L1 I I I I
Image Area Tools
3D 3D A A
Active Target L1 I I I I
Apply Hanging Protocols ~ HP A A
Apply System Layout L1 A A
Protocols
Auto Window Level L1 I I I I
Break Out Gated Series L1 A I I I
Cine Viewer L1 I I I I
Comparative Review COMPREV
Compare L1 I I I I
Create Combined Series L1
Create Summary Study L2 A I I I
Customize L1
Demographics Toggle L1 I I I I
Display Markup Toggle L1 I I I I
Display Scout L1 I I I I
Edit New Series Descriptions L1
Extended Monitor Display L1 I I I I
Histogram Equalization L1 A A
Image Enhancement L2 A A A
Image Information Window L1 I I I I
Image Pasting L1 A A
Image Selection L1 I I I I
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Cardiology

Operation License Cardiologist Echo Technologist
level Cardio
Linking L1 I I I I
Mammography CAD SR CAD I I I I
Toggle
MPR L2
Nonlinear Window Level L1 I I I I
Nuclear Medicine Palette L1 A I I I
Paired Zoom and Pan L1
Pin Study L1 I 1 I I
Pixel Value Toggle L1
Presentation State Selection L1 I I I I
Projection L1 I I I I
Rearrange Series L1 I I I I
Screen Layout L1 I I I I
Service Window L1
Sort Images L1 I I I I
Split Multi-Phasic Series L1
Tab Stops L1 A A
True Size L1 A I I I
Undo/Redo/Reset L1 I I I I
View Original Images L1
Window Level L1 I I I I
Window Level Preset L1 I I I I
Image Area Wizards
Create or Import Wizards ~ CA I I I I
Delete Wizards CA A A
Edit Wizards CA A A
Run Wizards CA I I I I
Job Manager
Delete Jobs L1 A
Enable Job Manager L1 A
Modify Any Job L1 A
Migrations Reference Guide—IMPAX 5.2 or 5.3 or WEB1000 to IMPAX 6.5.1 123

Agfa Company Confidential—Subject to Non-Disclosure Obligation



Cardiology

Operation License Cardiologist Echo Technologist
level Cardio
Modify Job Priority L1 A
Key Images Edit Favorite Titles L1
Keywords
Edit Personal Keywords L1 I I I I
Edit System Keywords L1
Link Patients L1 I I I I
Messaging Service
Instant Messaging L1 A I I I
Receive Study Messages L1
Modality
View All MOD_ALL 1 I I I
View CR MOD_CR
View CT MOD_CT
View DR MOD_DR
View MG MOD_MG
View MR MOD_MR
View NM MOD_NM
View US MOD_US
View XA MOD_XA
Orthopaedic Application oT
Override permissions on a folder TF
Print
Edit Composite Layouts L2 A A
Print to Paper L1 I I I I
Quality Control
Acknowledge Conflicts QC
Fixup, Segment, and Split QC
Studies
Quick Fix Up QC A
Remember User Settings L1 I I I I
Scripting
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Cardiology

Operation License Top Cardiologist Echo Technologist
level level Cardio
Configure Scripts L1
Run Scripts L1 A A
Search for Open Studies L1
Searching for studies
Add Search Criteria L1
Advanced Search L1 A I I I
Configure Simple Search
Criteria
Simple Search L1 I I I I
Use Relevant Prior Rules L1 I I I I
Set Default Image Type L1
TalkStation Integration TS
Teaching Files TF
Add Teaching File Folders ~ TF A A
Delete Teaching File Folders TF A A
Modify Teaching File Folder TF A
Security
Update Teaching File Folders TF A A
View Teaching File Folders TF A A
Text Area
Configure SmartSeek Tabs L1
Edit Favorite Study L1 A A
Comments
Enable Enterprise Study List L1
Enable Text Area L1 I I I I
Private Study Comments L1
Update Study L1
Worklists
Configure Global Priority L1
Groups
Edit Viewable Worklists L1
Personal Worklists L1
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Cardiology

Operation License Cardiologist Echo Technologist
level Cardio
Scheduled Worklists
Add Studies to Scheduled =~ RONDS
Worklists
Create Scheduled Worklists RONDS A A
Delete Scheduled Worklists RONDS A A
Edit Scheduled Worklists RONDS A A
Remove Studies from RONDS
Scheduled Worklists
Reorder Scheduled Worklists RONDS
View Scheduled Worklists ~ RONDS A A A
Standard Worklists
Create Worklists L1 A A
Delete Worklists L1 A A
Edit Worklists L1 A A

Study-Based

Cardiology
Operation License Top Cardiologist Echo Technologist
level level Cardio
Add/Remove Key Images L2 A I I I
Dictate Studies as Radiologist L1 A
Dictate Studies as Resident L1
Edit Study Priority
Export and Import Studies
Export Studies to Local Media L1 A I I I
Export Studies to Remote L1 A I I I
Media
Image Area Tools
Collimate L1 A A
Delete Image (Approved) L1
Delete Image (Dictated) L1 A
Delete Image (New) L1 A
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Cardiology

Operation License Top Cardiologist Echo Technologist
level level Cardio
Delete Image (Reported) L1
Edit All Markups (Approved) Ll
Edit All Markups (Dictated) L1 A A
Edit All Markups (New) L1 A A
Edit All Markups (Reported) L1
Edit DICOM Elements L1
Edit Study Snapshots L1
Export Images L1 I I I I
Geometry L1 I I I I
Import Images L1 A I I I
Invert L1 I I I I
Magnification L1 I I I I
Markup L1 I I I I
Publish SPS Objects L1 A A A
Rearrange Images L1 I I I I
Save Geometry (Approved) L1
Save Geometry (Dictated) L1 A A A
Save Geometry (New) L1 A A A
Save Geometry (Reported) L1
Save Magnification/Pan L1
(Approved)
Save Magnification/Pan L1
(Dictated)
Save Magnification/Pan (New) L1
Save Magnification/Pan L1
(Reported)
Save Markup (Approved) L1
Save Markup (Dictated) L1 A A A
Save Markup (New) L1 A A A
Save Markup (Reported) L1
Save Tab Stops L1 A A
Save User Image Calibration L1 A A
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Cardiology

Operation License Top Cardiologist Echo Technologist
level level Cardio
Save Window Level L1 A A
User Image Calibration L1
Keywords
Associate keywords with study L1 I I I I
Print
Print Composite Layouts L1 A A A
Print Study L1 A
Study Retrieval
Retrieve Offline Studies L1 A I I I
Retrieve Studies from External L1 A I I I
PACS
Retrieve Studies from HSM L1 A I I I
Retrieve Studies from Nearline L1 A I I I
Text Area
Add study comments L1 I I I I
Edit Patient Demographics QC
Edit Performing Physician L1
Edit Study Comments L1 A A
Edit Study Status L1 A A
Protect Studies L1 A A
View Reports L1 I I I I
Transmit Studies L1 A A
View Study L1 I I I I

Clerical Print role: Default PACS Client operations

(Topic number: 54883)

Legend:

3D 3D visualization Mod_CT Display of CT modality type

A Assigned functionality Mod_DR Display of DR modality type
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CA Client automation Mod_MG Display of MG modality type
CAD Display of CAD markers Mod_MR Display of MR modality type
COMPREV  Mammography Mod_NM Display of NM modality type
CONFIG Configuration area Mod_US Display of US modality type
CS Context Server Mod_XA Display of XA modality type
HP Hanging protocols oT Orthopaedic integration

I Inherited functionality QC Quality

L1 Level 1 Basic Feature Set RONDS Scheduling and review of ronds
L2 Level 2 Basic Feature Set TF Teaching files

Mod_ALL Display of all modality types TS TalkStation integration
Mod_CR Display of CR modality type

General
Operation License level Clerical
Print
At-a-Glance
Edit At-a-Glance Messages L1
Show At-a-Glance L1 A
Audible Notification L1
Change Password CONFIG A
Configure Area
Individual Configuration CONFIG
Preferences CONFIG
Printers CONFIG
Service CONFIG
Stations CONFIG
Users and Roles CONFIG
Context Server Integrations
Allow Single Sign-on CS A
Enable Context Server Integrations CS A
Cycle Studies L1
Delete Study
Edit Columns L1
Edit Enumerated Values
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Operation License level Clerical

Print
Edit Viewable Worklists
Export and Import Studies
Export Studies with Image Viewer L1 A
Export Studies with Reports L1 A
Import Studies L1
History L1
Image Area L1 A
Image Area Tools
3D 3D
Active Target L1
Apply Hanging Protocols HP
Apply System Layout Protocols L1
Auto Window Level L1 A
Break Out Gated Series L1
Cine Viewer L1
Comparative Review COMPREV
Compare L1
Create Combined Series L1
Create Summary Study L2
Customize L1
Demographics Toggle L1 A
Display Markup Toggle L1 A
Display Scout L1 A
Edit New Series Descriptions L1
Extended Monitor Display L1
Histogram Equalization L1
Image Enhancement L2
Image Information Window L1 A
Image Pasting L1
Image Selection L1 A
Linking L1
Mammography CAD SR Toggle CAD
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Operation License level Clerical

Print
MPR L2
Nonlinear Window Level L1
Nuclear Medicine Palette L1
Paired Zoom and Pan L1
Pin Study L1
Pixel Value Toggle L1
Presentation State Selection L1
Projection L1
Rearrange Series L1
Screen Layout L1 A
Service Window L1
Sort Images L1
Split Multi-Phasic Series L1
Tab Stops L1
True Size L1
Undo/Redo/Reset L1 A
View Original Images L1
Window Level L1 A
Window Level Preset L1 A
Image Area Wizards
Create or Import Wizards CA
Delete Wizards CA
Edit Wizards CA
Run Wizards CA
Job Manager
Delete Jobs L1
Enable Job Manager L1
Modify Any Job L1
Modify Job Priority L1 A
Key Images Edit Favorite Titles L1
Keywords
Edit Personal Keywords L1
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Operation

Edit System Keywords
Link Patients
Messaging Service

Instant Messaging

Receive Study Messages
Modality

View All

View CR

View CT

View DR

View MG

View MR

View NM

View US

View XA
Orthopaedic Application

Override permissions on a folder

Print
Edit Composite Layouts
Print to Paper
Quality Control
Acknowledge Conflict
Fixup, Segment, and Split Studies
Quick Fix Up
Remember User Settings
Scripting
Configure Scripts
Run Scripts
Search for Open Studies
Searching for studies
Add Search Criteria
Advanced Search

License level

L1
L1

L1
L1

MOD_ALL
MOD_CR
MOD_CT
MOD_DR
MOD_MG
MOD_MR
MOD_NM
MOD_US
MOD_XA
oT

TF

L2
L1

QC
QC
L1

L1
L1
L1

L1
L1

Clerical

Print
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Operation License level Clerical

Print
Configure Simple Search Criteria L1
Simple Search L1 A
Use Relevant Prior Rules L1 A
Set Default Image Type L1
TalkStation Integration TALK
Teaching Files TF
Text Area
Configure SmartSeek Tabs L1
Edit Favorite Study Comments L1
Enable Enterprise Study List L1
Enable Text Area L1 A
Private Study Comments L1
Update Study L1
Worklists
Configure Global Priority Groups L1
Edit Viewable Worklists L1
Personal Worklists L1
Scheduled Worklists
Add Studies to Scheduled Worklists RONDS A
Create Scheduled Worklists RONDS
Delete Scheduled Worklists RONDS
Edit Scheduled Worklists RONDS
Reorder Scheduled Worklists RONDS
Remove Studies from Scheduled Worklists RONDS
View Scheduled Worklists RONDS A
Standard Worklists
Create Worklists L1
Delete Worklists L1
Edit Worklists L1
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Study-Based

Operation License level  Clerical
Print
Add/Remove Key Images L2
Dictate Studies as Radiologist L1
Dictate Studies as Resident L1
Edit Study Priority
Export and Import Studies
Export Studies to Local Media L1 A
Export Studies to Remote Media L1 A
Image Area Tools
Collimate L1
Delete Image (Approved) L1
Delete Image (Dictated) L1
Delete Image (New) L1
Delete Image (Reported) L1
Edit All Markups (Approved) L1
Edit All Markups (Dictated) L1
Edit All Markups (New) L1
Edit All Markups (Reported) L1
Edit DICOM Elements L1
Edit Study Snapshots L1
Export Images L1 A
Geometry L1
Import Images L1
Invert L1 A
Magnification L1 A
Markup L1
Publish SPS Objects L1
Rearrange Images L1
Save Geometry (Approved) L1
Save Geometry (Dictated) L1
Save Geometry (New) L1
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Operation License level Clerical

Print

Save Geometry (Reported) L1

Save Magnification/Pan (Approved) L1

Save Magnification/Pan (Dictated) L1

Save Magnification/Pan (New) L1

Save Magnification/Pan (Reported) L1

Save Markup (Approved) L1

Save Markup (Dictated) L1

Save Markup (New) L1

Save Markup (Reported) L1

Save Tab Stops L1

Save User Image Calibration L1

Save Window Level L1

User Image Calibration L1
Keywords

Associate keywords with study L1
Print

Print Composite Layouts L1 A

Print Study L1 A
Study Retrieval

Retrieve Offline Studies L1 A

Retrieve Studies from External PACS L1 A

Retrieve Studies from HSM L1 A

Retrieve Studies from Nearline L1 A
Text Area

Add study comments L1

Edit Patient Demographics QC

Edit Performing Physician L1

Edit Study Comments L1

Edit Study Status L1

Protect Studies L1

View Reports L1 A
Transmit Studies L1 A
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Operation

Clerical
Print

License level

View Study

L1 A

Clinician role: Default PACS Client operations

(Topic number: 54892)

Legend:
3D 3D visualization Mod_CT Display of CT modality type
A Assigned functionality Mod_DR Display of DR modality type
CA Client automation Mod_MG Display of MG modality type
CAD Display of CAD markers Mod_MR Display of MR modality type
COMPREV  Mammography Mod_NM Display of NM modality type
CONFIG Configuration area Mod_US Display of US modality type
CS Context Server Mod_XA Display of XA modality type
HP Hanging protocols oT Orthopaedic integration
I Inherited functionality QC Quality
L1 Level 1 Basic Feature Set RONDS Scheduling and review of ronds
L2 Level 2 Basic Feature Set TF Teaching files
Mod_ALL Display of all modality types TS TalkStation integration
Mod_CR Display of CR modality type
General
Clinician
Operation License Top-level Emergency ICU Oncology Paediatrics
level Dept
At-a-Glance
Edit At-a-Glance L1
Messages
Show At-a-Glance L1 I I I 1 I
Audible Notification L1 I I I 1 I
Change Password CONFIG 1 I I 1 I
Configure Area
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Clinician

Operation License Top-level Emergency ICU Oncology Paediatrics
level Dept

Individual CONFIG
Configuration

Preferences CONFIG
Printers CONFIG
Service CONFIG
Stations CONFIG

Users and Roles CONFIG

Context Server Integrations

Allow Single Sign-on CS I I I 1 I
Enable Context CS I I I I I
Server Integrations

Cycle Studies L1

Delete Study

Edit Columns L1

Edit Enumerated Values

Edit Viewable Worklists
Export and Import Studies
Export Studies with L1 A I I I I
Image Viewer
Export Studies with L1
Reports
Import Studies L1
History L1
Image Area L1 I I I I I
Image Area Tools
3D 3D A
Active Target L1 I I I I I
Apply Hanging HP
Protocols
Apply System Layout L1 I I I 1 I
Protocols
Auto Window Level L1 I I I 1 I
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Clinician

Operation License Top-level Emergency ICU Oncology Paediatrics
level Dept
Break Out Gated L1
Series
Cine Viewer L1 I I I I I
Comparative Review COMPREV
Compare L1 I I I I I
Create Combined L1
Series
Create Summary L2 A I I I I
Study
Customize L1
Demographics L1 I I I I I
Toggle
Display Markup L1 I I I I I
Toggle
Display Scout L1 I I I I I
Edit New Series L1 A
Descriptions
Extended Monitor L1 I I I I I
Display
Histogram L1 A A A 1 I
Equalization
Image Enhancement L2 A I I 1 I
Image Information L1 I I I 1 I
Window
Image Pasting L1
Image Selection L1 I I I I I
Linking L1 I I I I I
Mammography CAD CAD A
SR Toggle
MPR L2
Nonlinear Window L1 I I I I I
Level
Nuclear Medicine L1 A A A 1 I
Palette
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Operation

License
level

Clinician

Top-level Emergency ICU Oncology Paediatrics
Dept

Paired Zoom and L1
Pan
Pin Study L1 I I I I I
Pixel Value Toggle L1
Presentation State L1 I I I 1 I
Selection
Projection L1 I I I I I
Rearrange Series L1 I I I I I
Screen Layout L1 I I I I I
Service Window L1
Sort Images L1 I I I I I
Split Multi-Phasic L1
Series
Tab Stops L1
True Size L1 I I I I I
Undo/Redo/Reset L1
View Original Images L1
Window Level L1 I I I I I
Window Level Preset L1 I I I 1 I
Image Area Wizards
Create or Import CA I I I I I
Wizards
Delete Wizards CA
Edit Wizards CA
Run Wizards CA I I I I I
Job Manager
Delete Jobs L1
Enable Job Manager L1
Modify Any Job L1
Modify Job Priority L1
Key Images Edit Favorite = L1
Titles
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Clinician

Operation License Top-level Emergency ICU Oncology Paediatrics
level Dept
Keywords
Edit Personal L1 I I I I I
Keywords
Edit System L1
Keywords
Link Patients L1 I I I I I
Messaging Service

Instant Messaging L1

Receive Study L1
Messages

Modality
View All MOD_ALL 1 I I I I
View CR MOD_CR
View CT MOD_CT
View DR MOD_DR
View MG MOD_ MG
View MR MOD_MR
View NM MOD_NM
View US MOD_US
View XA MOD_XA

Orthopaedic Application ~ OT

Override permissionsona TF

folder
Print
Edit Composite L2
Layouts
Print to Paper L1 I I I I I
Quality Control
Acknowledge QC
Conflict
Fixup, Segment, and QC
Split Studies
Quick Fix Up QC
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Clinician

Operation License Top-level Emergency ICU Oncology Paediatrics
level Dept

Remember User Settings L1 I I I I I

Scripting

Configure Scripts L1

Run Scripts L1
Search for Open Studies L1
Searching for studies

Add Search Criteria L1

Advanced Search L1

Configure Simple L1
Search Criteria

Simple Search L1 I I I I I
Use Relevant Prior L1 | I I I I
Rules

Set Default Image Type L1
TalkStation Integration TS

Teaching Files TF
Add Teaching File ~ TF A I I 1 I
Folders
Delete Teaching File TF A I I I I
Folders
Modify Teaching File TF A I I 1 I
Folders
Update Teaching File TF A I I I I
Folders
View Teaching File ~ TF A I I 1 I
Folders

Text Area
Configure SmartSeek L1
Tabs
Edit Favorite Study L1 A A
Comments

Enable Enterprise L1

Study List
Enable Text Area L1 I I I I I
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Clinician

Operation License Top-level Emergency ICU Oncology Paediatrics
level Dept
Private Study L1 I I I I I
Comments
Update Study L1
Worklists
Configure Global L1
Priority Groups
Edit Viewable L1
Worklists
Personal Worklists L1
Scheduled WorKklists
Add Studies to RONDS
Scheduled Worklists
Create Scheduled RONDS A I | I I
Worklists
Delete Scheduled RONDS A I I I I
Worklists
Edit Scheduled RONDS A I | I I
Worklists
Reorder Scheduled RONDS
Worklists
Remove Studies from RONDS
Scheduled Worklists
View Scheduled RONDS
Worklists
Standard Worklists
Create Worklists L1
Delete Worklists L1
Edit Worklists L1

Study-Based

Clinician
Operation License Top-level Emergency ICU Oncology Paediatrics
level Dept.
Add/Remove Key Images L2 A I I I I
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Clinician

Operation License Top-level Emergency ICU Oncology Paediatrics
level Dept.

Dictate Studies as Radiologist L1
Dictate Studies as Resident L1
Edit Study Priority

Export and Import Studies

Export Studies to Local L1 A I I 1 I
Media

Export Studies to Remote L1
Media

Image Area Tools
Collimate L1 A
Delete Image (Approved) L1
Delete Image (Dictated) L1
Delete Image (New) L1
Delete Image (Reported) Ll

Edit All Markups L1
(Approved)

Edit All Markups L1
(Dictated)

Edit All Markups (New) LI
Edit All Markups L1
(Reported)

Edit DICOM Elements LI
Edit Study Snapshots L1

Export Images L1 I I I I I
Geometry L1 I I I I I
Import Images L1 A A A 1 I
Invert L1 I I I I I
Magnification L1 I I I 1 I
Markup L1 I I I I I
Publish SPS Objects L1 A A A 1 I
Rearrange Images L1 I I I I I
Save Geometry L1

(Approved)
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Clinician

Operation License Top-level Emergency ICU Oncology Paediatrics
level Dept.

Save Geometry L1 A A A 1 I
(Dictated)
Save Geometry (New) LI A A A I I
Save Geometry L1
(Reported)
Save Magnification/Pan LI
(Approved)
Save Magnification/Pan L1
(Dictated)
Save Magnification/Pan LI
(New)
Save Magnification/Pan L1
(Reported)
Save Markup (Approved) L1
Save Markup (Dictated) L1 A A A 1 I
Save Markup (New) L1 A A A I I
Save Markup (Reported) L1
Save Tab Stops L1 A A A 1 I
Save User Image L1 A A A 1 I
Calibration
Save Window Level L1
User Image Calibration Ll

Keywords
Associate keywords with L1 I I I I I
study

Print
Print Composite Layouts L1 A I I I I
Print Study L1

Study Retrieval
Retrieve Offline Studies Ll A I I I I
Retrieve Studies from L1 A I I I I
External PACS
Retrieve Studies from L1 A I I I I
HSM
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Operation

Clinician

License Top-level Emergency ICU Oncology Paediatrics

level

Retrieve Studies from L1

Nearline
Text Area
Add study comments L1
Edit Patient QC
Demographics
Edit Performing L1
Physician
Edit Study Comments Ll
Edit Study Status L1
Protect Studies L1
View Reports L1
Transmit Studies L1
View Study L1

Dept.

I I I
I I I
I I I
A 1 I
I I I

My Site role: Default PACS Client operations

(Topic number: 54880)

Legend:

3D 3D visualization Mod_CT Display of CT modality type
A Assigned functionality Mod_DR Display of DR modality type
CA Client automation Mod_MG Display of MG modality type
CAD Display of CAD markers Mod_MR Display of MR modality type
COMPREV  Mammography Mod_NM Display of NM modality type
CONFIG Configuration area Mod_US Display of US modality type
CS Context Server Mod_XA Display of XA modality type
HP Hanging protocols oT Orthopaedic integration

I Inherited functionality QC Quality

L1 Level 1 Basic Feature Set RONDS Scheduling and review of ronds
L2 Level 2 Basic Feature Set TF Teaching files
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Mod_ALL Display of all modality types TS TalkStation integration
Mod_CR Display of CR modality type

General
Operation License level My
Site
At-a-Glance
Edit At-a-Glance Messages L1
Show At-a-Glance L1 A
Audible Notification L1 A
Change Password CONFIG A
Configure Area
Individual Configuration CONFIG
Preferences CONFIG
Printers CONFIG
Service CONFIG
Stations CONFIG
Users and Roles CONFIG
Context Server Integrations
Allow Single Sign-on CS A
Enable Context Server Integrations CS A
Cycle Studies L1
Delete Study
Edit Columns L1
Edit Enumerated Values
Edit Viewable Worklists
Export and Import Studies
Export Studies with Image Viewer L1
Export Studies with Reports L1
Import Studies L1
History L1
Image Area L1 A
Image Area Tools
3D 3D
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Operation License level My

Site

Active Target L1 A

Apply Hanging Protocols HP

Apply System Layout Protocols L1

Auto Window Level L1 A

Break Out Gated Series L1

Cine Viewer L1 A

Comparative Review COMPREV

Compare L1 A

Create Combined Series L1

Create Summary Study L2 A

Customize L1

Demographics Toggle L1 A

Display Markup Toggle L1 A

Display Scout L1 A

Edit New Series Descriptions L1

Extended Monitor Display L1 A

Histogram Equalization L1

Image Enhancement L2

Image Information Window L1 A

Image Pasting L1

Image Selection L1 A

Linking L1 A

Mammography CAD SR Toggle CAD

MPR L2

Nonlinear Window Level L1 A

Nuclear Medicine Palette L1

Paired Zoom and Pan L1

Pin Study L1 A

Pixel Value Toggle L1

Presentation State Selection L1 A

Projection L1 A

Rearrange Series L1 A
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Operation License level My
Site
Screen Layout L1 A
Service Window L1
Sort Images L1 A
Split Multi-Phasic Series L1
Tab Stops L1
True Size L1
Undo/Redo/Reset L1 A
View Original Images L1
Window Level L1 A
Window Level Preset L1 A
Image Area Wizards
Create or Import Wizards CA A
Delete Wizards CA
Edit Wizards CA
Run Wizards CA A
Job Manager
Delete Jobs L1
Enable Job Manager L1
Modify Any Job L1
Modify Job Priority L1
Key Images Edit Favorite Titles L1
Keywords
Edit Personal Keywords L1 A
Edit System Keywords L1
Link Patients L1 A
Messaging Service
Instant Messaging L1
Receive Study Messages L1
Modality
View All MOD_ALL A
View CR MOD_CR
View CT MOD_CT
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Operation License level My
Site
View DR MOD_DR
View MG MOD_MG
View MR MOD_MR
View NM MOD_NM
View US MOD_US
View XA MOD_XA
Orthopaedic Application oT
Override permissions on a folder TF
Print
Edit Composite Layouts L2
Print to Paper L1 A
Quality Control
Acknowledge Conflicts QC
Fixup, Segment, and Split Studies QC
Quick Fix Up QC
Remember User Settings L1 A
Scripting
Configure Scripts L1
Run Scripts L1
Search for Open Studies L1
Searching for studies
Add Search Criteria L1
Advanced Search L1
Configure Simple Search Criteria L1
Simple Search L1 A
Use Relevant Prior Rules L1 A
Set Default Image Type L1
TalkStation Integration TS
Teaching Files TF
Add Teaching File Folders TF
Delete Teaching File Folders TF
Modify Teaching File Folders TF
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Operation License level My

Site
Update Teaching File Folders TF
View Teaching File Folders TF
Text Area
Configure SmartSeek Tabs L1
Edit Favorite Study Comments L1
Enable Enterprise Study List L1
Enable Text Area L1 A
Private Study Comments L1
Update Study L1
Worklists
Configure Global Priority Groups L1
Edit Viewable Worklists L1
Personal Worklists L1
Scheduled Worklists
Add Studies to Scheduled Worklists RONDS
Create Scheduled Worklists RONDS
Delete Scheduled Worklists RONDS
Edit Scheduled Worklists RONDS
Remove Studies from Scheduled Worklists RONDS
Reorder Scheduled Worklists RONDS
View Scheduled Worklists RONDS
Standard Worklists
Create Worklists L1
Delete Worklists L1
Edit Worklists L1

Study-Based

Operation License level My
Site
Add/Remove Key Images L2
Dictate Studies as Radiologist L1
Dictate Studies as Resident L1
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Operation License level My
Site
Edit Study Priority
Export and Import Studies
Export Studies to Local Media L1
Export Studies to Remote Media L1
Image Area Tools
Collimate L1
Delete Image (Approved) L1
Delete Image (Dictated) L1
Delete Image (New) L1
Delete Image (Reported) L1
Edit All Markups (Approved) L1
Edit All Markups (Dictated) L1
Edit All Markups (New) L1
Edit All Markups (Reported) L1
Edit DICOM Elements L1
Edit Study Snapshots L1
Export Images L1 A
Geometry L1 A
Import Images L1
Invert L1 A
Magnification L1 A
Markup L1 A
Publish SPS Objects L1
Rearrange Images L1 A
Save Geometry (Approved) L1
Save Geometry (Dictated) L1
Save Geometry (New) L1
Save Geometry (Reported) L1
Save Magnification/Pan (Approved) L1
Save Magnification/Pan (Dictated) L1
Save Magnification/Pan (New) L1
Save Magnification/Pan (Reported) L1
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Operation License level My

Site

Save Markup (Approved) L1

Save Markup (Dictated) L1

Save Markup (New) L1

Save Markup (Reported) L1

Save Tab Stops L1

Save User Image Calibration L1

Save Window Level L1

User Image Calibration L1
Keywords

Associate keywords with study L1 A
Print

Print Composite Layouts L1

Print Study L1
Study Retrieval

Retrieve Offline Studies L1

Retrieve Studies from External PACS L1

Retrieve Studies from HSM L1

Retrieve Studies from Nearline L1 A
Text Area

Add study comments L1 A

Edit Patient Demographics QC

Edit Performing Physician L1

Edit Study Comments L1

Edit Study Status L1

Protect Studies L1

View Reports L1 A
Transmit Studies L1
View Study L1 A
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Nursing role: Default PACS Client operations

(Topic number: 54886)

Agfa Company Confidential—Subject to Non-Disclosure Obligation

Legend:
3D 3D visualization Mod_CT Display of CT modality type
A Assigned functionality Mod_DR Display of DR modality type
CA Client automation Mod_MG Display of MG modality type
CAD Display of CAD markers Mod_MR Display of MR modality type
COMPREV  Mammography Mod_NM Display of NM modality type
CONFIG Configuration area Mod_US Display of US modality type
CS Context Server Mod_XA Display of XA modality type
HP Hanging protocols oT Orthopaedic integration
I Inherited functionality QC Quality
L1 Level 1 Basic Feature Set RONDS Scheduling and review of ronds
L2 Level 2 Basic Feature Set TF Teaching files
Mod_ALL Display of all modality types TS TalkStation integration
Mod_CR Display of CR modality type
General
Operation License level Nursing
At-a-Glance
Edit At-a-Glance Messages L1
Show At-a-Glance L1 I
Audible Notification L1 I
Change Password CONFIG I
Configure Area
Individual Configuration CONFIG
Preferences CONFIG
Printers CONFIG
Service CONFIG
Stations CONFIG
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Operation License level Nursing

Users and Roles CONFIG

Context Server Integrations
Allow Single Sign-on CS I
Enable Context Server Integrations CS I

Cycle Studies L1

Delete Study

Edit Columns L1

Edit Enumerated Values

Edit Viewable Worklists

Export and Import Studies
Export Studies with Image Viewer L1 I
Export Studies with Reports L1
Import Studies L1

History

Image Area L1 I

Image Area Tools
3D 3D
Active Target L1 I
Apply Hanging Protocols HP
Apply System Layout Protocols L1
Auto Window Level L1 I
Break Out Gated Series L1
Cine Viewer L1 I
Comparative Review COMPREV
Compare L1 I
Create Combined Series L1
Create Summary Study L2 I
Customize L1
Demographics Toggle L1 I
Display Markup Toggle L1 I
Display Scout L1 I
Edit New Series Descriptions L1
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Operation License level Nursing
Extended Monitor Display L1 I
Histogram Equalization L1 I
Image Enhancement L2 I
Image Information Window L1 I
Image Pasting L1
Image Selection L1 I
Linking L1 I
Mammography CAD SR Toggle CAD
MPR L2
Nonlinear Window Level L1 I
Nuclear Medicine Palette L1 I
Paired Zoom and Pan L1 I
Pin Study L1 I
Pixel Value Toggle L1
Presentation State Selection L1 I
Projection L1 I
Rearrange Series L1 I
Screen Layout L1 I
Service Window L1
Sort Images L1 I
Split Multi-Phasic Series L1
Tab Stops L1
True Size L1 I
Undo/Redo/Reset L1 I
View Original Images L1
Window Level L1 I
Window Level Preset L1 I

Image Area Wizards
Create or Import Wizards CA I
Delete Wizards CA
Edit Wizards CA
Run Wizards CA I
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Operation License level Nursing

Job Manager
Delete Jobs L1
Enable Job Manager L1
Modify Any Job L1
Modify Job Priority L1
Key Images Edit Favorite Titles L1
Keywords
Edit Personal Keywords L1 I
Edit System Keywords L1
Link Patients L1 I
Messaging Service
Instant Messaging L1
Receive Study Messages L1
Modality
View All MOD_ALL I
View CR MOD_CR
View CT MOD_CT
View DR MOD_DR
View MG MOD_MG
View MR MOD_MR
View NM MOD_NM
View US MOD_US
View XA MOD_XA
Orthopaedic Application oT
Override permissions on a folder TF
Print
Edit Composite Layouts L2
Print to Paper L1 I
Quality Control
Acknowledge Conflict QC
Fixup, Segment, and Split Studies QC
Quick Fix Up QC
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Operation License level Nursing
Remember User Settings L1 I
Scripting
Configure Scripts L1
Run Scripts L1
Search for Open Studies L1
Searching for studies
Add Search Criteria L1
Advanced Search L1
Configure Simple Search Criteria L1
Simple Search L1 I
Use Relevant Prior Rules L1 I
Set Default Image Type L1
TalkStation Integration TS
Teaching Files TF
Add Teaching File Folders TF I
Delete Teaching File Folders TF I
Modify Teaching File Folders TF I
Update Teaching File Folders TF I
View Teaching File Folders TF I
Text Area
Configure SmartSeek Tabs L1
Edit Favorite Study Comments L1
Enable Enterprise Study List L1
Enable Text Area L1 I
Private Study Comments L1
Update Study L1
Worklists
Configure Global Priority Groups L1
Edit Viewable Worklists L1
Personal Worklists L1
Scheduled Worklists
Add Studies to Scheduled Worklists RONDS
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Operation License level Nursing
Create Scheduled Worklists RONDS I
Delete Scheduled Worklists RONDS I
Edit Scheduled Worklists RONDS I
Remove Studies from Scheduled Worklists RONDS
Reorder Scheduled Worklists RONDS
View Scheduled Worklists RONDS
Standard Worklists
Create Worklists L1
Delete Worklists L1
Edit Worklists L1
Study-Based
Operation License level Nursing
Add/Remove Key Images L2 I
Dictate Studies as Radiologist L1
Dictate Studies as Resident L1
Edit Study Priority
Export and Import Studies
Export Studies to Local Media L1
Export Studies to Remote Media L1
Image Area Tools
Collimate L1
Delete Image (Approved) L1
Delete Image (Dictated) L1
Delete Image (New) L1
Delete Image (Reported) L1
Edit All Markups (Approved) L1
Edit All Markups (Dictated) L1
Edit All Markups (New) L1
Edit All Markups (Reported) L1
Edit DICOM Elements L1
Edit Study Snapshots L1
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Operation License level Nursing

Export Images L1 I
Geometry L1 I
Import Images L1 I
Invert L1 I
Magnification L1 I
Markup L1 I
Publish SPS Objects L1 I
Rearrange Images L1 I
Save Geometry (Approved) L1
Save Geometry (Dictated) L1 I
Save Geometry (New) L1 I
Save Geometry (Reported) L1
Save Magnification/Pan (Approved) L1
Save Magnification/Pan (Dictated) L1
Save Magnification/Pan (New) L1
Save Magnification/Pan (Reported) L1
Save Markup (Approved) L1
Save Markup (Dictated) L1 I
Save Markup (New) L1 I
Save Markup (Reported) L1
Save Tab Stops L1 I
Save User Image Calibration L1 I
Save Window Level L1
User Image Calibration L1
Keywords
Associate keywords with study L1 I
Print
Print Composite Layouts L1 I
Print Study L1
Study Retrieval
Retrieve Offline Studies L1 I
Retrieve Studies from External PACS L1 I
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Operation

Text Area

Retrieve Studies from HSM

Retrieve Studies from Nearline

Add study comments

Edit Patient Demographics
Edit Performing Physician
Edit Study Comments

Edit Study Status

Protect Studies

View Reports

Transmit Studies

View Study

License level Nursing
L1 I
L1 I
L1 I
QC

L1

L1

L1

L1

L1 I
L1 I
L1 I

Radiology role: Default PACS Client operations

(Topic number: 54895)

Legend:

3D 3D visualization Mod_CT Display of CT modality type
A Assigned functionality Mod_DR Display of DR modality type
CA Client automation Mod_MG Display of MG modality type
CAD Display of CAD markers Mod_MR Display of MR modality type
COMPREV  Mammography Mod_NM Display of NM modality type
CONFIG Configuration area Mod_US Display of US modality type
CS Context Server Mod_XA Display of XA modality type
HP Hanging protocols oT Orthopaedic integration

I Inherited functionality QC Quality

L1 Level 1 Basic Feature Set RONDS Scheduling and review of ronds
L2 Level 2 Basic Feature Set TF Teaching files

Mod_ALL Display of all modality types TS TalkStation integration
Mod_CR Display of CR modality type

Migrations Reference Guide—IMPAX 5.2 or 5.3 or WEB1000 to IMPAX 6.5.1
Agfa Company Confidential—Subject to Non-Disclosure Obligation

160



General

Radiology
Operation License Top- Breast NM Power Rad Resident Tech
level level Imaging Physician Rad
Rad
At-a-Glance
Edit At-a-Glance L1 A A A A
Messages
Show At-a-Glance L1 I I I I I I I
Audible Notification L1 I I I I I I I
Change Password CONFIG 1 I I I I I I
Configure Area
Individual CONFIG
Configuration
Preferences CONFIG
Printers CONFIG
Service CONFIG
Stations CONFIG
Users and Roles  CONFIG
Context Server
Integrations
Allow Single CS I I I I I I I
Sign-on
Enable Context  CS I I I I I I I
Server
Integrations
Cycle Studies L1
Delete Study
Edit Columns L1 A
Edit Enumerated Values
Edit Viewable Worklists
Export and Import
Studies
Export Studies L1 A A A A A
with Image
Viewer
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Radiology

Operation License Top- Breast NM Power Rad Resident Tech
level level Imaging Physician Rad
Rad
Export Studies L1 A A A A A
with Reports
Import Studies L1 A A A A
History L1
Image Area L1 I I I I I I I
Image Area Tools
3D 3D A A A A A
Active Target L1 I I I I I I I
Apply Hanging  HP A A A A A
Protocols
Apply System L1
Layout Protocols
Auto Window L1 I I I I I I I
Level
Break Out Gated L1 A A A A A
Series
Cine Viewer L1 I I I I 1 I I
Comparative COMPREV A
Review
Compare L1 I I I I I I I
Create Combined L1
Series
Create Summary L2 I I I A I A I
Study
Customize L1 A A A A
Demographics L1 I I I I I I I
Toggle
Display Markup L1 I I I I I I I
Toggle
Display Scout L1 I I I I I I I
Edit New Series L1
Descriptions
Extended Monitor L1 I I I I I I I
Display
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Radiology

Operation License Top- Breast NM Power Rad Resident Tech
level level Imaging Physician Rad
Rad
Histogram L1
Equalization
Image L2 A A A A A
Enhancement
Image L1 I I I I I I I
Information
Window
Image Pasting L1 A A A A A
Image Selection L1 I I I I I I I
Linking L1 I I I I I I I
Mammography =~ CAD A A A
CAD SR Toggle
MPR L2 I I I I I I I
Nonlinear L1 I I I I I I I
Window Level
Nuclear Medicine L1 A I A A I I A
Palette
Paired Zoom and L1
Pan
Pin Study L1 I I I I I I I
Pixel Value Toggle L1
Presentation State L1 I I I I I I I
Selection
Projection L1 I I I I I I I
Rearrange Series L1 I I I I I I I
Screen Layout L1 I I I I I I I
Service Window L1 A
Sort Images L1 I I I I I I I
Split Multi-Phasic L1
Series
Tab Stops L1 A A
True Size L1 A I I I I | A
Undo/Redo/Reset L1 I I I I I I I
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Radiology

Operation License Top- Breast NM Power Rad Resident Tech
level level Imaging Physician Rad
Rad
View Original L1
Images
Window Level L1 I I I I I I I
Window Level L1 I I I I I I I
Preset
Image Area Wizards
Create or Import CA I I I A I I I
Wizards
Delete Wizards CA A A A A A
Edit Wizards CA A A A A A
Run Wizards CA I I I I I I I
Job Manager
Delete Jobs L1 A A
Enable Job L1 A A
Manager
Modify Any Job L1 A A
Modify Job L1 A A
Priority
Key Images Edit Favorite L1
Titles
Keywords
Edit Personal L1 I I I I 1 I I
Keywords
Edit System L1
Keywords
Link Patients L1 I I I I 1 I I
Messaging Service
Instant Messaging L1 A I I I I I I
Receive Study L1 A
Messages
Modality
View All MOD_ALL 1 I I I I I I
View CR MOD_CR
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Radiology

Operation License Top- Breast NM Power Rad Resident Tech
level level Imaging Physician Rad
LE
View CT MOD_CT
View DR MOD_DR
View MG MOD_MG
View MR MOD_MR
View NM MOD_NM
View US MOD_US
View XA MOD_XA
Orthopaedic Application OT
Override permissionson TF
a folder
Print
Edit Composite L2 A
Layouts
Print to Paper L1 I I I I I I I
Quality Control
Acknowledge QC A
Conflicts
Fixup, Segment, QC A
and Split Studies
Quick Fix Up QC A
Remember User Settings L1 I I I I I I I
Scripting
Configure Scripts L1 A
Run Scripts L1 A
Search for Open Studies L1 A
Searching for studies
Add Search L1 A A A A A
Criteria
Advanced Search L1 A I I I I I I
Configure Simple L1
Search Criteria
Simple Search L1 I I I I I I I
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Radiology

Operation License Top- Breast NM Power Rad Resident Tech
level level Imaging Physician Rad
Rad
Use Relevant Prior L1 I I I I I I I
Rules

Set Default Image Type L1

TalkStation Integration TS A A A A A

Teaching Files TF A
Add Teaching File TF A A A A A A
Folders
Delete Teaching  TF A A A A A A
File Folders
Modify Teaching TF A A A A A
File Folders
Update Teaching TF A A A A A A
File Folders
View Teaching TF A A A A A A
File Folders

Text Area
Configure L1
SmartSeek Tabs
Edit Favorite L1 A A A A A
Study Comments
Enable Enterprise L1
Study List
Enable Text Area L1 I I I A I I I
Private Study L1
Comments

Update Study L1

Worklists
Configure Global L1 A A A A A
Priority Groups
Edit Viewable L1 A A A A A
Worklists
Personal L1 A A A A A
Worklists
Scheduled
Worklists
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Radiology

Operation License Top- Breast NM Power Rad Resident Tech
level level Imaging Physician Rad
&

Add Studies to RONDS A A A A A
Scheduled

Worklists

Create Scheduled RONDS A A A A A
Worklists

Delete Scheduled RONDS A A A A A
Worklists

Edit Scheduled RONDS A A A A A
Worklists

Remove Studies RONDS A A A A A
from Scheduled

Worklists

Reorder RONDS A A A A A
Scheduled

Worklists

View Scheduled RONDS A A A A A
Worklists

Standard

Worklists

Create Worklists L1 A A A A A
Delete Worklists L1 A A A A A
Edit Worklists L1 A A A A A

Study-Based

Radiology
Operation License Top-level Breast NM Power Rad Resident Tech
level Imaging Physician Rad
Rad
Add/Remove Key Images L2 A A A A
Dictate Studies as L1 A A A A
Radiologist
Dictate Studies as L1 A
Resident
Edit Study Priority
Export and Import
Studies
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Operation

Export Studies to
Local Media

Export Studies to
Remote Media

Image Area Tools
Collimate

Delete Image
(Approved)

Delete Image
(Dictated)

Delete Image
(New)

Delete Image
(Reported)

Edit All Markups
(Approved)

Edit All Markups
(Dictated)

Edit All Markups
(New)

Edit All Markups
(Reported)

Edit DICOM
Elements

Edit Study
Snapshots

Export Images
Geometry
Import Images
Invert
Magnification
Markup

Publish SPS
Objects

Rearrange Images

License Top-level Breast NM

level

L1

L1

L1
L1

L1

L1

L1

L1

L1

L1

L1

L1

L1

L1

Radiology

Imaging Physician Rad

Rad

A A A A A
A A A A A
A A A A A
A A A A A
A A A A A
I I I I I
I I I I I
A A A A A
I I I I I
I I I I |
I I I I I
A A A A A
I I I I I

Power Rad Resident Tech
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Radiology

Operation License Top-level Breast NM Power Rad Resident Tech
level Imaging Physician Rad
Rad
Save Geometry L1
(Approved)
Save Geometry L1 A A A A A
(Dictated)
Save Geometry L1 A A A A A
(New)
Save Geometry L1
(Reported)
Save L1
Magnification/Pan
(Approved)
Save L1 A A A A A
Magnification/Pan
(Dictated)
Save L1 A A A A A
Magnification/Pan
(New)
Save L1
Magnification/Pan
(Reported)
Save Markup L1
(Approved)
Save Markup L1 A A A A A
(Dictated)
Save Markup L1 A A A A A
(New)
Save Markup L1
(Reported)
Save Tab Stops L1 A A A A A
Save User Image L1 A A A A A
Calibration
Save Window Level L1 A A
User Image L1 A A A A
Calibration
Keywords
Associate keywords L1 I I I I I I I
with study
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Radiology

Operation License Top-level Breast NM Power Rad Resident Tech
level Imaging Physician Rad
&
Print
Print Composite L1 A A A
Layouts
Print Study L1 A
Study Retrieval
Retrieve Offline L1 A I I I I | |
Studies
Retrieve Studies L1 A I I I I I I
from External
PACS
Retrieve Studies L1 A I I I 1 I I
from HSM
Retrieve Studies L1 A I I I I I I
from Nearline
Text Area
Add study L1 I I I I I I I
comments
Edit Patient QC
Demographics
Edit Performing L1
Physician
Edit Study L1 A
Comments
Edit Study Status L1 A A A
Protect Studies L1
View Reports L1 I I I I I I I
Transmit Studies L1 A A A A A
View Study L1 I I I I I I I
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Referring Physician role: Default PACS Client

operations

(Topic number: 54898)

Agfa Company Confidential—Subject to Non-Disclosure Obligation

Legend:
3D 3D visualization Mod_CT Display of CT modality type
A Assigned functionality Mod_DR Display of DR modality type
CA Client automation Mod_MG Display of MG modality type
CAD Display of CAD markers Mod_MR Display of MR modality type
COMPREV  Mammography Mod_NM Display of NM modality type
CONFIG Configuration area Mod_US Display of US modality type
CS Context Server Mod_XA Display of XA modality type
HP Hanging protocols oT Orthopaedic integration
I Inherited functionality QC Quality
L1 Level 1 Basic Feature Set RONDS Scheduling and review of ronds
L2 Level 2 Basic Feature Set TF Teaching files
Mod_ALL Display of all modality types TS TalkStation integration
Mod_CR Display of CR modality type
General
Operation License level Referring
Physician

At-a-Glance

Edit At-a-Glance Messages L1

Show At-a-Glance L1 I
Audible Notification L1 I
Change Password CONFIG I
Configure Area

Individual Configuration CONFIG

Preferences CONFIG

Printers CONFIG
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Operation License level Referring

Physician
Service CONFIG
Stations CONFIG
Users and Roles CONFIG
Context Server Integrations
Allow Single Sign-on CS I
Enable Context Server Integrations CS I
Cycle Studies L1
Delete Study
Edit Columns L1
Edit Enumerated Values
Edit Viewable Worklists
Export and Import Studies
Export Studies with Image Viewer L1
Export Studies with Reports L1
Import Studies L1
History L1
Image Area L1 I
Image Area Tools
3D 3D
Active Target L1 A
Apply Hanging Protocols HP
Apply System Layout Protocols L1
Auto Window Level L1 A
Break Out Gated Series L1
Cine Viewer L1 A
Comparative Review COMPREV
Compare L1 A
Create Combined Series L1
Create Summary Study L2 I
Customize L1
Demographics Toggle L1 I
Display Markup Toggle L1 I
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Operation License level Referring

Physician
Display Scout L1 A
Edit New Series Descriptions L1
Extended Monitor Display L1 I
Histogram Equalization L1
Image Enhancement L2
Image Information Window L1 I
Image Pasting L1
Image Selection L1 I
Linking L1 I
Mammography CAD SR Toggle CAD
MPR L2
Nonlinear Window Level L1 A
Nuclear Medicine Palette L1
Paired Zoom and Pan L1
Pin Study L1 A
Pixel Value Toggle L1
Presentation State Selection L1 A
Projection L1 A
Rearrange Series L1 A
Screen Layout L1 I
Service Window L1
Sort Images L1 A
Split Multi-Phasic Series L1
Tab Stops L1
True Size L1
Undo/Redo/Reset L1 I
View Original Images L1
Window Level L1 I
Window Level Preset L1 I
Image Area Wizards
Create or Import Wizards CA I
Delete Wizards CA
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Operation License level Referring
Physician
Edit Wizards CA
Run Wizards CA I
Job Manager
Delete Jobs L1
Enable Job Manager L1
Modify Any Job L1
Modify Job Priority L1
Key Images Edit Favorite Titles L1
Keywords
Edit Personal Keywords L1 I
Edit System Keywords L1
Link Patients L1 I
Messaging Service
Instant Messaging L1
Receive Study Messages L1
Modality
View All MOD_ALL I
View CR MOD_CR
View CT MOD_CT
View DR MOD_DR
View MG MOD_MG
View MR MOD_MR
View NM MOD_NM
View US MOD_US
View XA MOD_XA
Orthopaedic Application oT
Override permissions on a folder TF
Print
Edit Composite Layouts L2
Print to Paper L1 I
Quality Control
Acknowledge Conflicts QC
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Operation License level Referring
Physician
Fixup, Segment, and Split Studies QC
Quick Fix Up QC
Remember User Settings L1 I
Scripting
Configure Scripts L1
Run Scripts L1
Search for Open Studies L1
Searching for studies
Add Search Criteria L1
Advanced Search L1
Configure Simple Search Criteria L1
Simple Search L1 I
Use Relevant Prior Rules L1 I
Set Default Image Type L1
TalkStation Integration TS
Teaching Files TF
Add Teaching File Folders TF
Delete Teaching File Folders TF
Modify Teaching File Folders TF
Update Teaching File Folders TF I
View Teaching File Folders TF
Text Area
Configure SmartSeek Tabs L1
Edit Favorite Study Comments L1
Enable Enterprise Study List L1
Enable Text Area L1 I
Private Study Comments L1
Update Study L1
Worklists
Configure Global Priority Groups L1
Edit Viewable Worklists L1
Personal Worklists L1
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Operation License level Referring

Physician
Scheduled Worklists
Add Studies to Scheduled Worklists RONDS
Create Scheduled Worklists RONDS
Delete Scheduled Worklists RONDS
Edit Scheduled Worklists RONDS
Remove Studies from Scheduled Worklists RONDS
Reorder Scheduled Worklists RONDS
View Scheduled Worklists RONDS
Standard Worklists
Create Worklists L1
Delete Worklists L1
Edit Worklists L1

Study-Based

Operation License level  Referring
Physician
Add/Remove Key Images L2
Dictate Studies as Radiologist L1
Dictate Studies as Resident L1
Edit Study Priority
Export and Import Studies
Export Studies to Local Media L1
Export Studies to Remote Media L1
Image Area Tools
Collimate L1
Delete Image (Approved) L1
Delete Image (Dictated) L1
Delete Image (New) L1
Delete Image (Reported) L1
Edit All Markups (Approved) L1
Edit All Markups (Dictated) L1
Edit All Markups (New) L1
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Operation License level  Referring

Physician

Edit All Markups (Reported) L1

Edit DICOM Elements L1

Edit Study Snapshots L1

Export Images L1 A
Geometry L1 A
Import Images L1

Invert L1 A
Magnification L1 A
Markup L1 A
Publish SPS Objects L1

Rearrange Images L1 A
Save Geometry (Approved) L1

Save Geometry (Dictated) L1

Save Geometry (New) L1

Save Geometry (Reported) L1

Save Magnification/Pan (Approved) L1

Save Magnification/Pan (Dictated) L1

Save Magnification/Pan (New) L1

Save Magnification/Pan (Reported) L1

Save Markup (Approved) L1

Save Markup (Dictated) L1

Save Markup (New) L1

Save Markup (Reported) L1

Save Tab Stops L1

Save User Image Calibration L1

Save Window Level L1

User Image Calibration L1

Keywords
Associate keywords with study L1 I
Print
Print Composite Layouts L1
Print Study L1
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Operation License level Referring

Physician
Study Retrieval
Retrieve Offline Studies L1
Retrieve Studies from External PACS L1
Retrieve Studies from HSM L1
Retrieve Studies from Nearline L1 A
Text Area
Add study comments L1 A
Edit Patient Demographics QC
Edit Performing Physician L1
Edit Study Comments L1
Edit Study Status L1
Protect Studies L1
View Reports L1 A
Transmit Studies L1
View Study L1 A
Surgery role: Default PACS Client operations
(Topic number: 54901)
Legend:
3D 3D visualization Mod_CT Display of CT modality type
A Assigned functionality Mod_DR Display of DR modality type
CA Client automation Mod_MG Display of MG modality type
CAD Display of CAD markers Mod_MR Display of MR modality type
COMPREV  Mammography Mod_NM Display of NM modality type
CONFIG Configuration area Mod_US Display of US modality type
CS Context Server Mod_XA Display of XA modality type
HP Hanging protocols oT Orthopaedic integration
I Inherited functionality QC Quality
L1 Level 1 Basic Feature Set RONDS Scheduling and review of ronds
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L2 Level 2 Basic Feature Set TF Teaching files
Mod_ALL Display of all modality types TS TalkStation integration
Mod_CR Display of CR modality type

General
Surgery
Operation License Top-level General Neuro Orthopaedic
level Surgeon Surgeon Surgeon
At-a-Glance
Edit At-a-Glance Messages L1
Show At-a-Glance L1 I I I I
Audible Notification L1 I I I I
Change Password CONFIG 1 I I I
Configure Area
Individual Configuration = CONFIG
Preferences CONFIG
Printers CONFIG
Service CONFIG
Stations CONFIG
Users and Roles CONFIG
Context Server Integrations
Allow Single Sign-on CS I I I I
Enable Context Server CS I I I I
Integrations
Cycle Studies L1
Delete Study
Edit Columns L1
Edit Enumerated Values
Edit Viewable Worklists
Export and Import Studies
Export Studies with Image L1 A
Viewer
Export Studies with Reports L1
Import Studies L1
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Surgery

Operation License Top-level General Neuro Orthopaedic
level Surgeon Surgeon Surgeon
History L1
Image Area L1 I I I I
Image Area Tools
3D 3D A
Active Target L1 I I I I
Apply Hanging Protocols HP A
Apply System Layout L1
Protocols
Auto Window Level L1 I I I I
Break Out Gated Series L1 A
Cine Viewer L1 I I I I
Comparative Review COMPREV
Compare L1 I I I I
Create Combined Series L1
Create Summary Study L2 A I I I
Customize L1
Demographics Toggle L1 I I I I
Display Markup Toggle L1 I I I I
Display Scout L1 I I I I
Edit New Series L1
Descriptions
Extended Monitor Display L1 I I I I
Histogram Equalization L1 A
Image Enhancement L2 A
Image Information L1 I I I I
Window
Image Pasting L1 A
Image Selection L1 I I I I
Linking L1 I I I I
Mammography CAD SR CAD A
Toggle
MPR L2
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Surgery

Operation License Top-level General Neuro Orthopaedic
level Surgeon Surgeon Surgeon
Nonlinear Window Level L1 I I I I
Nuclear Medicine Palette L1 A
Paired Zoom and Pan L1
Pin Study L1 I I I I
Pixel Value Toggle L1
Presentation State Selection L1 I I I I
Projection L1 I I I I
Rearrange Series L1 I I I I
Screen Layout L1 I I I I
Service Window L1
Sort Images L1 I I I I
Split Multi-Phasic Series L1
Tab Stops L1
True Size L1 A
Undo/Redo/Reset L1
View Original Images L1
Window Level L1 I I I I
Window Level Preset L1 I I I I
Image Area Wizards
Create or Import Wizards CA I I I I
Delete Wizards CA
Edit Wizards CA A
Run Wizards CA I I I I
Job Manager
Delete Jobs L1
Enable Job Manager L1
Modify Any Job L1
Modify Job Priority L1
Key Images Edit Favorite Titles L1
Keywords
Edit Personal Keywords L1 I I I I
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Operation

Edit System Keywords
Link Patients
Messaging Service

Instant Messaging

Receive Study Messages
Modality

View All

View CR

View CT

View DR

View MG

View MR

View NM

View US

View XA
Orthopaedic Application
Override permissions on a folder
Print

Edit Composite Layouts

Print to Paper
Quality Control

Acknowledge Conflicts

Fixup, Segment, and Split
Studies

Quick Fix Up
Remember User Settings
Scripting

Configure Scripts

Run Scripts
Search for Open Studies

Searching for studies

License
level

L1
L1 I

L1 A

L1

MOD_ALL 1
MOD_CR
MOD_CT
MOD_DR
MOD_MG
MOD_MR
MOD_NM
MOD_US
MOD_XA
OoT

TF

L2
L1 I

QC
QC

QC
L1 I

L1
L1
L1

Top-level General Neuro
Surgeon Surgeon Surgeon

Surgery
Orthopaedic

I I I
I A A
I I I
I I I
I I I
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Surgery

Operation License Top-level General Neuro Orthopaedic
level Surgeon Surgeon Surgeon
Add Search Criteria L1
Advanced Search L1 A
Configure Simple Search L1
Criteria
Simple Search L1 I I I I
Use Relevant Prior Rules L1 I I I I
Set Default Image Type L1
TalkStation Integration TS
Teaching Files TF
Add Teaching File Folders TF A
Delete Teaching File TF A
Folders
Modify Teaching File TF
Folders
Update Teaching File TF A
Folders
View Teaching File Folders TF A

Text Area
Configure SmartSeek Tabs L1

Edit Favorite Study L1
Comments

Enable Enterprise Study L1
List

Enable Text Area L1 I I I I
Private Study Comments L1

Update Study L1

Worklists
Configure Global Priority L1
Groups
Edit Viewable Worklists L1
Personal Worklists L1
Scheduled Worklists
Add Studies to Scheduled RONDS
Worklists

Migrations Reference Guide—IMPAX 5.2 or 5.3 or WEB1000 to IMPAX 6.5.1 183

Agfa Company Confidential—Subject to Non-Disclosure Obligation



Surgery

Operation License Top-level General Neuro Orthopaedic
level Surgeon Surgeon Surgeon

Create Scheduled Worklists RONDS A
Delete Scheduled Worklists RONDS A
Edit Scheduled Worklists RONDS A
Remove Studies from RONDS
Scheduled Worklists

Reorder Scheduled RONDS
Worklists

View Scheduled Worklists RONDS A
Standard Worklists

Create Worklists L1 A
Delete Worklists L1 A
Edit Worklists L1 A

Study-Based

Surgery
Operation License Top-level General Neuro Orthopaedic
level Surgeon Surgeon Surgeon
Add/Remove Key Images L2 A
Dictate Studies as Radiologist L1
Dictate Studies as Resident L1
Edit Study Priority

Export and Import Studies
Export Studies to Local Media L1

Export Studies to Remote L1
Media

Image Area Tools
Collimate L1 A
Delete Image (Approved) L1

Delete Image (Dictated) L1
Delete Image (New) L1
Delete Image (Reported) L1

Edit All Markups (Approved) L1
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Surgery

Operation License Top-level General Neuro Orthopaedic
level Surgeon Surgeon Surgeon
Edit All Markups (Dictated) L1
Edit All Markups (New) L1
Edit All Markups (Reported) L1
Edit DICOM Elements L1
Edit Study Snapshots L1
Export Images L1 I I I I
Geometry L1 I I I I
Import Images L1 A
Invert L1 I I I I
Magnification L1 I I I I
Markup L1 I I I I
Publish SPS Objects L1 A
Rearrange Images L1 I I I I
Save Geometry (Approved) L1
Save Geometry (Dictated) L1
Save Geometry (New) L1 A
Save Geometry (Reported) L1
Save Magnification/Pan L1
(Approved)
Save Magnification/Pan L1
(Dictated)
Save Magnification/Pan (New) L1 A
Save Magnification/Pan L1
(Reported)
Save Markup (Approved) L1
Save Markup (Dictated) L1
Save Markup (New) L1 A
Save Markup (Reported) L1
Save Tab Stops L1 A
Save User Image Calibration L1 A
Save Window Level L1 A
User Image Calibration L1
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Surgery

Operation License Top-level General Neuro Orthopaedic
level Surgeon Surgeon Surgeon
Keywords
Associate keywords with study L1
Print I I I I
Print Composite Layouts L1 A
Print Study L1
Study Retrieval
Retrieve Offline Studies L1 A
Retrieve Studies from External L1 A
PACS
Retrieve Studies from HSM L1 A
Retrieve Studies from Nearline L1 A I I I
Text Area
Add study comments L1 I I I I

Edit Patient Demographics ~ QC
Edit Performing Physician L1

Edit Study Comments L1
Edit Study Status L1
Protect Studies L1
View Reports L1 I I I I
Transmit Studies L1
View Study L1 I I I I
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Glossary

A

all-in-one configuration

A configuration in which the Database,
Archive Server, Network Gateway, and Curator
Server components are all installed on a single
Windows server, along with the Application
Server software.

Application Server

Intermediary server between IMPAX Client
and IMPAX Server machines. LDAP,
Documentation, and other Business Services
reside on the Application Server.

Archive Server

The IMPAX server that manages the archive.
The Archive Server handles requests to store
studies to the archive and to retrieve studies
from the archive. The Archive Server stores
studies in its cache before archiving them to
long-term storage.

C

cluster

A networking solution combining two or more
otherwise independent computers, enabling
them to work together in managing hospital
data.

coplanar

Two or more series that are parallel, or in the
same plane, are coplanar.
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D

database

A collection of data that is organized so that
its contents can easily be accessed, managed,
and updated.

DICOM

Digital Imaging and Communications in
Medicine. The standard communication
protocol used by a PACS, HIS, or modality to
exchange information or images with other
systems.

DLT

Digital Linear Tape. A half-inch format used
for archiving. Each carrier is two-sided; each
side is considered to be a separate volume.
These tapes have one spindle in the cartridge,
as opposed to other types of tapes (for
example, VHS) that have two. The tape
unwinds into the drive and must be completely
wound back into the DLT cartridge before it
can be unloaded.

F

firewall

On alocal area network (LAN) connected to
a larger network, the security system that
prevents outside intrusion and that keeps
internal information from getting out.
Typically, all traffic must pass through the
machine on which the firewall is implemented.
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H
HIS

Hospital Information System. The database
used by a hospital to manage patient
information and scheduling.

|
IMPAX Client

IMPAX Clients are used to view study images
and data. The IMPAX Client integrates PACS,
RIS, and reporting applications into a single
delivery of information.

L

load balancing

Distributing processing and communications
activity evenly across a computer network so
that no single device is overwhelmed.

M

Macro enterprise

A Macro enterprise is an environment
comprised of multiple clusters or Micro
enterprises and coordinated by a central Data
Center. It is the most common deployment

type.

MIP

Maximum Intensity Projection. Refers to a
projection of the 3D object that shows the
tissues of highest density.

modality

An imaging discipline, such as CT, or a device
that gathers digital information, such as
digitizers for X-ray film, MRI scanners, and
CR devices.

multiple IMPAX cluster configuration

In a multiple IMPAX cluster configuration,
an IMPAX cluster is linked to one or more
other IMPAX or external PACS clusters, such
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that patient and study data can be shared and
synchronized between them.

N

Network Gateway

The Network Gateway is part of the IMPAX
MVF cluster. Essentially, this is the workflow
manager of the IMPAX 6.0 and later system.
The Network Gateway controls the studies
coming into the cluster from an acquisition
station, validates these incoming studies
against information from the HIS or RIS, and
routes the validated studies to cache or archive.

P
PACS

A Picture Archive and Communication
Systems (PACS) makes it possible to
electronically store, manage, distribute, and
view images.

permissions, IMPAX

Permissions define the available IMPAX
features and types of studies that users in a
particular role have access to. Permissions are
made up of a set of operations.

preferences

Configurable options in IMPAX that can be
set to accommodate the preferred workflow
of defined groups or individuals.

R
RIS

Radiology Information System. Responsible
for scheduling exams and for report
management in the Radiology department.

role

A collection of users or other roles that holds
IMPAX Client permissions and preferences as
well as licensing options. For example, a role
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can represent the enterprise, the institution, a
department, or a team.

S

single-server configuration

An IMPAX single server is a Windows server
that runs the AS300 Server software in a
single-host configuration along with the
Application Server and Connectivity Manager
software.

standalone configuration

In an IMPAX standalone configuration, the
IMPAX AS300 Server, Application Server, and
Client software are all installed on the same
Windows server.

study access rule

The second portion of a study-based
permission. The rules limit what groups of
studies the permission applies to. For example,
you can set study access rules to apply a
permission to all studies from a specific
modality, or to allow clinicians to view only
the studies they referred.

W

wizard

Wizards are used to automate processes.
Wizards perform a predetermined sequence
of actions after they are selected and applied.

worklist

A collection of patients and their studies. For
radiologists, the worklist is analogous to a pile
of film jackets. They use the worklist to know
which studies they must interpret during a
specific time period. For technologists, a
worklist is a list of the studies they must
perform at specific times for each patient.
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